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KATA PENGANTAR
Alhamdulillah, segala puji bagi Allah yang telah memberikan segala bimbinganNya

kepada penulis untuk menyelesaikan buku praktikum Pemrograman Multimedia.

Buku ini dipergunakan sebagai modul ajar praktikum Pemrograman Multimedia program
studi D3 Teknologi Multimedia Broadcasting di Politeknik Elektronika Negeri Surabaya. Sasaran
dari praktikum Pemrograman Multimedia ini adalah memberikan pengetahuan kepada mahasiswa
tentang Virtual Reality.

Modul ini dibuat dengan pertimbangan tren perkembangan Teknologi Multimedia salah
satunya adalah Virtual Reality. Gartner memprediksi pada tahun 2021 teknologi virtual reality
akan menjadi kebutuhan orang banyak terutama pada penerapan komunikasi jarak jauh
(teleconference).

Diharapkan dengan mengikuti tutorial yang ada dalam modul, mahasiswa dapat
meningkatkan pengetahuan skill di bidang pemograman multimedia dan dapat menghasilkan
berbagai karya pada konten virtual reality.

Penulis menyadari bahwa buku ini jauh dari sempurna, oleh karena itu penulis akan

memperbaikinya secara berkala.Saran dan kritik untuk perbaikan buku ini sangat kami harapkan.

Surabaya, 24 April 2018

Hormat kami,

Penulis
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BAB 1
PENGENALAN

TUJUAN

1. Pembaca Dapat Menginstal Unity 3D
2. Pembaca Dapat Menginstal Oculus

3. Pembaca Dapat Menginstal Leap Motion

A. DASAR TEORI
1.1 Virtual Reality

Virtual reality terdiri dari dua kata yaitu virtual dan reality. Virtual reality adalah teknologi
yang dapat berinteraksi dengan suatu lingkungan yang disimulasikan oleh computer.

Virtual Reality (VR), kadang-kadang disebut Virtual Environments (VE) telah menarik
banyak perhatian beberapa tahun terakhir. Liputan media yang luas menyebabkan minat ini
berkembang pesat. terminologi dasar dan kelas dari sistem VR terdaftar, diikuti oleh teknologi
aplikasi ini dalam sains, pekerjaan, dan area hiburan. Sebuah studi mendalam tentang sistem VR
yang khas dilakukan. Semua komponen aplikasi VR dan keterkaitan antara keduanya diperiksa
secara menyeluruh: perangkat input, perangkat output dan perangkat lunak. Selain itu faktor
manusia dan implikasinya didiskusikan pada masalah desain VE [1]. Hal ini dapat dilihat seperti

gambar 1.1.

AnimeNewsNetwork.com |

Gambar 1.1 Etymology Virtual Realty
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1.2 UNITY 3D
1.2.1 Pengertian Unity 3D

Unity 3D adalah sebuah game engine yang berbasis cross platform. Unity dapat digunakan
untuk membuat sebuah game yang bisa digunakan pada perangkat komputer, ponsel pintar
android, iPhone, PS3, dan bahkan X-BOX. Unity adalah sebuah tool yang terintegerasi untuk

membuat game, arsitektur bangunan dan simulasi [2].

Gambar 1.2 Contoh Game di Unity 3D

1.2.2 Sejarah UNITY 3D

Unity (umumnya dikenal sebagai Unity3D) adalah game engine yang dikenal Integrated
Development Environment (IDE) untuk membuat media interaktif, khususnya permainan video.
Sebagai CEO David Helgason mengatakannya, Unity “adalah toolset yang digunakan untuk
membuat game, dan itu adalah teknologi yang mengeksekusi grafik, audio, fisika, interaksi, dan
jaringan [3].

Unity Technologies didirikan pada tanggal 2 Agustus 2004 oleh David Helgason (CEO),
Nicholas Francis (CCO), dan Joachim Ante (CTO) di Kopenhagen, Denmark setelah pertandingan
pertama mereka, GooBall, gagal meraih kesuksesan. Ketiganya mengenali nilai pengembangan
mesin dan alat dan menetapkan untuk menciptakan mesin yang dikembangkan di rumah yang
dapat digunakan semua orang dan harganya terjangkau. Unity Technologies telah menerima dana

dari orang-orang seperti Sequoia Capital, WestSummit Capital, dan iGlobe Partners [3].
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& unity

Gambar 1.3 Logo Unity 3D

1.2.3 Contoh Pengembangan Unity 3D
1. Pengembangan Game Berbasis Unity 3D Sebagai Media Evaluasi Pembelajaran Musik Di
SMP Negeri 4 Purworejo.
Pada tahun 2014 Nur Arif Anandhita membuat sebuah media evaluasi pembelajaran musik
dengan menggunakan Unity 3D yang diterapkan di SMP Negeri 4 Purworejo. Nur Arif Anandhita
membuat media evaluasi pembelajaran musik ini sebagai syarat untuk memperoleh gelar Sarjana

Pendidikan Seni Musik di Jurusan Pendidikan Seni Musik Universitas Negeri Yogyakarta [4].

Disusun Oleh:

NUR ARIF ANANDHITA
09208244011

|IYFAKULTAS BAHASA DAN SEN)
UNIVERSITAS NEGERI YOCYAKARTA

Gambar 1.4 Media Evaluasi Pembelajaran Musik Berbasis Unity 3D
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2. Angry Bird

Gambar 1.5 Angry Bird

3. Jimmy Vegas

jﬁmmg \\/@@%Q unﬂ'y
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FALLOUT 4 HEALTH

Gambar 1.6 Jimmy Vegas

1.3  OCULUS
1.3.1 Pengertian Oculus
Oculus adalah sebuah perangkat wearable yang dikembangkan oleh perusahaan Oculus

VR. Perangkat ini mampu menampilkan gambar virtual reality dengan dua layar untuk masing-
masing mata. Selain itu, Oculus Rift memiliki resolusi 1200 x 800 dengan sudut pandang hingga

4
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110 derajat [5]. Oculus Rift merupakan sitem virtual reality yang akan membawa anda ke dunia

maya [6].

Gambar 1.7 Oculus Rift

1.3.2 Bagian Bagian Oculus
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Gambar 1.8 Bagian Bagian Oculus
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1.4  LEAP MOTION
1.4.1 Pengertian Leap Motion

Leap motion adalah perangkat tambahan yang dihubungkan dengan komputer.yang
dapat digunakan sebagai pengganti fungsi mouse ataupun keyboard yang dikembangkan dari
konsep motion tracking. Fungsi dari alat ini adalah membantu penggunanya menggendalikan
atau mengganti tugas mouse atau keyboard mengendalikan komputer hanya dengan gerakan

tangan maupun jari di udara [7].

sl [
\ ]
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Gambar 1.9 Leap Motion

1.4.2 Sejarah Leap Motion

Pengontrol Leap Motion, juga dikenal sebagai The Leap, dirilis pada tahun 2013 oleh Leap
Motion, Inc. Leap Motion adalah perangkat yang sangat ditunggu-tunggu yang memantau gerakan
tangan pengguna dalam suatu ruang delapan kaki kubik di atas pengontrol menggunakan tiga
kamera inframerah (Leap Motion). Perangkat Leap Motion dapat melacak gerakan sekecil 0,01
milimeter (Foster 2013).

David Holz memulai pengembangan pada kontroler Leap Motion pada tahun 2008, dan
menghabiskan hampir lima tahun mengembangkan perangkat lunak dan kamera. Setelah lima
tahun, sebuah prototipe adalah diperagakan untuk Bill Warner yang kemudian menginvestasikan
$ 25.000 untuk mengembangkan teknologi lebih lanjut. Proyek tersebut kemudian memperoleh

dukungan dari beberapa individu lain dan perusahaan modal ventura. Dukungan ini membantu
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perusahaan berkembang menjadi lebih dari 80 karyawan dan menjadi populer di kalangan

kelompok besar pengguna masa depan [8].

Leap Motion
and WebVR

David Holz

Gambar 1.10 David Holz

Perangkat tersebut terinspirasi oleh pengalaman Holz dengan perangkat lunak pemodelan
3D, menyadari tentang yang bisa dipahat dari tanah liat dalam waktu lima menit membutuhkan
waktu berjam-jam menggunakan perangkat lunak papan atas. Dia tahu bahwa teknologi telah
membantunya melakukan hal-hal yang biasanya tidak bisa dia sadari kontrol computer pada
umumnya seperti mouse dan keyboard menyulitkan proses penciptaan ketika harus semudah
menggunakan tangan manusia. Keinginan ini untuk menyederhanakan antarmuka untuk
mendorong perkembangan apa yang sekarang dikenal sebagai Leap Motion, dan salah satu dari
sekian banyak [8].

15  SOFTWARE DEVELOPMENT KIT
1.5.1 Pengertian SDK

Software Development Kit (SDK) adalah perangkat tambahan, kegunaan, dan kerangka
kerja yang dimaksudkan untuk memberikan peningkatan produktivitas saat penerapan pola fitur
extensibility umum pada sistem infinity.

Software Development Kit (SDK atau devkit) merupakan satu set perkakas pengembangan
software yang digunakan untuk mengembangkan atau membuat aplikasi untuk paket software
tertentu, software framework, hardware platform, sistem komputer, konsol video game, sistem

operasi atau platform sejenis lainnya. la mencakup mulai dari pemrograman sederhana seperti
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sebuah Application Programming Interface (API), sampai dengan pemrograman yang lebih rumit

dengan hardware yang canggih atau pada sistem embedded termasuk perangkat mobile.

Ay
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Z »
= . L1

. ¢pK

Gambar 1.11 Software Development Kit
(Sumber : http://kreatindo.com)

B. PRAKTIK

Untuk menguat lebih dalam tentang Virtual Reality. Pembaca perlu adanya instalasi

tentang Unity sebagai Game Engine, Oculus sebagai perangkat Virtual Reality, dan Leap Motion

sebagai perangkat inputan .

PERALATAN

1. Komputer

2 Oculus

3. Leap Motion

4 Koneksi Internet

LANGKAH LANGKAH PERCOBAAN

Instalasi Unity

1. Mendownloadnya terlebih dahulu di www.unity3d.com/get-unity/download


http://www.unity3d.com/get-unity/download
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€& 3> C | [ hitpsy/funity3d.com/download
i Apps & MULTIMEDIA - Goo
Qunity Products  Solutions Made with Unity  Learn  Community Asset Store Q 0
. . _
Download Unity System
> vou want to download ty the 0St PO elopmen

!'GQUH'QI'WQFKQ

load U

Welcome! You're here be

platform for creating

Download Unity Beta

We use cookies to ensure that we give you the best experience on our website. Click for more information.

Gambar 1.12 Screenshoot Web Download Unity 3D

Jalankan aplikasi master intalasinya dan tunggu hingga proses instalasi selesai. Ketika proses
intalasai selesai maka akan muncul pemberitahuan bahwa instalasi Unity telah selesai dan siap
untuk dijalankan.

Selanjutnya kita jalankan Unity 2017. Ketika Unity mulai dijalankan, maka akan muncul
Splash Screen (tampilan awal) Unity 2017 yang menandakan bahwa Unity sudah berjalan.
Memasukkan key lisensi yang kita punya. Dimana pada form ini kita sebagai free user atau
pemakai secara gratis akan memilih bagian “Unity 2017 Personal Edition”. Pastikan kita sudah
mencentang bagian tersebut dan sudah mencentang juga persetujuan lisensi yang di form
tersebut bertuliskan “I hereby confirm my acceptance...”

Pastikan kita terkoneksi dengan internet pada saat kita sudah menekan “OK” di form lisensi.
Karena pada pengaktivan lisensi tersebut kita akan mendapat konfrimasi secara online dari
Unity.

Registrasi Akun Unity

Jika kita sudah memastikan akun kita sudah terdaftar pada Unity, maka segera login pada form
lisensi

Setelah login berhasil, maka akan muncul pemberitahuan kalau login berhasil. Setalah itu
langsung melangkah ke step selanjutnya dengan menekan tombol “Start Using Unity”.
Setelah login berhasil maka akan muncul form wizard. Dimana form ini merupakan form menu

awal pada Unity 2017.
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Instalasi Oculus

1. Pastikan semua peralatan sudah lengkap dan sudah disambungkan ke laptop atau komputer
kita, pastikan semuanya telah tersambung satu persatu dengan benar (HDMI,USB,AUDIO
dil).

Gambar 1.13 Kabel Sudah Terpasang

2. Ketika semua sudah tersambung maka Oculus Rift DK2 akan menyala pada powernya. Jika
tidak menyala maka kita bisa menekan tombol powernya.

3. Download beberapa software pendukungnya seperti Driver Runtime sesuai dengan driver
Laptop atau Komputer anda dan SDK nya di https://developer.oculus.com/downloads/ untuk

mendapatkan update terakhir atau update terbaru.

& 3 C [ 8 secure | hpsrdeveoperoculus.com/dowr 2l i
1 Apps @ MULTMEDIA - Goo

A ~
, < W
> A "\\l\ | A& ;\‘\ ) j= i ==y
WI2ZER N 2R N —J
Unity Unreal Engine Web VR
& 2 f ) —=  —
| 1O\ i —
7N\ SN .

Gambar 1.14 Tampilan Web Untuk Mendownload Software Pendukung Seperti SDK dan Run Time
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4. Ikuti petunjuk yang ada sesuai dengan petunjuk yang muncul pada form instalasi.

5. Langkah langkah Form instalasi
° Setup -EH |- Setup -olEH| | < Setup - clEN

===================

®) Taccept the sgresment
Tkt accent e agreement

o Question

wwwww g "':o‘ To complete the installation, Setup must restart your computer. Would you like to
& restar

Unisching C2Program s (xe6) 0z ok Ok CeniglU. exe rt now?

Yes Ne

Gambar 1.15 Form Form Instalasi

6. Pada bagian instalasi ini banyak driver yang akan diinstal salah satunya adalah kacamata
virtual dan camera positional tracking. Jika muncul pemberitahuan maka kita pilih untuk
melanjutkan instalasi

7. Jika Instalasi selesai maka kita harus merestart komputer atau laptop kita dengan kedaaan
Oculus beserta perangkat pendukungnya menancap pada komputer atau laptop kita. Kemudian
kita lakukan restart. Akan muncul icon tray pada taskbar pojok kanan bawah.

8. Setelah itu lakukan konfigurasi untuk mengetahui apakah driver sudah terinstall dengan baik.

Click kanan icon tray kemudian pilih . . akan muncul . . .

Gambar 1.16 Icon Tray dan Perangkat Oculus

11
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9. KIlik tombol + untuk menambahkan user. Atur gender, player height, Eye relief sesuai dengan

kondisi player.

© Oculus Configuration Utility “
File Tools Help

Device

=

Oculus Rift DK2: Ready

Eye Cups A &
Eye Relief in out "
User
User ||+ -
Gender Male -
Player Height Metric | 178 cm >
Advanced
Show Demo Scene Close

Gambar 1.17 Pengaturan Gender, Player height, Eye relief

10. Lalu klik show demo scene untuk menampilkan demo scene

o Oculus Demo Scene Mirror - o IEl

© Oculus VR © Oculus VR

Gambar 1.18 Demo Scene
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Instalasi Leap Motion

1. Mendownload pastikan Anda sudah memiliki akun Leap Motion, karena perlu login terlebih
dahulu untuk download driver dan SDK.

2. Download SDK Leap Motion di halaman https://developer.leapmotion.com/

DOCS  GALLERY  ®BUY

Unity Assets for Leap Motion Orion Beta

ni
HTC Vive (requires Unity 5.6+)

Now suppoerts both Unity 5.6 & 20173

DOWNLOAD UNITY CORE ASSETS 434

Gambar 1.19 Tampilan Halaman Download Driver dan SDK Leap Motion

3. Ketika sudah terdownload extract file tersebut kemudian install driver dan SDK dengan klik

dua Kkali file Leap_Motion_Installer_release_public_win_x86 2.2.6+29154 ah1867.exe

- ol o Leap Motion Controller Setup

Installation completed

Gambar 1.20 Tahapan Instalasi Leap Motion

4. Jika sudah terinstall akan muncul Leap Motion App Home

hess
4 '/.vg"

Touchless

f 0

Gambar 1.21 Tampilan Home Leap Motion
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5. Setelah selesai terinstall, lakukan restart pada komputer Anda. Setelah itu, untuk mengecek
driver dan SDK yang sudah terinstall apakah sudah benar, pasang Leap Motion pada

komputer.

C. KESIMPULAN
Dalam Membuat aplikasi Virtual Reality membutuhkan minimal

Hardware:
1. Komputer
2. Oculus
3. LeapMotion

Software

1. Unity 3D

D. SOAL

1. Teknologi yang dapat berinteraksi dengan suatu lingkungan yang disimulasikan oleh komputer
a. Virtual Box  b. Virtual Reality c. Reality Man d. Reality Philosophy

2. Sebuah game engine yang berbasis cross platform.
a. Corel Draw b. Autocad c. Unity 3D d. Punch Software

3. Resolusi yang dimiliki Oculus Rift
a. 720 x 576 b. 1024 x 768 c. 1200 x 800 d. 1920 x 1080

4. Alat yang berfungsi membantu penggunanya menggendalikan atau mengganti tugas mouse
atau keyboard mengendalikan komputer hanya dengan gerakan tangan maupun jari di udara
a. Leap Motion  b. Gear Vr c. Oculus Rift d. Google Cardboard

5. Satu set perkakas pengembangan software yang digunakan untuk mengembangkan atau
membuat aplikasi untuk paket software tertentu disebut
a. Software Development Kit
b. Software Development Life
c. Software Development House

d. Software development Process

14
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BAB 2
UNITY

TUJUAN

Pembaca dapat mengetahui bagian dan fungsi dari user interface Unity 2017.3.1.

Pembaca dapat mengetahui cara membuat project baru pada Unity 2017.3.1.
Pembaca dapat mengetahui cara membuat scene baru pada Unity 2017.3.1.
Pembaca dapat mengetahui cara menmbahkan object pada Unity 2017.3.1.

o & w0 D

Pembaca dapat mengetahui cara mengimport package pada Unity 2017.3.1.

A. DASAR TEORI
2.1  Unity

2.1.1 Pengertian Unity 3D

. t
Gambar 2. 1 Logo Unity

Unity3D adalah Unity 3D adalah sebuah game engine yang berbasis cross platform. Unity
dapat digunakan untuk membuat sebuah game yang bisa digunakan pada perangkat komputer,
ponsel pintar android, iPhone, PS3, dan bahkan X-BOX. Unity adalah sebuah tool yang

terintegerasi untuk membuat game, arsitektur bangunan dan simulasi [2].

15
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Unity bukan hanya mesin permainan untuk membangun 2D yang indah dan menarik game 3D.
Unity adalah platform lengkap yang memungkinkan user menerapkannya ke semua sistem operasi
seluler utama dan sedang berkembang, mempercepat proses pengembangan user mengoptimalkan
permainan, terhubung dengan audiens, dan mencapai kesuksesan komersial.

Unity 2017.3.1 merupakan aplikasi unity terbaru yang dirilis pada tahun 2017. Unity versi
ini dapat digunakan untuk semua pengguna dengan berlangganan aktif (Personal, Plus and Pro).

Unity 2017.3.1 memiliki banyak fitur yang diperbarui.

2.1.2 Sejarah Unity

Unity (umumnya dikenal sebagai Unity3D) adalah game engine yang dikenal Integrated
Development Environment (IDE) untuk membuat media interaktif, khususnya permainan video.
Sebagai CEO David Helgason mengatakannya, Unity “adalah toolset yang digunakan untuk
membuat game, dan itu adalah teknologi yang mengeksekusi grafik, audio, fisika, interaksi, dan
jaringan [3].

Salah satu alasan utama keberhasilan Unity adalah dukungannya bagi pengembang
independen yang tidak memiliki sumber daya untuk lisensi teknologi pengembangan game mahal.
Mereka tahu mereka ingin membangun semacam teknologi game, tetapi tidak tahu media mana
yang digunakan. Dua tahun kemudian, trio menemukan misi mereka: untuk membuat alat definitif
untuk 3D di web. Dengan ini faktor pendorong, kelompok itu mengeluarkan pinjaman besar untuk
membuka kantor dan mempekerjakan beberapa insinyur [3].

Pada titik ini, grup dimasukkan dengan nama Over the Edge Entertainment (OTEE) dan
mulai membentuk rencana bisnis. Model kriteria tidak hanya memiliki teknologi dasar yang baik,
tetapi juga memiliki banyak judul besar menggunakan teknologi. Pemikirannya adalah bahwa
konsumen tidak merasa cukup nyaman untuk lisensi mesin mahal tanpa melihat pengembang game
utama menggunakannya terlebih dahulu [3].

OTEE menyadari bahwa game kasual dan online hanya akan tumbuh, dan memutuskan
untuk melakukannya, memfokuskan upaya mereka di pasar. Setelah dua tahun coding, dan banyak
malam tanpa tidur, Unity mendekati peluncuran dan tim memutuskan bahwa perlu membuat game

komersial lengkap menggunakan mesin baru mereka [3].
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Gambar 2. 2 Game Gooball

OTEE menghabiskan lima bulan membuat game yang disebut Gooball menggunakan
mesin baru, yang masih dalam versi beta. Gooball diterbitkan pada Maret 2005 oleh Ambrosia
Software. Kesatuan tim menggunakan kesempatan ini untuk menghancurkan mesin mereka untuk
menemukan bug, menghilangkan gangguan, dan memperbaiki antarmuka sebelum rilis resminya.

Menggunakan keuntungan dari Gooball, OTEE mempekerjakan lebih banyak pengembang

untuk menyempurnakan hasil sebelumnya, awal rilis 1.0 pada bulan Juni 2005. Mereka ingin
memberi Unity kesempatan terbaik untuk sukses, sehingga mereka menyempurnakan semua sisi
yang kurang dan juga menyediakan dokumentasi dan dukungan yang luas untuk para pengguna.
Setelah dirilis, perusahaan segera mulai bekerja pada iterasi berikutnya [3].

Pada titik saat itu, Unity adalah baru di industri video game. Mayoritas pengguna terdiri
dari penggemar dan pengembang independen. Banyak perusahaan pengembangan game di waktu
akan membuat game yang tidak laris dengan baik, dan kemudian mencoba untuk "membuang"
mesin mereka teknologi. Pelanggan potensial khawatir ini mungkin terjadi dengan Unity. Butuh
dua bertahun-tahun sebelum OTEE membuktikan bahwa Unity akan didukung dan diperbarui
dengan baik. Versi pertama dari Kesatuan yang tersedia untuk publik hanya mendukung proyek-
proyek bangunan untuk dijalankan Mac OS X. Itu tidak sampai versi 1.1, yang didukung Unity
mengekspor ke Microsoft Windows dan web. Dukungan browser tiba tepat ketika adegan game
kasual meledak. Sebelumnya, Adobe’s Flash, dengan sistem berbasis vektornya yang kikuk,
adalah salah satu opsi yang sangat sedikit pengembang mencari untuk mempublikasikan ke web.
Unity membawa grafis 3D yang dipercepat perangkat keras ke industri game browser. Versi 1.1
juga menambahkan dukungan untuk plugin eksternal C / C ++, memungkinkan pengembang untuk

memperluas mesin untuk menggunakan hardware dan software yang tidak didukung oleh Unity.

17



MARI BELARMAIN VIRTUAL REALITY DENGAN UNITY 3D

Saat itu sekitar tiga co-founder merasa bahwa produk mereka sudah sampai diproyeksikan standar.
Tim menghabiskan waktu tiga bulan berikutnya untuk melakukan debugging, mengoptimalkan,
dan membuat workarounds untuk PC yang lebih tua yang diganggu dengan bug kartu grafis dan
masalah driver. Ini diintegrasikan ke dalam rilis Unity 1.5 [3].

Segera setelah rilis awal Unity, fitur Unity 2.0 sedang dikembangkan sisi. Dua tahun
pengembangan kemudian, "langkah terbesar pernah™ Unity, versi 2.0, adalah dilepaskan. Fokus
dari rilis ini adalah untuk memperkuat dukungan Windows dan meningkatkan web player
kompatibilitas antar platform. Untuk mencapai hal ini, tim menambahkan dukungan Microsoft
DirectX, yang telah diprainstal pada sistem Windows Vista, seperti yang ditunjukkan pada
OpenGL, yang seharusnya diunduh secara terpisah. DirectX menambahkan sekitar 30 persen
peningkatan kecepatan pada Windows sistem di samping optimalisasi kinerja umum yang
diberikan oleh Unity 2.0. Fitur utama lainnya yang termasuk dalam rilis ini adalah streaming web,
bayangan real-time, jaringan, mesin medan, server asset, dan sistem GUI berbasis kode baru [3].

Unity 2.0 dirilis selama Konferensi Pengembang Unite 2007. Dengan maraknya aplikasi
smartphone, dan dirilisnya Apple iPhone dan alhasil AppStore, Unity Technologies memutuskan
untuk mengembangkan versi Unity itu mengaktifkan penerbitan untuk iPhone. Dipasarkan sebagai
produk terpisah, iPhone Unity dirilis pada tahun 2008 Desember 2008 dan tersedia dalam versi
Basic dan Pro, mirip dengan produk basis Unity [3].

Antara 2008 dan 2009, Tim Kesatuan, sekarang dikenal sebagai Unity Technologies,
memperhatikan bahwa pelanggan mereka membeli komputer Macintosh untuk menggunakan
Unity. Tim Unity membutuhkan untuk mendukung editor di Windows juga. Untuk melakukannya,
mereka harus membongkar editor saat ini dan menulis ulang dari awal menjadi platform
independen. Unity Technologies meluncurkan versi pertama Unity dengan dukungan Windows
(Unity 2.5) pada Konferensi Pengembang Game 2009 [3].

Rilis besar berikutnya adalah versi 3.0 pada tanggal 27 September 2010. Pembaruan ini
dibawa banyak fitur yang diinginkan termasuk penyatuan editor, Beast lightmapping,
penangguhan yang tertunda, Oklusi Umbra memuntahkan, debugging tingkat rendah, dan filter
audio FMOD [3].

Untuk menyatukan editor, tim kesatuan mengambil semua mempublikasikan platform
yang membutuhkan editor eksternal berbeda (mis. Unity iPhone, Wii) dan dimasukkan ke dalam

editor tunggal bersama dengan opsi penerbitan yang ada. Pada saat Rilis Unity 3.0 ada lebih dari
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200.000 pengembang Unity yang terdaftar. Kesatuan menjadi mesin # 1 untuk tujuan pendidikan,
dan teknologi yang paling banyak digunakan di platform seluler. [19] Pada 22 Desember 2011,
Unity Technologies memulai open beta pubik pertama untuk Unity 3.5.

2.1.3 Pengenalan Unity
Unity tidak dirancang untuk proses desain atau modelling, dikarenakan unity bukan tool

untuk mendesain. Banyak hal yang bisa dilakukan dengan unity, ada fitur audio reverb zone,
particle effect, dan Sky Box untuk menambahkan langit. Fitur scripting yang disediakan,
mendukung 3 bahasa pemrograman, JavaScript, C#, dan Boo.

Unity mempunyai 2 versi komersil, yaitu versi berbayar dan versi gratis. Unity dengan
versi gratis memberikan fasilitas kepada kita untuk mempelajari, mengembangkan dan
mempublish game yang kita kembangkan dengan royalti atau harga jual game kita secara gratis.
Sedangkan untuk Unity yang versi pro atau veri berbayar, kita dapat menjual game yang kita
kembangkan dengan harga yang kita berikan secara komersil.

2.2 Perbedaan Versi Unity
Tabel 1 Perbedaan Versi Unity

VERSI BERBAYAR VERSI GRATIS
Pro Plus Personal
Untuk  professional yang | Untuk creator yang serius | Untuk pemula, mahasiswa dan
menginginkan  fitur  yang | menggunakan unity pada | penggemar yang ingin belajar
sangat lengkap. kehidupan ~ mereka  dan | memulai dengan Unity
berencana menerbitkannya
Terdiri dari : Terdiri dari : Terdiri dari :
*  Semua fitur plus » Screen Splash yang dapat | Semua fitur inti
e Premium support dan disesuaikan (fitur akan dibahas pada slide
tersedianya source code | ¢ Performance Reporting berikutnya)
access » Extended Unity Analytics
* Flexible Seat
Management
* Pro Skin Editor Ul
Harga $125/bulan Harga $55/bulan [9] -
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1.2.1 Pengenalan Unity 2017.3.1
Unity 2017.3.1 adalah versi unity keluran terbaru dan di rilis pada tahun 2017. pada unity
2017.3.1 tersedia untut semua user dengan active subscription plan (Personal, Plus and Pro).

€ Unity 2017.3.1f1

Projects BMew  [Popen (@) MyAccount

On Disk

In the Cloud

Gambar 2.3 Tampilan Awal Unity 2017.3.1

2.3 Fitur Unity 2017.3.1
Pada Unity 2017.3.1 terdapat pembaruan seperti:
1. Animation Clips
Animation Clips adalah salah satu elemen inti dari Unity’s animation system yang
mendukung animasi import dari sumber eksternal, dan menawarkan kemampuan untuk membuat

animation clip dari awal menggunakan Animation window.
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[[© nspector | : P

Bake Animations
Anim. Compression | Keyframe Reduction

Rotation Error 05
Position Error 0.5
Scale Error 0.5

Rotstion error is delined a5 maximum angle devigtion allowed in
degrees, for others it is defined as maximum distance/delts devistion

allowed in perconts

Animated Custom Proj|__
Start End

SHE
E HumanoidWalk o,
Length @40 50 PP
l 0:00 500 § 10:00 I
Start (2152 End 244.5)
Loop Time W
Loop Pose ¥4 loop manch o
Cycle Offset 0.86

Roo asiorm Rotation
HumanoldWalk

™ |

0:02 (007.4%) Frame 217

Gambar 2.4 Contoh Animasi Import

2. Animator Controller

Animator Controller digunakan untuk mengatur dan memelihara seperangkat Klip Animasi

dan Transisi Animasi terkait karakter atau objek.
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22 Animator
| Layers || Parameters |

(orMame p)

& Base Layer Auto Live Link

= Strafe
= Fire

= Die

Animators/Player Animatar,contraller

Gambar 2.5 Animator Controller

3. Build Settings

Build Settings digunakan untuk memilih platform target, menyesuaikan pengaturan untuk

build, dan memulai proses build.

22

Scenes In Build

M scenes/Title Screen.unity
Scenes/Controls unity
M scenes/stage 1.unity

o scenes/Stage 2.unity

M sScenes/Stage 3.unity

M scenes/stage 4.unity

[ scenes/Stage 5.unity

L S R -]

Add Open Scenes

Platform ‘
- .
& PC, Mac & Linux Standalone
Target Platform
Architecture
i Development Build Cl
Autoconnect Profiler Ol
Script Debugging |
@ BlackBerry
ﬁ Tizen E
[ Switch Platform “ Player Settings...] [ Build ][ Build And Run ]

Gambar 2.6 Build Settings
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4. Script Compilation And Assembly Definition Files

Unity secara otomatis dapat mendefinisikan bagaimana skrip dapat dikompilasi ke rakitan
yang dikelola. Biasanya, skrip dikompilasi secara berulang sesuai dengan banyak skrip yang
ditambahkan ke Proyek.

Assembly-CSharp.dll Stuff.dll Library.dll

Main.dll
uiiBllin
@ ThirdParty.dll

—1 L

Gambar 2.6 Script Compilation

5. Artists & Designers: Brand new tools for storytelling and in-game sequences

Timeline adalah tool visul baru yang berfungsi membuat konten sinematik seperti
cutscenes dan trailers, gameplay sequences, dan lain lain. Pada timeline dapat mengatur objek
pada game, animasi, suara, dan adegan lain sehingga dapat disatukan, diulang, dipotong dan lain-
lain.

Untuk mengakses jendela Timeline Editor, pilih Timeline Editor dari menu Window..
Timeline Editor akan menampilkan apa saja yang telah dipilih dengan cara drag and drop dari

jendela proyek atau tampilan scene.

Timeline
| Preview |1 | 14 | » [ b1 [pel | [[»] ][0 | s

n
| Preview | | 1 | > [ M [pel | [[»] ][0 [/ ¢ ExampleTimeline

I Animation Track

‘ Audio Track

Gambar 2.7 Timeline Unity 3D
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6. Artists & Designers: Brand new tools for storytelling and in-game sequences

Cinemachine adalah Sistem kamera canggih yang digunakan untuk menangkap gambar
dengan baik pada waktu terbaik berdasarkan komposisi dan interaksi adegan, tanpa kode apapun
serta dapat mengirim gambar ke era sinematografi prosedural. Fitur Cinemachine tersedia di asset
store, sehingga harus menambahkan ke dalam proyek terlebih dahulu
7. Asset Store

Asset Store adalah kumpulan (toko) yang berisi aset-aset unity yang dapat dimasukan pada
projek. Dalam asset store terdapat aset-aset yang berbayar dan tidak berbayar. Gambar “a”
merupakan beberapa contoh aset berbayar dan gambar “b” merupakan beberapa contoh aset yang

gratis (tidak berbayar) [10].

Lowpoly
Low Pody = e %
MESH GENVR'TO%/ i ; " e
A= yps 2 v 11 Sci-fi Units

Low Poly Mesh Generator Medieval Enemies Pack PolyWorld: Woodland Lo... Scifi Military Pack Pro
$15 $175 $50 $125 $100

Top Free Packages

) unity

Standard Assets Post Processing Stack ProBuilder TextMesh Pro
FREE FREE FREE FREE

Gambar 2.8 Contoh Assets yang ada di Asset Store

8. Artists & Designers

Brand new tools for storytelling and in-game sequences post-processing memudahkan
penerapan filter realistis ke layar dengan menggunakan terminologi industri film, kontrol, dan
format ruang warna untuk menciptakan visual yang berkualitas tinggi agar terlihat lebih dramatis

dan realistis, sehingga dapat menceritakan kisah visual yang lebih baik.
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Monitors

- SN

Gambar 2.9 Post-processing Pada Unity 2017.3.1

1.3.1 Interface Unity 2017.3.1
Pada bagian ini kita akan mempelajari interface dari unity3D versi 2017.3.1 yang telah

diinstal sebelumnya. Untuk mempelajarinya kita mengambil sample project yang telah disediakan
unity sebelumnya, yaitu Standart Assets Example Project. Agar bisa menggunakan Standart Assets

Example Project install terlebih dahulu UnityStandartAsset dan UnityExampleProjects. Download

. https://unity3d.com/get-unity/download/archive.

d’
UnityDownload& UnityExampleProj

ssistant-2017.3.7f ectSetup-2017.3.1
1.exe fl.exe

d’
UnitySetupfd-201 | UnityStandardAss

7.3 .exe etsSetup-2017.3.1
fl.exe

Gambar 2.10 Standart Assets

Jika tidak muncul dalam history open unity maka bisa klik open other cari file tersebut di
C:\Users\Public\Documents\Unity Projects\Standard Assets Example Project.
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Q Unity 2017.3.171
Projects  Learn (B New  [7)open

1ple Project

On Disk

3.0b8 | rdcontentteam

In the Cloud

Gambar 2.11 Stanndard Asset Yang Keluar di Project Awal Unity 2017.3.1

Setelah itu buka scene car pada folder Assets > SampleScenes > Scenes.

1.3.2 Bagian Window Pada Tampilan Unity 2017.3.1

5. Hierarchy Window 2. Scene View 1. T(10Ibar 3. Inspektq Windows
- o IEH

Unity 2017.3.1f1 Personal (64bit) - Car.unity - §andard Assets Example Project - PC, Maq & Linux Standalone <DX11>
File Edit Assets GamdObject Component Mobile Input Window Help

[ @ coab - JIL.o Wlaccount - M caprs - JLavout -]
ector [ Y

S I

E
|Open |

eeeee

CharacterT..  2dCharacte; AircraftPro.. Al CarAIWayp.. Particles

a
ssets - + Scenes
dch. r o Aircrafdet.  Aircraftdet.. afeP ircraftro.. (D CharacterFi.. CharacterT.. CharacterT.

y

N
4. Project Window
Gambar 2.12 Bagian Window Pada Unity 2017.3.1

1. Toolbar menyediakan akses ke fitur kerja yang paling penting.
= Di sebelah kiri toolbar berisi alat dasar untuk memanipulasi scene view dan asset-asset
yang ada di dalamnya.
= Ditengah adalah play, pause and step control.
= Tombol di sebelah kanan merupakan tombol akses ke Unity Cloud Services dan Unity
Account, diikuti oleh menu layer visibility dan menu editor layout (yang menyediakan
beberapa layout alternatif untuk jendela editor, dan untuk menyimpan layout sendiri).
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2. Scene view menampilkan navigasi dan area untuk mengedit scene. Scene view dapat
menampilakan persekti secara 2D atau pun 3D, tergantung pada jenis proyek yang sedang
dikerjakan

3. Inspectore Window digunakan untuk melihat dan mengedit semua properti dari objek yang
dipilih. Setiap objek memiliki rangkaian properti yang berbeda, tata letak dan isi dari
inspectore window akan bervariasi.

4. Project Window menampilkan library aset yang digunakan dalam proyek. Bila kita mengimpor
aset ke proyek, mereka akan muncul.

5. Hierarchy Window adalah representasi hirarki dari setiap objek yang terdapat dalam scene.
Setiap item dalam scene memiliki entri dalam hierarki. Hirarki mengungkapkan struktur

bagaimana objek saling melekat satu sama lain.

1.3.3 Bagian Pada Unity 3D
1. Navigasi Scene View
Pada bagian Scene ini digunakan untuk mengarahkan layar ke bagian dimana ingin

mengedit objek yang diinginkan.

Gambar 2.13 Navigasi Scene View

Dengan menggunakan mouse, dapat melakukan zoom in dan zoom out dengan

menggunakan Scroll.

» Scroll ke Atas

Scroll ke Bawah untuk Zoom In

untuk Zoom Out

Gambar 2.14 Scroll Mouse
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Untuk merotasi Scene View dapat menekan tombol “Alt” pada keyboard dengan cara
ditahan. Lalu mengarahkan mouse sehingga akan terlihat cursor berubah menjadi icon mata yang

kemudian bisa kita gerakkan.

Gambar 2.15 Shutcut Untuk Merotasi Scene

2. Gizmo

Scene Gizmo ini adalah pengaturan yang diurutkan secara otomatis berdasarkan tingkat
perspective tampilan dan isometric tampilan. Scene Gizmo ini sebenarnya menunjukkan sebuah
kompas yang sesuai dengan keadaan di dunia nyata dengan menggunakan tampilan perspective.
Dengan menggunakan Gizmo ini kita juga mendapatkan pandanagan secara isometric yang biasa
ada pada tool-tool untuk membuat objek 3D.

|

+

N

Gambar 2.16 Gizmo Unity

= Sumbu y untuk menampilkan objek dari atas atau bawah
= Sumbu x untuk menampilkan objek dari kanan atau Kiri

= Sumbu z untuk menampilkan objek dari depan dan belakang
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3. Hirarchy View

Hierarchy adalah sebuah susunan yang didalamnya merupakan objek objek yang ada dalam
scene kita. yang saling membangun dan berkaitan. Hierarchy ini dapat memepercepat pekerjaan
kita ketika memasukkan objek yang ada pada scene. Bisa langsung dengan drag and drop ke panel

Hierarchy. Hierarchy ini juga meberikan fitur pencarian yang sangat akurat.

= Hierarchy | =
Create | larAll

b Cameras

b GeometryDynamic
b Geometry Static
Uz

b Car

b Helpers

b Lights

b CarTiltControls

Gambar 2.17 Hierarchy

4. Scene Unity

Pada scene Unity Standard Asset ini mempunyai tampilan yang sangat banyak sekali untuk
dijelajahi. Khususnya pada Scene view kita bisa melihat fitur nya satu persatu. Pada secene view
kita bisa menemukan 3D view yang bisa kita atur secara manual untuk melihat apa yang ingin kita
lihat berdasarkan tampilan objek 3D yang ada. Kita bisa memilihnya pada bagian pojok kiri atas

pada panel Scene.
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# Scene € Game.

| Shaded Tl 2D % | <) | 7|
Shading Mode
¥ Shaded

Wireframe

Shaded Wireframe

Miscellaneous
Shadow Cascades
Render Paths
Alpha Channel
Overdraw
Mipmaps

Deferred
Albeda
Specular
Smoothness
Narmal

Global Illumination
UV Charts
Systems
Albedo
Emissive
Irradiance
Directionality O
Baked

¥ Show Lightmap Resolution

.~ A A A _.~A
Gambar 2.18 Scene Unity

Scenes »

= Mode Wireframe yaitu mode yang menggambarkan seperti blueprint yang terdiri dari garis

garis kesatuan yang membangun object 3D nya. Wireframe ini berfungsi untuk melihat bagian

mana object 3D yang disusun bisa kita atur.

# Scene € Game £ Asset Store
| Wireframe -||2p || % ~|

Gambar 2.19 Mode Wireframe

= Mode Shaded adalah mode untuk Menampilkan permukaan object dengan tekstur yang
terlihat.
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# Scene € Game £ Asset Store
Shaded ~||2p || @ | <) | &~

Gambar 2.20 Mode Shaded

= Mode Shaded Wireframe adalah 2 mode yang digabungkan menjadi satu sehingga objek
terlihat tekstur dan terlihat garis-garis.

€ Game 5 Asset Store

G

A =

Gambar 2.21 Mode Shaded Wireframe

Fitur Lain

# Scene | € Game
Shaded

Gambar 2.22 Fitur Lain Pada Unity

a. Tampilan pada layar 2D : untuk mengubah tampilan 2D dan 3D pada scene. dalam mode 2D,

kamera melihat ke arah z positif, dengan sumbu x mengarah ke kanan dan sumbu y mengarah
ke atas

b. Tampilan lighting : menghidupkan dan mematikan lighting pada scene
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c. Mode suara: menghidupkan dan mematikan audio effect pada scene

d. Tampilan material : Untuk mengaktifkan dan menonaktifkan efek rendering pada scene.

5. Game View

Game view merupakan tampilan dari kamera yang berada dalam game dan tampilan akhir

dari game yang akan dipublikasikan

Maximize On Play | Mute Audio | Stats | Gizmos ~

Gambar 2.23 Menu Game View

Berikut adalah macam-macam tombol pada game view :

Tabel 2 Macam Macam Tombol Pada Game View

No. Tombol Fungsi

1. Display Untuk memilih kamera yang terdapat pada list kamera.

2. Aspect Pilihan angka yang digunakan untuk menguji bagaimana
permainan akan terlihat pada monitor dengan rasio
aspek yang berbeda.

3. Scale slider Scroll ke kanan untuk memperbesar dan memeriksa area
pada layar game secara rinci dan scroll ke kiri untuk
memperkecil tampilan keseluruhan layar.

4. Maximize on Untuk memaksimalkan tampilan game

Play
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5. Mute audio Digunakan ini untuk mematikan audio dalam game saat
memasukkan Play Mode

6. Stats Untuk mengaktifkan overlay Statistik, yang berisi
Statistik Rendering tentang audio dan grafik permainan.
Ini sangat berguna untuk memantau kinerja game saat
berada di Mode Bermain.

7. Gizmos Untuk mengaktifkan visibilitas Gizmos.

(> 11 P

Gambar 2.24 Play Mode

Play mode digunakan untuk mengontrol Play Mode Editor dan melihat bagaimana
permainan diputar. Saat berada di Play Mode, setiap perubahan yang dibuat bersifat sementara,

dan akan disetel ulang saat keluar dari Play Mode.

6. Project View
Project View merupakan tampilan susunan objek kita yang ada di Windows Explorer.

i Pr’o]ect | Hconsale a
Create

bﬁ Edltm’ 4| Assets - SampleScenes » Scenes -

¥ SampleScenes

= i@@@@@@@@@

& Models ofT. 2dCharacter Alrcrafiler.  Aircraftler.  AircraftPro.. AlrcraftPro CarAIWayp. CharacterFi_ Characrar
&5 Mavmesh

PhysicsMaterials
(& Prefabs

L= ]
&3 Scripts

Shaders aaaaaa RollerBall
&l Textures

(3 Standard Assets —

4
[}

Gambar 2.25 Project View

7. Console
Pada sebelah panel project terdapat panel console. Fungsi dari panel console sendiri adalah
untuk programmer melihat debugging, apakah terjadi error atau tidak saat ditambahkan beberapa

script pada scene.
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El consale

| Clear| | Cnllapsel Clear on Pla'yl Error Pause | | (_?;'ﬂ | {:50 | 02

o You have some scripts andfor assemblies that use old obsolete API, that Unity can try to upgrade to the new

v Assets/Scripts /Al NewBehaviourScript.cs(8,17): error C50619: “UnityEngine.Compaonent.rigidbody' is obsc

Assets/Scripts fAlfNewBehaviourScript.cs(8,17): error C50619: " UnityEngine.Component.rigidbody’ is obsolete:
" Property rigidbody has been deprecated. Use GetCompaonent<Rigidbody=() instead. (UnityUpgradable)’

Gambar 2.26 Tampilan Console Terjadi Error

8. Inspector
Inspector merupakan properties dari object yang terdapat pada scene. Pada inspector disini bisa
dilihat komponen — komponen apa saja yang ada pada objek tersebut, seperti rigidbody, script,

dan sejenisnya.
| © Inspector |1 Lighting RS

M [car | []static +
Tag | Player # | Layer | Default 4]

Prefab | Select | Revert | Apply

¥ .~ Transform i
Position %[0 Yo zlo |
Rotation X|0 Y0 Z0
Scale X1 Y1 Z[1

¥ % Rigidbody
Mass 1000
Drag 0.1
Angular Drag 0.05
Use Gravity ™
Is Kinematic -
Interpolate [ Mane

Collision Detection | Discrete
¥ Constraints

¥ || M car Controller (Script)

I-T|

Script - CarController o]
Car Drive Type | Four Wheel Drive i

b Wheel Colliders
> Wheel Meshes
» Wheel Effects
Centre Of Mass Offset

x/0 v o lzlo
Maximum Steer Ang|25
Steer Helper ——| 644

Traction Control —) | 1

Full Terque Over All 2500

Reverse Torque 500

Max Handbrake Torc/1e+08

Downforce 100

Speed Type | MPH ™
Topspeed [150 [N
Doun o Aoy 1%

Gambar 2.27 Tampilan Inspector
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B. PRAKTIK

Kita akan melakukan praktik tentang pengenalan Unity 2017.3.1. Pada praktik bab ini agar
pembaca mengenal dasar-dasar Unity 3DCara Membuat Project Baru Pada Unity 3D. Mengetahui
bagian dan fungsi dari user interface Unity 2017.3.1 Membuat New Project dan New Scene

Menambahkan Objek Import Package

PERALATAN
1. Komputer
2. Instalasi Unity
3. Koneksi Internet

LANGKAH LANGKAH PERCOBAAN

Cara Membuat Project Baru Pada Unity 3D.

1. Install unity3D versi 2017.3.1, lalu install UnityStandartAsset dan UnityExampleProjects.
Sebelumnya, download installer Unity Standart Asset dan Unity Example Projects di

https://unity3d.com/get-unity/download/archive.

Unity download archive
_ g€

- B UnityDownloadA  UnityExampleProj  UnitySetupf4-201 | UnityStandardAss
ssistant-2017.3.1f  ectSetup-2017.3.1 731 exe etsSetup-2017.3.1
T.exe flexe fl.exe

|
Gambar 2.28 Download Example Project

2. Jalankan aplikasi master instalasinya dan tunggu hingga proses instalasi selesai.

Q Example Project for Unity 2017.3.111 Setup = 9 Standard Assets for Unity 2017.3.1f1 Setup =
Installing Installing
. . . Please wait while Standard Assets for Unity 2017.3. 1f1 is being installed.
Please wait while Example Project for Unity 2017, 3. 1f1 is being installed,
Installing Standard Assets...
Installing example project...

Gambar 2.29 Proses Instalasi
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3. Jalankan Unity 2017.3.1. Ketika unity mulai dijalankan, maka akan muncul tampilan awal
seperti pada gambar disamping. Tampilan tersebut sudah terdapat Standard Assets Example

Project.

Q Unity 2017.3.11

Projects  Learn

On Disk Standard Assets Example Project
Path: C:\Users\Public\Documents\Unity Projects

In the Cloud

New Unity Project
Path: C:\Users\Maghfirah Aginda P\D

Gambar 2.30 Tampilan Awal Unity 2017.3.1

4. Jika tidak muncul dalam history open unity maka bisa klik open other cari file tersebut di
C:\Users\Public\Documents\Unity Projects\Standard Assets Example Project. (Windows)
5. Path:/User/Shared/Unity|Unity version: 2017.3.1 (Mac)

Mengetahui bagian dan fungsi dari user interface Unity 2017.3.1

1. Tampilan awal saat membuka yaitu disebut Navigasi Scene.

| # scene € Game

’
i

Gambar 2.31 Navihasi Scene Unity 2017.3.1
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2. Gunakan mouse untuk melakukan zoom in dan zoom out dengan cara menggunakan scroll.

Scroll ke Scroll ke
Bawah untuk Atas untuk
Zoom Out Zoom In

Gambar 2.32 Mouse

3. Gunakan Gizmo untuk mengubah scene view perspective atau isometric.

Gambar 2.33 Gizmo Unity

4. Gunakan “alt” untuk merotasi scene view hingga cursor berubah menjadi icon mata, lalu
gerakkan.

f

I
'Alt_J++ —

Gambar 2.34 shotcut Merotasi Scene View

5. Gunakan Hierarchy Untuk mengetahui objek apa saja yang ada pada scene kita, . Hierarchy

terletak pada samping Kiri scene view.
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Q 7 ersonal (64bit) - Car.unity - Standard Assets Example Project - PC, Mac & Linux Standalone <DX11> - s IEN

[C coin = IO I pccount < DR carers. <l covovt. <}
B

LS
) 4N
4 Assets » SampleScenes - Scenes - 1
CharacterT.  2dCharacter  Aicrsbdet.  Arcraiet.  Aircrstre.  Aicraore. QTP CorAlways. Charscterfi. ChascteT. ChascteT.  Parscles

¥ carunty —_—— |

Gambar 2.35 Tampilan Hierarchy Pada Unity 2017.3.1

6. Klik Scene untuk mengubah tampilan pada scene view. Terdapat banyak tampilan scene view

yang di sediakan dan kita bisa menggunakan fiturnya yang telah di sediakan.

# Scene € Game

Shaded *|| 20 || = | <)

Shading Mode

+ Shaded
Wireframe
Shaded Wireframe

Miscellaneous
Shadow Cascades
Render Paths
Alpha Channel
Overdraw
Mipmaps

Deferred
Albedo
Specular
Smoothness
MNarmal

Global Illumination
UV Charts
Systems
Albedo
Emissive
Irradiance
Directionality
Baked

¥ Show Lightmap Resolution

Gambar 2.36 Scene Pada Unity 2017.3.1
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7. Klik Inspector yang terletak pada kanan scene view untuk menampilkan properties dari object

® Inspector

PG Ol - =
Tag | Player ﬂ Layer mh—J‘

Prefab [ Select [ Revert [ _Apply |

yang terdapat pada scene.

Gambar 2.37 Inspector Pada Unity 2017.3.1

Membuat New Project dan New Scene
1. Setelah kita selesai create project, maka kita akan masuk pada bagian lembar kerja atau scene

seperti pada gambar dibawah ini.

L] Unity 2017.31f1 Personal (64bit) - Untitied - New Unity Project (1) - PC, Mac & Linux Standalone <DX11> - o IEN

Gambar 2.38 Scene Baru
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2. Untuk membuat scene baru yaitu klik file > new scene atau dengan menekan ctrl + N.
Ctrl o+ ml.l

Gambar 2.39 Shutcut Membuat Scene Baru

3. Untuk menyimpan scene yang sedang aktif tersebut bisa klik file > save atau tombol ctrl + S
Ctrl |t %‘_]

Gambar 2. 40 Shutcut Untuk Menyimpan Scene

Menambahkan Object
1. Untuk menambahkan object ke dalam scene klik kanan pada bagian hierarchy.

2. Pilih object sesuai yang anda butuhkan.

< Unity 2017.3.1f1 Personal (64bit) - Untitled - New Unity Project (1) - PC, Mac & Linux Standalone <DX11>
File Edit Assets GomeObject Component Window Help

Select Prefab

Create Empty
3D Object

2D Object
Effects

aaaaaa

avorites
) All Material
) All Models o
() All Prefabs

This falder is empty

Gambar 2.41 Menambahkan Object Pada Unity 2017.3.1

Import Package

Untuk mengimport package dengan cara:
1. klik menu Assets

2. Import Package

3. Custom Package
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Unity 2017.3.1f1 Personal (64b

F it I Assets I GameObject Compeonent Window Help
Create P beal
= Hierarc ShoalinlEploze; e | € Game £ Asset ¢
Create ™ Open || 2D fe ﬂiﬂl =R
v <) untit Delete
Main
Direct| Open Scene Additive
Import Mew Asset..,
Import Package » I Custom Package...

Export Package...

2D
Find References In S5cene Cameras 3
Select Dependencies Characters

Refresh Ctrl+R CrossPlatforminput
Reimport Effects
Reimport Al Environment
ParticleSystemns
Extract From Prefab T
Run APl Updater... Utility
Vehicles

Open C# Project

£3 Project —
| Clear | | Callapse | Clear on Play | Errar Pause | Editar ~

Gambar 2.42 Mengimport Package Pada Unity 2017.3.1

C. KESIMPULAN

Pengenalan unity meliputi interface unity 3D, membuat new project, menambah objek, dan

mengimport package.

D. SOAL
1. Unity Technologies didirikan pada tanggal ...
a. 4 Agustus 2004 c. 2 Agustus 2004
b. 3 Agustus 2004 d. 1 Agustus 2004

2. Elemen inti dari Unity’s animation system yang mendukung animasi import dari sumber
eksternal, dan menawarkan kemampuan untuk membuat animation clip dari awal
menggunakan Animation window disebut ...

a. Animation Clips c. Animator Controller
b. Build Settings d. Inspectore Window

3. Kumpulan (toko) yang berisi aset-aset unity yang dapat dimasukan pada projek disebut ...
a. Unity Store b. Assets Store c. Play Store d. App Store

4. Pada bagian Scene ini digunakan untuk mengarahkan layar ke bagian dimana ingin
mengedit objek yang diinginkan disebut ...
a. Hierarchy b. Gizmo c. Navigasi Scene d. Inspector
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42

10.

Mode yang menggambarkan seperti blueprint yang terdiri dari garis garis kesatuan yang
membangun object 3D nya.?

a. Mode Wireframe c. Mode Shaded

b. Mode Shaded Wireframe d. Mode 3D

Pada tombol game view yang berfungsi untuk memaksimalkan tampilan game adalah ...
a. Display b. Aspek c. Scale slider d. Maximize on play
Tampilan susunan objek kita yang ada di Windows Explorer disebut ...

a. Scene view b. Game view c. Project view d. Hierarchy
Shutcut untuk membuat scene baru ...

a. Ctrl+S b.Ctrl + C c.Ctrl+B d. Ctrl + N

Cara menambahkan object ke dalam scene ...

a. Klik kanan pada bagian project c. Klik kanan pada bagian console
b. Kilik kanan pada bagian scene  d. Klik kanan pada bagian hierarchy
Cara untuk mengimport package adalah ...

a. Klik menu Assets >Import New Assets

b. Klik menu Assets > Import Package > Custom Package

c. Klik menu Assets > Game Object > Custom Package

d. Klik menu Assets > Create > Custom Package
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BAB 3
PEMBUATAN ASSETS

TUJUAN

1. Pembaca dapat mengembangkan asset 3D yang sudah ada
2. Pembaca dapat menambahkan material, texture, lighting, dan tata letak kamera pada
asset 3D

A. DASAR TEORI
3.1  Grafik Komputer 3D

Grafik komputer 3D adalah karya seni grafis yang dibuat dengan bantuan komputer digital
dan perangkat lunak 3D khusus. Secara umum, istilah itu mungkin juga mengacu pada proses
pembuatan grafik tersebut, atau bidang studi 3D teknik grafis komputer dan teknologi terkaitnya.
Grafik komputer 3D berbeda dari grafik komputer 2D dalam dimensi tiga dimensi representasi
data geometris disimpan di komputer untuk tujuan melakukan perhitungan dan rendering gambar

2D. Terkadang gambar-gambar ini sudah dirender sebelumnya.

Q;_;;;;‘ Focal

——t—  Point*0O”

Gambar 3.1 Proyeksi Perspektif

Secara umum, seni pemodelan 3D, yang menyiapkan data geometrik untuk komputer 3D

grafis mirip dengan memahat atau fotografi, sedangkan seni grafis 2D analog dengan lukisan.
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Namun, grafik komputer 3D bergantung pada banyak algoritma yang sama dengan grafik
komputer 2D.

Dalam perangkat lunak komputer grafis, perbedaan ini kadang-kadang kabur; beberapa
Aplikasi 2D menggunakan teknik 3D untuk mencapai efek tertentu seperti pencahayaan,

sementara beberapa aplikasi terutama 3D menggunakan teknik visual 2D [11].

3.1.1 Sejarah 3D Computer

5% 4

Graphic

WEE U

Gambar 3.2 Foto William Fetter

William Fetter yang dikenal dengan sebagai Coining Grafis Komputer pada tahun 1961
dan mengabdikan dirinya bekerja di Boeing.

Salah satu tampilan animasinya yang pertama kali yaitu Futureworld (1976). Mencakup
animasi wajah manusia dan sebuah tangan, yang pada awalnya muncul dalam suatu karya
eksperimental pada tahun 1972 yang bertajuk A Computer Animated Hand. Diciptakan oleh

Mahasiswa Universitas Utah, Edwin Catmull dan Fred Parke.
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Gambar 3.3 Poster Animasi Futureworld (1976)

Perangkat Lunak (Software) 3D mulai muncul pada akhir tahun 1970an. Contoh yang
pertama kali diketahui adalah 3D Art Graphics, yang ditulis oleh Kazumasa Mitazawa dan dirilis
pada bulan Juni tahun 1978 untuk Apple II.

Arrt = ||

Gambar 3.4 Komputer Apple Il yang digunakan untuk 3D Art Graphics

3.2 Assets

Asset merupakan bagian terpenting dalam pengembangan game maupun pengembangan
3D interaktif yang dikembangkan pada unity ini nantinya. Asset merupakan sekumpulan bagian
bagian file yang berada dalam satu project yang berisi sekumpulan object dianatraranya Objek 2D,
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Objek 3D, Gambar, Suara, Script, dan lain lain. Asset ini merupakan sekumpulan objek yang

nantinya akan membangun aplikasi atau game kita hingga siap di publish [12].

Gambar 3.5 Contoh Asset Unity

3.3  Komponen Dasar Object 3D
1. Vertex

Vertex adalah titik-titik yang dihubungkan dengan edge, dan merupakan komponen paling
dasar dari objek 3 dimensi. Untuk memanipulasi posisi vertex dapat dilakukan dengan mengganti

nilai kordinat x, y, dan z pada vertex tersebut. Contoh vertex pada objek polygon [13].

Gambar 3.6 Komponen Dasar 3D Vertex

2. Edge
Edge adalah garis yang menghubungkan lebih dari dua vertex(titik). Contoh edge pada
objek polygon [13].
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Gambar 3.7 Komponen Dasar 3D Edge

Face

Face adalah sebuah permukaan yang dibentuk oleh minimal 3 edges (tris) yang tertutup.
Contoh face pada objek polygon [13].

Gambar 3.8 Komponen Dasar 3D Face

Normal
Normal digambarkan dengan sebuah vector yang tegaklurus dengan permukaan sebuah
face. Normal ini biasanya akan menentukan sisi mana yang akan dimasukan kedalam kalkulasi

proses render, atau dalam beberapa hal, normal suatu face juga salah satu elemen penting dalam
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kalkulasi simulasi dynamic. Kalau normal arahnya terbalik, biasanya suka ada warna hitam

pada sekeliling edges dari face tersebut [13].

Gambar 3.9 Komponen Dasar 3D Normal

3.4 3D Model
Model 3D dibuat dengan menggunakan empat metode popular antara lain :
1. Primitives Modeling

Metode yang paling sederhana untuk pemodelan tiga dimensi adalah dengan menggunakan
objek primitif. Metode ini menggunakan objek geometris primitif seperti silinder, kerucut, kubus
dan bola.

Pemodelan primitif digunakan terutama dalam mengembangkan model 3D pada aplikasi
teknis, misalnya dalam pemodelan arsitektur, desain interior, mesin, konstruksi bangunan, dan

sebagainya [13].
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Gambar 3.10 Contoh Primitives Modeling

2. Polygonal Modeling

Banyak model 3D yang dibuat dengan menggunakan metode poligonal model bertekstur.
Pemodelan poligonal adalah metode untuk menciptakan model 3D dengan menghubungkan
segmen garis melalui titik-titik dalam ruang 3D. Titik-titik dalam ruang juga dikenal sebagai
vertex/vertices (simpul).

Kekurangan polygonal modeling adalah tidak dapat membuat permukaan melengkung
secara akurat sesuai dengan ukuran geometris yang tepat. Permukaan melengkung biasanya
dibentuk melalui metode penghalusan (smoothing) yang dibentuk dari satu garis ke garis lainnya,
atau dari satu poligon ke poligon lainnya.

Oleh karena itu, polygonal modeling biasa dipergunakan untuk membuat model-model 3
Dimensi objek non geometris, seperti pada pemodelan karakter atau character modeling, kartun,
mahluk hidup, dan lain-lain [13].

Gambar 3.11 Contoh Polygonal Modeling
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3. NURBS

NURBS adalah singkatan dari Non-Uniform Rational B-Spline, salah satu metode
pemodelan yang menggunakan garis melengkung halus sebagai dasar dari pembentukan objek 3
dimensi. NURBS modeling dapat ditemukan dalam perangkat lunak populer seperti Maya, 3DS
MAX.

Pemodelan NURBS benar-benar menciptakan permukaan melengkung halus melalui garis
lengkung (Spline) secara akurat. Oleh karena itu, NURBS modeling biasa dipergunakan untuk
pembuatan model-model 3 Dimensi objek-objek geometris dengan tingkat keakuratan tinggi,
misalnya pada pemodelan pesawat, mobil, dan lain-lain [13].

Gambar 3.12 Contoh NURBS Modeling

4. Patch Modeling

Metode ini serupa dengan prosedur pemodelan NURBS. Model 3 Dimensi dibuat dengan
menggunakan garis-garis lengkung untuk mengidentifikasi permukaan yang terlihat. Pada Patch
modeling, objek 3 Dimensi akan tersusun atas permukaan-permukaan berbentuk segitiga atau

segiempat yang saling berhubungan [13].
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Gambar 3.13 Contoh Patch Modeling

Software 3D

Berikut ini beberapa contoh software 3D yang support untuk software Unity.

1.

3.4

2
3
4.
5

Auto Desk Maya
Auto Desk 3D Max
Blender

Wings 3D

Cheetah 3D

Modelling 3D

3.4.1 Material

Material adalah asset yang mengontrol tampilan visual pada obyek game serta berisi shader

dan script yang mengontrol tampilan render. Didalam material ini terdapat beberapa pengaturan

yaitu Properties, Warna, dan Tekstur.
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Aviets + Standard Asssts - Vehicies - Car + Materals

doopeEmog

PLL
H

SyCatigh ShyCurtigh- SkyCarlih. SiyCarthe ShyCarmha.  Teatshd

Gambar 3.15 Mengganti Warna Asset

How Mt Daclebur. Panclesm-.

FEDLEEER
RSS2

H

3.4.2 Texturing
Texture adalah bagian warna dan bentuk terluar dari objek 3D kita. Texture ini seperti

sebuah kulit yang menyelimuti objek.

Standard (Roughness setup)
Standard (Specular zetup)
=

Custom

Fx

Gul

Mobile

P
STV ety - Stndard Assets + Ve + Car - Materials

Gambar 3.16 Mengganti Texture Asset

3.4.3 Macam — Macam Legacy Shaders
1. Bumped Diffuse
Pencahayaan yang hanya bergantung pada sudut, dan tidak berubah saat kamera bergerak

atau berputar [14].

52



MARI BELARMAIN VIRTUAL REALITY DENGAN UNITY 3D

4 Base (RGE)
Tiling. Offset
« 1 o
¥ 0

Normalmap
Tiling Offset
x 1

0

Gambar 3.17 Bumped Diffuse

2. Bumped Specular

Efek pencahayaan dimana bayangan sumber cahaya pada permukaan objek. Efek specular
terlihat pada objek akan mengkilat, semakin mengkilat maka makin jelas bayangan sumber cahaya
yang terlihat pada permukaan objek tersebut [14].

+ Scene e
.

z, 1 .x
| Main Color
\T‘ | specular Color
| Shininess
| Base (RGB) Gloss (A)
Tiling
0

y 1

| Normalmap
Tiling
T

Gambar 3.18 Bumped Specular

3. Decal

Tekstur decal dapat melengkapi tekstur utama. Misalnya, jika Anda memiliki dinding bata,
Anda bisa menghias tekstur batu bata sebagai tekstur utama, dan menggunakan tekstur decal
dengan alpha channel untuk menggambar grafiti di tempat yang berbeda di dinding [14].
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Gambar 3.19 Decal

4. Diffuse Detail

Shader ini adalah versi shader Diffuse biasa dengan data tambahan. Ini memungkinkan
Anda menentukan tekstur "Detail" kedua yang secara bertahap akan muncul saat kamera
mendekatinya. Tekstur Detail diletakkan di atas tekstur dasar. Warna yang lebih gelap dalam
tekstur detail akan menggelapkan tekstur utama dan warna yang lebih terang akan
mencerahkannya. Tekstur detail biasanya abu-abu [14].

| #Scene €Ga
| Textured ¢| [RGB o) | ¥ | & l<Di AT

v.} © Inspector A=

‘ bricks Qs
Shader -

Main Color
Base (RGB)

. Tiling
x1
vy

Detail (RGB)
Tiling
8

v 8

Gambar 3.20 Diffuse Detail
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5. Parallax Diffuse
Seperti menampakkan kedalaman pada suatu asset. Ini yang sering digunakan di asset batu

bata untuk menampilkan celah celah [14].

= O inspector I A=

bricks Ge.
Shader | Parallax Diffuse A

Main Color [ 12
Height o Yo—
Base (RGB) a

# Scene | € Game
Textured 3| | RGE 3| b |4 | AT

Gambar 3.21 Parallax Diffuse

6. Parallax Specular
Memberikan kesan 3D pada objek 2D. Dan pada permukaan objeknya akan terlihat seperti
mengkilap [14].

o= O Inspector

bricks @
Shader | ParallaxSpecular v

Main Color —
=z

Specular Color

Gambar 3.22 Parallax Specular
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7. Specular

Sama seperti Diffuse, Pencahayaan yang hanya bergantung hanya bergantung pada sudut,

dan tidak berubah saat kamera bergerak atau berputar, yang nantinya akan ditambah sorotan
specular viewer dependent [14].

- .
v=| © Inspector

| bricks
‘ Shader [ Specular
x

Main Color
Specular Color
Shininess

Base (RGB) Gloss (A)

Tiling Offs
x 1 i)
ya

Gambar 3.23 Specular

8. Vertex-LIT

Yang merupakan salah satu shader yang paling shader. Semua cahaya yang menyala di
atasnya akan di anggap dalam satu jalur dan dihitung hanya pada simpul [14].

[Fscene

| Textured

== O Inspector

bricks
Shader [ Vertextit

B 1ain Color
| Spec Color
| Emissive Color
| Shininess
| Base (RGB)

Gambar 3.24 Vertex-LIT
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3.4.4 Lighting
Komponen Lighting adalah pencahayaan yang bisa memberikan gambaran terhadap

suasana lingkungan 3D yang sedang dibangun.

Tabel 3 Jenis dan Keterangan Lighting

Jenis Lighting Keterangan

Points Lights Lighting yang diletakan pada satu titik, dan lighting ini akan
menyebarkan sinar kesegala arah sama besar. Point Lights sangat
membantu untuk mensimulasikan sebuah lampu atau sumber

cahaya lokal.

Spot Lights Lighting yang diletakan pada posisi yang area sinar yang
dipancarkan sangat jelas. Jenis lighting ini dibatasi oleh sudut (sinar
berbentuk kerucut). Penggunaan spot lights digunakan untuk
pencahayaan yang sengaja dibuat seperti lampu senter, lampu

mobil.

Directional Lights Lighting yang tidak mempunyai posisi yang spesifik sehingga arah
sinar yang dipancarkan dapat di letakkan disembarang tempat,
Penggunaan lighting ini bisaanya untuk area yang luas seperti

matahari atau bulan.

Area Lights Lighting yang memancarkan sinar dengan area berbentuk

segiempat.

Contoh Jenis Lighting
1. Point Light
Lighting sebagai sumber cahaya lokal, terlihat menyebarkan sinar kesegala arah pada suatu

objek.
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| Shaded 2||2p ] % || &~ Gizmos | (@Al

Gambar 3.25 Point Light

2. Spotlight

Lighting yang dibatasi oleh sudut berbentuk kerucut, focus pada satu titik saja.

| Shaded ~||2p | o | <) | &I~ | Gizmos * | VgtAH

Gambar 3.26 Spotlight

3. Directional Light
Lighting sebagai sumber cahaya matahari atau bulan yang dapat diletakkan disembarang

tempat, dan cahaya akan terlihat rata dan meluas.
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Gambar 3.27 Directional Light

4. Area Light
Lighting menyinarkan cahayanya berbentuk segiempat. Pada lighting ini cahaya terlihat

padam rata meskipun nilai intensitasnya di tambahkan.

| Shaded

=[] 20| % )| &1~ Gizmos - | (GZATT b}

Gambar 3.28 Area Light

3.4.5 Camera View

Camera view adalah tampilan yang dimunculkan dari hasil yang ditangkap oleh objek
camera pada unity. Camera view terdapat 2 jenis yang sering digunakan yatu jenis first person
shooter dan third person shooter.

First person shooter adalah jenis kamera yang menunjukan sudut pandang karakter yang

berada pada environment virtualnya. Sedangkan,
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Third person shooter adalah tampilan yang bisa menunjukan karakter.

Qumyzow.sm New Unity Project (5) - PC, Mac & Linux Standalone* <DX11>
FileEditAet t Mobilelnput Window Help
Create Emy Ctrl+Shift+N & Collab ~ i & |

Create Empty Child AltsShiftsN L
3D Object

v @ Untitled* 2D Object
Main Camera
Yeiics Effects

SkyCarBody  Light
SkyCarBrak Alidio
SkyCarCom -
SkyCarHeac Video
SkyCarMudt ul
SkyCarMudt
SkyCarSusg
SkyCarSuse __ center On Children
SkyCarWh
SkyCarwh Make Darent
SkyCarWhe

S Clear Parent
Directional Ligl  “pply Changes To Prefab
Camera Break Prefab Instance 2
Set as first sibling Ctrl+=
Set s last sibling Ctrl+-
SFooicer Move To View Ctrl+Alt+F

Create - Align With View Ctrl+Shift+F
Fl
@t Align View to Selected

& Toggle Active State AltsShift+A

@M ;

Pj \ ]
s

SkyCarLigh.. SkyCarLigh.. SkyCarligh.. SkyCarWhe.. SkyCarWhe.. Trailskid

Gambar 3.29 Cara mengakses Camera View

B. PRAKTIK

Setelah pembaca mengenal unity pada praktik Bab 2. Kita sekarang praktik tentang
pembuatan assets. Pembaca dapat mengembangkan asset 3D yang sudah ada yang disediakan
assest store Unity 3D. Selain itu pembaca harus dapat menambahkan material, texture, lighting,
dan tata letak kamera pada asset 3D sebagai dasar editing assets.

Kita menyiapkan assets yang bisa di download gratis di http://bit.ly/VR_Lab sebagai bahan
pembaca untuk belajar. Untuk melakukan import assets pembaca harus menginstal software 3D
yang support Unity 3D. Pada praktik kali ini kita menggunakan 3Ds Max versi minimal 2015

sebagai Assets Builder.

PERALATAN

1. Komputer

2. Software Unity

3. Koneksi Internet

4. 3Ds Max Minimal Versi 2015
5. Asset 3D (http://bit.ly/VR_Lab)
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LANGKAH LANGKAH PERCOBAAN
Membuat Aset Menggunakan Software 3D

Terdapat beberapa metode yang bisa dilakukan untuk membuat Asset 3D. Salah satu cara
yang bisa dilakukan yaitu dengan menggunakan Asset yang sudah tersedia pada website store

Unity. Website store Unity adalah https://www.assetstore.unity3d.com/

Vom Y XY s X O R XY @ e v (s Rwm ¢ - o x|
€ C & ps//asse com E" 0@ O 80O ® HSa :
anywcsm{e 3 20 AddOns Audic Templates Tools  VFX B9 a2 ¥* 0
Props Vegetation Vehicles

cl Air
El Lan:
B Se:
Food Trees  Space
Furnitur

G

I

In

Check it out

Don't miss out! Watch the Unity at GDC Keynote livestream. Set A Reminder

Gambar 3.30 Tampilan Website Store Unity

Selain melalui website, kita bisa membuka Asset Store melalui software Unity. Kita bisa masuk

menu Windows kemudian pilih Asset Store.

& Unity 2017.3.1f1 Personal (64bit) - Untitled - New Unity Pro ac & Linux Standalone <DX11>
File Edit Assets GameObject Component| Window

:: E, ™3 :I'-\: E] :(.‘.): @ Next Ctrl+Tab
?ﬁlmhy_ Ass Previous Window Ctrl+Shift+Tab
HeEAr )
vcr@ :ntitled = i ?
Main Camera Services Ctrl+0
Directional Light Scene Ctrl+1
Game Ctrl+2
Inspector Ctrl+3 ‘
Hierarchy Ctrl+4
Project Ctrl+5
Animation Ctrl+6 l
Profiler Ctrl+7
Audio Mixer Ctrl+8
I Asset Ste Ctrl+9 I
Animator
Animator Parameter
Sprite Packer E
@1 Project | B consale %
Create ~
¥ {7Favorites | Assets Holographic Emulation
(CLAll Materials Tile Palette
o ::: :"’::::s Test Runner i
Timeline
Lighting >
Occlusion Culling
Frame Debugger
Navigation
Physics Debugger
Console Ctrl+Shift+C

Gambar 3.31 Cara menampilkan Store Unity Lewat Unity 3D
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Instalasi 3DS MAX

1. Download software 3Ds max pada link berikut : https://www.autodesk.com/education/free-
software/3ds-max

2. Pilih Create Account

{\ AUTODESK . @ = MENU

EDUCATION

3 3ps MAX

Gambar 3.32 Tampilan Website 3D Max

3. lsilah dan lengkapi form yang ada.

CREATE ACCOUNT

Gambar 3.33 Tampilan Form yang ada

4. Pilih Versi 3Ds max, OS PC anda dan Bahasa yang ingin anda gunakan

5. Pilih install now
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{\ AUTODESK A - = MENU
EDUCATION  Freesoftware  Learn&teach  Competitions &events  Prepare &excel  Support  About Autodesk Educ
3ds Max 2018 v
WINGOWS 64-it v 4
English v
900-83551

mOoOMOm®|m e B @

Gambar 3.34 Tampilan Form Instal

6. Pilih 1 Accept
7. Pilih Install

£\ AUTODESK

Autodesk
LICENSE AND SERVICES AGREEMENT
READ CAREFULLY: AUTODESK LICENSES THE SOFTWARE AND OTHER
LICENSED MATERIALS ONLY ON THE CONDITION THAT LICENSEE

ACCEPTS ALL OF THE TERMS CONTAINED OFR. REFERENCED IN THIS
AGREEMENT.

B calecting the “T arcent” hutton or other button or mechanicm decioned to E

| Reject | !®/1 Accept

Gambar 3.35 Tampilan Autodesk License And Services Agreement

8. Pilih Install dan tunggu hingga proses Instalasi selesai.
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& Autodesk 3ds Max 2018 = X T Avtodesk 34 M 2018 = x

AUTODESK' 3DS MAX' 2018 O\ AUTODESK.  AUTODESK' 3DS MAX' 2018 £\ AUTODESK.

é Install

Install on this computer

Ostermining installation requirements. -]

‘ Installation Help | System Requirements | Readme Exit
Gambar 3.36 Tampilan Ketika Menginstal Autodesk 3DS MAX

g Cudbpl

Gambar 3.37 Tampilan 3Ds Max Saat Dijalankan ‘

Import Aset ke Project
1. Buka Unity kemudian pilih Import New Assets pada tool bar Assets

Q Unity 2017.2.1f1 Personal (64bit) - Untitled - New Unity Project - PC, Mac & Linux !
File Edit GameObject Component Window  Help

m Create > beal |

Show in Explorer

= Hierarel
Create ~| | Open
¥ €5 untit Delete
Main €
Directi Open Scene Additive
I Import Mew Asset...
Import Package >
Export Package..
Find References In Scene
Select Dependencies
Refresh Ctrl+R
Reimport
Reimport All
Extract From Prefab
Run APl Updater...
Open C# Project
23 Project E]
Create ~
—— = T

Gambar 3.38 Tampilan Cara Import Asset Dengan Tool Bar Assets
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2. Pilih folder VR_Lab

€ impon New Asset
« -1 » ThisPC » Data(D) » unmity »
Organize v Mew folder
B This PC
P 30 Otgects pict
= e
B [T

$ Douniosds M

" Modemn
B M
& Pctures
B videss

e Local Disk ()
- Data D)

1

o Network

Gambar 3.39 Tampilan Folder VR_Lab

Bisa juga mengimport asset dengan drag and drop folder VR_Lab ke Project window pada
unity.

Hold On

I
WR_Labltextures\dnding.ipg

Gambar 3.40 Tampilan Cara Import Asset Dengan Drag And Drop

Create folder dengan cara :
3. KIlik kanan pada folder Assets
4. Pilih Create kemudian pilih Folder.

5. Beri nama Folder tersebut dengan nama Scene
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= Hierardl

v  untitled

Shadler
Testing.
Playables

Shouin Explorer

Open 4 Scene
Delete Prefab

Open Scene Additive Audio Mixer
Impert New Asset.. Material
Import Package 3 Lens Flare
Export Packsge.. Render Texture

Find References In Scene. Lightmap Parameters
Select Dependencies Custom Render Texture

== Assets

Refresh Chrl-R Sprite Atlas

Reimport S ’ —
Tile

Reimpart All

Animator Controller

Extract From Prefab Animation

Animator Override Controller
Avatar Mask

Run API Updater.

Open C# Project

Timeline

Physic Material
Physics Material 2D

GUI Skin
Custom Font

Legacy

Gambar 3.41 Cara Membuat Folder di Unity 3D

Create Scene dengan cara :

6. Klik kanan pada Folder Scene

7. Pilih Create kemudian pilih Scene.
8. Beri nama scene VR Lab

i Project

Assets » Scene

iz m— Y —
r
C# Script
Shader

Testing
Playables

Prefab
Audio Mixer

Open Scene Additive Material

Import New Asset... Lens Flare

Import Package Render Tedure

Export Package... Lightmap Parameters
Find References In Scene Custom Render Texture

Select Dependencies Sprite Atlas

Refresh Cul+R Sprites
Reimport Tile

Reimport All Animater Controller
Bract From Prefab Animation
Animator Override Controller

Run AP| Updater. Avatar Mask

Timeline

Physic Materil
Physics Material 2D

GUISkin

Custom Font.

Legacy >

Gambar 3.42 Cara Membuat Folder di Unity 3D
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9. Drag and drop file room.max ke Folder Scene

« © 4 s TNSPC » Nand(E) » BerkasKuish » MMB 2015 » Semester6 » Pemiograman Mulimedis » VR.Lab »

3 Documents
an

Berhan Putra Mandwi

Pomet MAX MAX

INSINAS Materisls testures nwarp_uww fenalitslein  fenalftalein.max. GUlsoal GUisoslmaxmet  Materislsmets meja mejamaxmets
meta

Pemrograman Multmedia

w0 Creative Cloud Files
3
9 This PC MAX MAX MAX MAX
2 30 Objects penands & pipet propenty_glass vlvv::?’v;‘g'l:n m room room maxmets

..
B Desitop

3 Documents

& Downlosds

D Music MAX
R Pictures titration max.met tombol tombolmaxmet  urwarp_uvw.met
B Videor a a 3

ke Local Disk (C)

testures meta titration

- Nand (€)
- Dee ()

P Network

4 Homegroup

2items 1 tem sebected 1,53 MB

Gambar 3.43 Tampilan File Room.max Di Folder VR_Lab

10. Drag And Drop file room.max ke Project Windows

C—— 0 VLY

.....

Gambar 3.44 Tampilan Drag And Drop File Room.Max Ke Scene View

67



MARI BELARMAIN VIRTUAL REALITY DENGAN UNITY 3D

Material

1. Pilih Create lalu Material

3 Personal (64bit) - VR Lab.unity - p

File Edit Assets GameObject Component W

¥ <+ EEdio]

Folder

C# Script

Shader >
Testing ¥
Playables ¥
Scene

Prefab

Audio Mixer

Material

Lens Flare
Render Texture 1
Lightmap Parameters

Custom Render Texture

Sprite Atlas
Sprites. »
Tile

Animator Controller

Animation

Timeline

Physic Material
Physics Material 20

GUI Skin
Custom Font

Animator Override Controller '
Awatar Mask

@

Legacy » -
Gambar 3.45 Cara Mencari Material

2. Hasil Material dan Inspector dari material

68

© Inspector
New Material

PR

Shader | Standard

Rendering Mode
Main Maps
. oAlbedo

 oMetalic

Source
o Normal Map
 oHeight Map
" oOocdusion
@ Detail Mask
Emission
Tiling
Offset

Secondary Maps

@ Detail Albedo x

© Normal Map

Tiling
Offset
UV Set

Forward Rendering Options
Specular Highlights (v
R o

Reflection
New Material

AssetBundle

B3 Project

| create -|

v i:? Favorites

Assets

@ﬁll Materials
O All Models
@gAII Prefabs
@AII Scripts

» &5 Scene
> & VR_Lab

Scene

WR_Lab

Mew Materi

Gambar 3.46 Hasil Material Dan Inspector Dari Material
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3. Pergi ke folder VR_Lab

| Creste *| =
¥ 7 Favorites Assets » VR_Lab
L All Materials
L All Models
(Al Prefabs

(@ Al Scripts
¥ 5 Assets

aterials extures unwarp_uvw so0a a ipe
- ..-‘ .

) [ &% %

property_gl..
P G Scene

property_ql..

titration

tambal

Gambar 3.47 Hasil Material Dan Inspector Dari Material

4. Drag asset meja ke Scene View

[ AddComponent |

Gambar 3.48 Tampilan Scene View

5. Klik 2 kali pada kaki meja

6. Pilih salah satu material yang ada pada folder VR_Lab kemudian drag and drop pada kaki
meja

++ ENEIIn)

Mnactir_ o
Shader | Standord

Add Component

| crase - & E—NY VLY
L7 Assets + VR_Lab » Materials
Al Materials .
AN Models
(Al pretabs
Al seripts
¥ G Assets 04 - Default 13 - Defavk alr_hel blue bask_nons.  Butten Mulal oelas glass lantat Bs_jendels.
> i Scene.
'Ii =

i e[ [e[e| [ele[¢|

Gambar 3.49 Drag And Drop Kaki Meja
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7. Ganti warna material dengan cara klik gambar palet warna kemudian pilih warna yang

diinginkan

| &callab - [ & [ Account - [ Lavers - [ Layout - |
°

Assets + V_Lab - Materials

13-Dafask air_hel

a._ — 2557 | ericia
g g D"_ D @) Click to add new proset

~ oDetail Albedo x

Gambar 3.50 Pallet Warna Pada Unity 3D

Texture
1. KIlik dua kali pada bangku yang ada dipinggir tembok
2. Pilih Legacy Shaders kemudian p|||h Bumped diffuse

sx~ T Collab + J O W Account_+ | Layers - i Layout -~
= Hierarchy cene © nspector
Croate - | =lianll 3 L) & - | Giamen - = m—w
v VR Lab = we
Main Camera Tag [Untagged | Layer | Dafaulc
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n ) &
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Rectangle02 R et m
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s Scale x s
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Box007 =
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o /[\w e E—
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Boxo1L P AL
Box014 Bumped Diffuse. (Roughness setup)
P #)

Box015. ‘Bumped Spe s

& Project Dec ::

L T — e,
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Al Prefabs i Uightmapped > Nutwrs
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o4~ 12 ikl Skybox

¥ Assets Parallax Specular

>imn Reflective > Spetis
S u
ﬁnn-u o ‘ T phee 5 R

Vertertit Legacy Shaders B

Gambar 3.51 Langkah Memilih Bumped Diffuse
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3. Pilih kedua texture dibawah ini

1) - VR Lab.unity - progmm - PC, Mac & Linux Standalone <DX11> a

t Component Window Help
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)
Multiple | Trstance ]
V.~ Transform *
Position x= Iy J2[ ]
Rotation
Scale x X z

¥ Box 014 (Mesh Filter) o
= o

Conereterlaor.. | dinding

issets » VR_Lab » Materials

Dll

dinding dinding dinding_NRM floor-tiles-tex.

i - - e - m
ConcreteFloors0046_4_S_normal
Texture 2D
1024x1024 DXTnm
wall white_b. 1.3 MB

Assets/VR_Li

Gambar 3.53 Texture 2

Lighting
1. Pada Hierarchy pilih Directional Light

2. Letakkan Directional Light pada atas ruangan
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3. Pengaturan pada lighting dapat diubah di Inspector

[~ ] Static *
Main Camera — Tag [(Untagged 3] Layer (Defauic 2
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Gambar 3. 54 Directional Light Pada Unity 3D

4. Pada Inspector ubah Type menjadi Point
5. Pengaturan pada lighting dapat diubah di Inspector

#Scene
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Gambar 3.55 Point Light Pada Unity 3D

6. Pada Inspector ubah Type menjadi Area
7. Pengaturan pada lighting dapat diubah di Inspector
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Unity 2017.2.0f3 Personal (64bit) - VR Lab.unity - progmm

File Edit Assets GameObject Component Window Help
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and has been discarded,

Gambar 3.56 Area Light Pada Unity 3D

£\ A palygon of Line0os is

8. Pada Inspector ubah Type menjadi Spot
9. Pengaturan pada lighting dapat diubah di Inspector
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£\ A polygon of Line00s is self-intersecting and has been discarded.

Gambar 3.57 Spot Light Pada Unity 3D

Camera View
1. Pada Hierarchy pilih Main Camera
2. Hasil gambar dari Main Camera ditampilkan pada Camera Preview
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Gambar 3.58 Camera View

C. KESIMPULAN

Dalam pengembangan assets 3D yang sudah ada terdapat 4 hal terpenting yaitu Material,
Texture, Lighting dan Camera View. Selain itu pembaca bisa mendownload asset di asset syore
unity 3D.
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D. SOAL

1. Sekumpulan bagian-bagian file yang berada dalam satu project yang berisi seskumpulan object
diantaranya object 2D, object 3D gambar, suara, script dll disebut ...
a. Material b. Asset c. Texturing d. Lighting

2. Bagian warna dan bentuk terluar dari objek 3D disebut ...
a. Material b. Asset c. Texturing d. Lighting

3. Pencahayaan yang bias memberikan gambaran terhadap suasana lingkungan 3D yang sedang
dibangun disebut ...
a. Material b. Asset c. Texturing d. Lighting

4. Software 3D yang support untuk unity adalah ...
a. Autodesk Maya, Cheetah 3D, dan Autodesk 3DS MAX
b. Cinema 4D, Wings 3D, dan Autodesk 3DS MAX
c. Adobe Premier, Wings 3D, dan Autodesk 3DS MAX
d. Avidemux, Cheetah 3D, dan Autodesk 3DS MAX

5. Pada komponen dasar object yang merupakan sebuah permukaan yang dibentuk oleh minimal
3 edge (tris) yang tertutup disebut ...
a. Vertex b. Edge c. Normal d. Face

6. Lighting yang diletakkan pada posisi yang area sinar yang dipancarkan sangat jelas disebut ...
a. Points Lights b. Spot Light c. Directional Light d. Areaw Light

7. Penggunaan lighting yang biyasanya untuk area luas seperti Matahari dan Bulan disebut...
a. Points Lights b. Spot Light c. Directional Light d. Area Light

8. Pada Camera View jenis kamera yang menunjukkan sudut kamera karakter yang berada pada
environment virtualnya disebut ...
a. First Person Shooter c. Third Person Shooter
b. Second Person Shooter d. Fourth Person Shooter

9. Cara mengganti texture assets adalah ...
a. Kilik dua kali object > Legency Shaders > Pilih macam Legency Shaders
b. KIlik dua kali object > Ul > Pilih macam Ul > Pilih macam Ul
c. Kilik dua kali object > Particle > Pilih macam Particle
d. KIlik dua kali object > Nature > Pilih macam Nature

10. Pengaturan Lighting dapat dilakukan di ...

a. Services b. Hierarchy c. Inspector d. Console
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Halaman Ini Sengaja Dikosongkan
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BAB 4
PHYSICS ENGINE

TUJUAN

1. Pembaca dapat mengenal tentang Physics Engine

2. Pembaca paham tentang Rigidbody dan Collider

A. DASAR TEORI
4.1.  Pengenalan Physics Engine

Phys X

oy NVIDIA

Gambar 4.1 Logo Physic

Physics Engine pada dasarnya adalah kalkulator besar matematika yang diperlukan untuk
mensimulasikan fisika [15]. Physics Engine adalah perangkat lunak ( software ) komputer yang
menyediakan simulasi sistem fisik tertentu, seperti dinamika benda yang kaku ( termasuk deteksi
tabrakan antara benda lain ), dinamika softbody, dan dinamika fluida yang digunakan pada
computer grafis serta digunakan dalam pembuatan video game dan animasi.

PhysX adalah solusi dalam pembuatan multi-platform permainan yang membutuhkan
perhitungan fisika yang dapat digunakan dalam berbagai perangkat. Physics Engine dalam Unity
berasal dari PhysX dari NVIDIA.PhysX pun dapat dikenal dengan nama Novodex, sebuah Spin-
off ETH Zurich. Pada tahun 2004, Novodex diakusisi oleh Ageia dan pada tahun 2008, Ageia

diakusisi oleh Nvidia.
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Gambar 4.2 llustrasi Object Berinteraksi Dengan Object Lain

Pada Game Engine terdapat fitur yang memungkin object atau game object berinteraksi
antara yang satu dengan yang lain, salah satunya yaitu Physic. Dengan Physic memungkin objek
atau game object terjadi simulasi sistem fisika tertentu seperti bertubrukan, fluida, rigidbody,
cloth[15].

Dengan mencatumkan physic pula, objek bisa menjadi lebih dinamis dengan mengatur
beberapa pengaturan yang tersedia dan mengkontrolnya melalui script, sehingga bisa seperti
mesin.Component physic yang disediakan oleh unity diantaranya adalah Rigidbody dan Collider.

Gambar 4.3 llustrasi Perbedaan Physic Engine

Pada Gambar 1 merupakan keadaan disaat objek tidak diberi komponen apapun, objek
tidak memiliki hukum fisika. Objek terlihat melayang diudara yang menandakan tidak adanya
hukum fisika yang ditambahkan pada objek.
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Pada Gambar 2 merupakan objek yang diberikan Rigidbody dengan “Use Gravity”
diaktifkan. Maka tidak terlihat adanya objek, yang menandakan objek sudah memiliki gaya
gravitasi, namun tidak dapat bersentuhan dengan objek lainnya.

Pada Gambar 3 merupakan objek yang telah diberikan Rigidbody dan Collider .Sehingga
objek sudah memiliki gaya gravitasi serta sudah memiliki efek bersentuhan dengan objek
lainnya. Namun terdapat kekurangan karena benda yang jatuh pada permukaan yang tidak rata
tidak dapat berdiri tegak.

Pada Gambar 4 objek sudah memiliki seluruh efek fisik yang sudah ditambahkan dan

sekarang terlihat lebih nyata dibandingkan dengan gambar-gambar sebelumnya.

Gambar 4.4 Perbedaan Ada Gaya Grafitasi dan Tidak Ada

Rigidbody berfungsi untuk mengaktifkan GameObjects yntuk bertindak di bawah kendali
physic. Rigidbody dapat menerima kekuatan dan torsi untuk membuat objek Anda bergerak
dengan cara yang realistis. Setiap GameObject harus berisi Rigidbody yang dipengaruhi oleh
gravitasi, bertindak melalui scripting, atau berinteraksi dengan objek lain melalui mesin fisika
PhysX NVIDIA [16].
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4.2  Collider
Collider pada unity merupakan komponen dari physic yang dibutuhkan oleh game object
atau suatu object, untuk memberikan fungsi tertentu ketika objek tersebut menerima action baik

dari user maupun dari objek lainnya. Action yang diterima bisaa disebut collision.

iMprion
ExeecisEs

(evers 4

No

Gambar 4.5 Contog Object Apabila Diberi Rigidbody

Collider bisa dipasangkan dengan Rigidbody agar menghasilkan gerakan yang lebih
dinamis, seperti ketika jatuh lalu terjadi tabrakan. Terdapat banyak jenis collider yang disediakan
oleh unity, namun yang sering digunakan terdapat 4 jenis menurut bentuknya, yaitu:

a. Box collider

b. Sphere collider
c. Capsule collider
d. Mesh collider

421 Box Collider

Box Collider merupakan sebuah proyeksi tabrakan sederhana yang berbentuk kubus.

——

‘l"ﬁ- [« Box Collider £,
Edit Collider
Is Trigger L]
Material Mone (Physic Materi: ©
Center
X0 Y -1.421085 2 0.0058500
Size
X 1.174 Y 0.7240002 2 0.0117

Gambar 4.6 Bagian Box Collider
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Bagian dalam Box Collider yaitu :

a. IsTrigger : Apabila diaktifkan akan memicu sebuah kejadian dan akan mengabaikan oleh
physics engine, maka tidak akan.

b. Material : Memilih objek fisik yang akan menentukan bagaimana collider berinteraksi
dengan objek lain.

c. Center : Mengubabh posisi collider di ruang projek.

d. Size : Mengatur ukuran collider sesuai dengan sumbu [16].

4.2.2 Sphere Collider

Gambar 4.7 Sphere Collider

Sphere Collider merupakan sebuah proyeksi tabrakan sederhana yang berbentuk bola.

T“i!phere Collider £,
Edit Collider
Is Trigger L
Material ‘None (Physic Mati @
Center
X0 Yo zo |
Radius 0.5 |

Gambar 4.8 Bagian Sphere Collider

Bagian dalam Sphere Collider yaitu :
a. IsTrigger : Apabila diaktifkan akan memicu sebuah kejadian dan akan mengabaikan oleh

physics engine, maka tidak akan.
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b. Material : Memilih objek fisik yang akan menentukan bagaimana collider berinteraksi
dengan objek lain.

c. Center : Mengubabh posisi collider di ruang projek.

d. Size : Mengatur ukuran collider sesuai dengan sumbu.

4.2.3 Capsule Coliider.

Gambar 4. 9 Capsule Collider

Capsule Collider merupakan gabungan dua setengah bola berbentuk silinder. Bentuk

capsul collider sama dengan primitive capsule.

v i ¥ capsule Collider ] %,
Edit Collider
Is Trigger L]
Material 'None (Physic Maty
Center
X0 Yo ‘20 |
Radius 0.5 |
Height 1 |
Direction | ¥-Axis : |

Add Component l

Gambar 4.10 Bagian Capsule Collider
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Bagian dalam Capsule Collider yaitu :

a.

h DO o O

Is Trigger : Apabila diaktifkan akan memicu sebuah kejadian dan akan mengabaikan oleh
physics engine, maka tidak akan.

Material : Memilih objek fisik yang akan menentukan bagaimana collider berinteraksi
dengan objek lain.

Center : Mengubah posisi collider di ruang projek.

Size : Mengatur ukuran collider sesuai dengan sumbu.

Height  : Ketinggian total pada collider

Direction : Arah memanjang pada sumbu capsule di ruang project

4.2.4 Mesh Collider

Gambar 4.11 Mesh Collider

Mesh Collider mengambil bentuk dari objek dan membanggun collidernya berdasarkan

objeknya. Ini jauh lebih akurat untuk mendeteksi tabrakan daripada menggunakan primitive

collider untuk benda yang berbentuk rumit. Mesh collider secara otomatis dapat bertabak dengan

mesh collider lainnya.

¥ |-/ ¥ Mesh Collider &,
Is Trigger L]
Material |NﬁnE{F"hyrsic Material) | ]
Convex -
Mesh 'None (Mesh) ]

Gambar 4.12 Bagian Mesh Collider
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Bagian dalam Mesh Collider yaitu :

a. IsTrigger : Apabila diaktifkan akan memicu sebuah kejadian dan akan mengabaikan oleh
physics engine, maka tidak akan.

b. Material : Memilih objek fisik yang akan menentukan bagaimana collider berinteraksi
dengan objek lain.

c. Mesh : Referensi Mesh yang digunakan untuk bertabrakan.

B. PRAKTIK

Setelah pembaca faham tentang asset pada Unity 3D yang dibahas pada Bab sebelumnya.
Kali ini kita membahas tentang Physic Engine. Diharapkan pembaca dapat mengenal tentang
Physics Engine dan paham tentang Rigidbody dan Collider melalui langkah langkah yang kita
buat. Assets yang kita gunakan untuk penerapan Physic Engine bisa di download di bit.ly/vr_lab.

PERALATAN

1. Laptop

2. Software Unity

3. Koneksi Internet

4. Asset 3D (bit.ly/vr_lab)

DAFTAR PERALATAN — ASSET

(Dalam Folder Assets)

1. Erlenmeyer merupakan asset bentuk gelas kaca.

2. Pippete merupakan asset yang berbentuk pipa kecil dari kaca

3. Fenol merupakan asset yang berbentuk botol kecil.
LANGKAH LANGKAH PERCOBAAN

Download Asset
1. Download Asset 3D di bit.ly/vr_lab dan download file bernama “Bab 4.
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Shared withme > PHYSICS ENGINE ~ =%

Folders

‘ B BaBs

Gambar 4.13 Asset di Web

2. Buka project yang bernama “Bab4”, maka akan muncul environtment 3D yang layout.

| [ 1 = | Assets

Weme | Shere  view
d & cut &+ ® x @ T Mew item ~ @ Qopen~ [ select

wal Copy path +7] Easy access ~ [t Edit Select

Ci Paste M, Ci Delete R N Pr rti
omr [7] Paste shortcut tsv.e tzpvy € e Reneme ,ofd":, ropsres @History 20 invert
Clipboard Organize Hew Open Sel
« . 4 > ThisPC » NewVolume (F:) > Kulish > PEMOGRAMAN MULTIMEDIA > BAB4 > Assets
pacet ~  Name Date modified Type Size
perc2 Scene 3 File folder
teknologi web &) air.FBX 3D Object 26KB
VETA 3 |
& Onebiive 5ir FBX.mets METAFile K8
BAB4.uni Unity scene file 296 KB
< ty y
[ This PC Nty meta paryas ™
¥ 30 Objects [ Beaker.0B) Object File 465 KB
I Deskiop Beaker.OB).meta META File 2K8
- ~ o . } .
€] Documents [ Boiling Flask.obj Object File 213K8
Boiling Flask.obj.meta META File
< Downloads — i
[&) burret_titrasiFBX 3D Object
D Music . e
burret_titrasi.FEX.meta META File
=] Pictures [7] Condensing Flask.obj Object File 281 KB
ideos ondensing Flask.obj.meta META File 3K
8 vid Cend Flask.cb META Fil 2K8
‘i Local Disk (C3) | Cendensor Stand.obj Object File 48KB
— Local Disk (D3 Cendensor Stand.obj.meta META File 2K8
— New Volume (F) | ] Conical Flask.obj Object File 128 KB
v Conical Flask.obj.meta META File 3K8
P N

Gambar 4.14 Hasil Download

Menambahkan rigidbody

1. KIlik Erlenmeyer.

2. Kemudian pada bagian inspector klik add component.
3. Kilik Physics.
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€ Unity 2017.4.0f1 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone™ <DX11>
File Edit Assets ject Component Window Help

PN & [ S o | o1 [ capivet | ®tocel]

3 Scene.

Gambar 4.15 Cara Menambahkan Physic Pada Unity 3D

4. Klik Rigidbody

@ Unity 2017.4.01 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone™ <DX11>
File Edit Assets GameObject Component Window Help

Add Component

Gambar 4.16 Cara Menambahkan Rigibody

Menambahkan Rigidbody (Use Gravity)
1. Pippete, Lalu ikuti langkah sebelumnya.
2. Selanjutnya “Use Gravity” hingga tampil symbol J
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Q Unity 2017.4.0f1 Personal (64bit) - BABA.unity - BAB 4 - PC, Mac & Linux Standalone* <DX11>
File Edit Assets GameObject Component Window Help

Gambar 4.17 Cara Menambahkan Rigibody Use Gravity

3. Kilik “Is Kinematic” hingga tampil symbol J untuk menonaktifkan seluruh fungsi
Rigidbody pada pippete.

Q) Unity 2017.4.0f1 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone* <DX11>
File Edit Assets GameObject Component Window Help

—_—C—

Gambar 4.18 Cara Menonaktifkan Seluruh Fungsi Rigibody

Menambahkan BOX Collider

1. KIlik bagian kaca pada meja.

2. Kemudian pada bagian inspector klik add component.
3. Klik Physics.
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Q) Unity 2 bit) - BABA.unity - BAB 4 - PC, Mac & Linux Standalone™ <DX11> = (=] X
File Edit Assets GameObject Component Window Help
O S w [l ®) Pivot | @ Local > 11 @ Collab ~ | [ & | [ Account ~ Layers - | [Layout -
= Hierarchy # Scene © Inspector
|create~| GAT ||| shaded -2 % <) |- Gizmos +| (G4 by @ Fadargeor U static ~
e Tag (Untagged _¢] Layer
Cylnderonz odel _
Cylinderoo3 ¥~ Transform
Loftoo1 i x@v-z-
Lofto02 Rotation X010 |z[o |
e sede T YT J2E ]
Loftoos ¥ Rectangle 02 (Mesh Filt (@ %/
Loftoos Mesh °
Lofto07 v . ¥Mesh Rend @
,anns = & - TN l‘ﬁhﬁﬂl.i :nderer
’mg; & = 5 ) Materials
Lofto11 1 - 4 size z__ 1]
Lofto12 =g R e r—
W A (Y |
m A A Component 5
» tembok. Mesh -
¥ meja Effects >
Box02
Rectangle0l Physics 2D - 4°
& Project B Nayigation 3 . 3
| Create - @ |a|S[*]| Audio >
vy . Assets » | | video >
©\all materials Rendering >
©LAll Models ~¥ X T N
©L Al prefabs > [y > Layout - e
" ” - Playables. o [
cen o Scene Beaker g Flask  burret_titra..  Condensing..  Condensor..  Conical Fla.. curvedSurf.. M," 2 e
b, = Wiscellaneous. -
—_— 'Add Component
Gambar 4.19 Langkah Memberi Physic Engine Pada Meja Kaca
4. Kilik Box Collider pada bagian Inspector.
€ Unity 2017.4.0F1 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & - (=] X

File Edit Assets GameObject Component Window Help

mﬁ‘ﬂm & Collab - | & | [ Account - |- Layers - [{Layout -

= Hierarchy atsoene © Inspector
|cum | @A | Shaded T Gizmos ~| (o _ m  [Rectangieoz Dstaucv' 3

Box015 E Tag — Layer

Cylinderool
Cylindero02
Cylindero03
Loftoo1.
Loft002
Loft003

¥ .~ Transform
Loftooa 2 : ¢
Loft005. vu uamngluu esh Filt: Ill.
Loftons
Loft007 LR~ = = B
Loftoos ; i e -
Lofto0s 3
Lofto10 == /
Loft011 i X
Loft012
Lofto13

Lofto14 S — N =
Loft015 Z e : N Physics
» tembok- e R jidbody

¥ meja

Box02
Rectangle0l
o m‘ 2 | @ sphere Collider

3 Project O

i T e

v /Fa Assets -

©L All Materials

Ol
All Prefabl
~ - ’qu- Joint
Assets 'Fin

BARB4 Boiling Flask huvlﬁ._ﬂ:

aracter Controller

L o

Add Component

Gambar 4.20 Langkah Memberikan Box Collider

Menambahkan Capsule Collider

1. KiIik bagian pippete.

2. Kemudian pada bagian inspector klik add component.
3. KIlik Physics.
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Q Unity 2017.4.0F1 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone™ <DX11>
File Edit Assets GameObject Component Window Help

(O EBY S [ =B ES] [sipivot | @Local |
‘= Hierarch:

3 Scene

| © Inspector |

Gambar 4.21 Langkah Memberi Physic Engine Pada Pipate

4. Kilik Capsule Collider pada bagian Inspector

€ Unity 2017.4.0f1 Personal (64bit) - BABA.unity - BAB 4 - PC, Mac & Linux Standalone” <DX11>
File Edit Assets GameObject Component Window Help

Gambar 4.22 Langkah Memberi Physic Capsulle Collider

5. Aturlah Capsule Collider, dengan mengganti direction kedalam “Z-Axis”.

6. Kemudian aturlah Center, Radius dan Height agar Capsule membentuk sama dengan pippete.

89



MARI BELARMAIN VIRTUAL REALITY DENGAN UNITY 3D

& Unity 2017.4.0f1 Personal (§4bit) - BABA.unity - BAB 4 - PC, Mac & Linux Standalone® <DX11>
File Edit Assets GameObject Component Window Help

®1 Pivot & Collab ~

‘= Hierarchy O Insp
Create | (G7ATl D  Mater
Siz
¥ burret_titrasi Elei
¥ reom Elel

ector
ials

e
ment 0
ment 1

[Ored buret | @

alko Dynamic Occluded

Box001

Box002

Box003 b ¥4 Rigidbody

Box004 Mass

Box005 Drag

Box00§ Angular Drag

larelaf7 Use Gravity

Giaen) Is Kinematic *4

b nterpolat
Box010 nterpolate jone &
e — Collision Detectior Discrete ______#]
Box014 » Constraints

Box01s ¥ | ¥ capsule Collider |
Cylinder0o1

Cylinderooz Edit Collider
Cylinder0o3 Is Trigger

Loftoo1 Material

Loftooz

Lofto03

Lofto0d.

i@ Project
| creste -]

Radius
Height
Direction

¥ 1 /Favorites

() All Materials
() all Models
(@) All Prefabs

3 i I

Condensing.  Condensor..  Conical Fla..  curvedSurf.

.@

Beaker Boiling Flask  burret_titra

glass

red_burret

Shader | Standard

Shader | Standard

Add Component

Gambar 4.23 Langkah Mengatur Ukuran Capsulle Collider

Menambahkan 2 Collider Dalam Satu Objek

1.
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Klik bagian erlenmayer.
Kemudian pada bagian inspector klik add component.
Klik Physics.

(O RN S [ Bl &3] [e1pivot | @Local |

jerarchy

| cre

ate 7| GoAT L L | ™ [Erenmeyer | [ static ~

S ¥ T
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Y. " Beaker Add Component
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Gambar 4.24 Langkah Memberi Physic Engine Pada Erlenmayer
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4. Klik Box Collider pada bagian Inspector

(O BN S [ [E B [oarivet [ Siocal] @ coleb <

= Hierarchy 3 | © Inspector ervices

e "I ez e | N | Ca—
Cyli ro01 8
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Gambar 4.25 Langkah Memberi Physic Box Collider

5. KIlik Edit Collider.

6. Aturlah Box Capsule, dengan mengganti Center dan Size, dengan meletakkan box pada
badan dari Erlenmayer

&) Unity 2017.4.0f1 Personal (64bit) - BABA.unity - BAB 4 - PC, Mac & Linux Standalone™ <DX11> - X
File Edit Assets GemeObject Component Window Help

& Collab ~ | [ & | [ Account -
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o
Lofto0s Seale  x[s ¥ |
Loftoos I Line 004 (Mesh Filter) o
Lofton? Mesh WiLine004 Q
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Loftons » Lighting
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Lofto12 Em
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(©1 All Models e = E
©All prefabs - l - - - D l ]
Scene air BAB4 Beaker  BoilngFlask  burrettitra. Condensing.. Condensor. GonicalFla. curvedsur.

Gambar 4.26 Langkah Mengatur Box Coliider

7. lkuti langkah sebelumnya dan pilih Capsule Collider.
8. Edit Collider untuk dapat mengatur capsule yang telah dibuat.

91



MARI BELARMAIN VIRTUAL REALITY DENGAN UNITY 3D

9. Aturlah Capsule Collider, dengan mengganti direction kedalam “Y-Axis”.

10. Kemudian aturlah Center, Radius dan Height agar Capsule membentuk kapsul dan diletakkan

pada leher erlenmayer.

<@ Unity 2017.4.0F1 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone* <DX11> - s
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Gambar 4.27 Langkah Mengatur Capsule Collider

1. Tariklah asset Fenol pada bagian “Asset” lalu letakkan pada Scene.

2. Aturlah posisi dan ukuran asset pada bagian Inspector.

< Unity 2017.4.0f1 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone® <DX11> - X
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Gambar 4.28 Langkah Import dan Mengatur Asset Fenol
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Menambahkan MESH Collider

1. Kilik fenol

2. Kemudian

pada Scene.

pada bagian inspector klik add component.

3. KIlik Physics

€ Unity 2

File Edit

Per

sonal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone® <DX11> -

GameDbject Component Window  Help

fenol
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Gambar 4.29 Langkah Menambah Physic Pada Asset Fenol

Collider pada bagian Inspector
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Gambar 4.30 Langkah Menambah Mesh Collider Pada Asset Fenol
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5. Kilik Convex pada bagian Inspector hingga muncul symbol /
6. Klik Is Trigger pada bagian Inspector hingga muncul simbol J sehingga menonaktifkan

benturan pada asset.

Q) Unity 2017.4.0f1 Personal (64bit) - BABA.unity - BAB 4 - PC, Mac & Linux Standalone <DX11>
File Edit Assets GameObject Component Window Help

N —TcE
7o U] o

Model

B V
-/ Cylinder 001 (Mesh Filter) l#.
Mesl

@ Cylinder0ol

jicro:
» Volumetric F\ sk
» Retort Stand 1

— EYLYES No Name
v{}F avorite
» Shader [ Standard

0
@Aum u \ _
o .... E. A .. n l e ]
...... mej micrasco
v. Ib
¥ G fbx
S Mater —o—

Gambar 4.31 Langkah Mengaktifkan Dan Menonaktifkan Benturan

C. KESIMPULAN
Dalam pelaksanaan praktikum ini terdapat 4 hal penting yaitu Rigidbody, Capsule Collider, Box
Collider, dan Mesh Collider..
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Soal

Komponen utama dalam suatu physic pada Unity yang akan mendeteksi gravitasi disebut...

a. Mesh Collider b. Sphere Collider c. Box Collider d. Rigidbody
Komponen dari physic yang merupakan proyeksi tabrakan sederhana yang berbentuk bola
disebut ...

a. Mesh Collider b. Sphere Collider c¢. Box Collider d. Rigibody
Komponen dari physic yang merupakan sebuah proyeksi tabrakan sederhana yang berbentuk
kubus disebut ...

a. Capsule Collider b. Sphere Collider c. Box Collider d. Rigibody
Komponen dari physic yang merupakan gabungan dua setengah bola berbentuk silinder
disebut ...

a. Capsule Collider b. Sphere Collider c¢. Box Collider d. Rigibody

Pada bagian Box Collider yang digunakan untuk mengubah posisi collider di ruang projek
adalah ...

a. Center b. Size c. Position d. Direction

Pada bagian Sphere Collider yang digunakan untuk mengubah arah memanjang pada sumbu
capsule di ruang project adalah ...

a. Center b. Size c. Position d. Direction

Pada bagian Mesh Collider yang digunakan untuk memilih objek fisik yang akan
menentukan bagaimana collider berinteraksi dengan objek lain adalah ...

a. Center b. Material c. Position d. Direction

Cara menambahkan Rigibody adalah ...

a. Kilik pada asset > Add Componen > Physics > Rigibody

b. Kilik pada asset > Windows > Effects > Rigibody

c. KIlik pada asset > GameObject > Physics > Rigibody

d. KIlik pada asset > Assets > Effects > Rigibody

Cara menambahkan Box Collider adalah ...

a. Klik pada asset > Asstes > Effects > Box Collider

b. KIlik pada asset > Windows > Effects > Box Collider

c. KIlik pada asset > Assets > Physics > Box Collider

d. KIlik pada asset > Add Componen > Physics > Box Collider

Cara menambahkan Mesh Collider adalah ...

a. Klik pada asset > Windows > Effects > Mesh Collider

b. KIlik pada asset > Assets > Physics > Mesh Collider

c. Klik pada asset > Add Componen > Physics > Mesh Collider

d. Klik pada asset > Assets > Effects > Mesh Collider
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Halaman Ini Sengaja Dikosongkan
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BAB 5
UNITY SCRIPTING

TUJUAN

1. Pembaca dapat mengetahui bahasa pemrograman yang digunakan untuk melakukan
scripting pada Unity 3D

2. Pembaca dapat mengetahui fungsi dan variabel scripting pada Unity 3D

3. Pembaca dapat melakukan scripting pada Unity 3D

A. DASAR TEORI
5.1 Pengertian Scripting

Bahasa scripting (biasa disebut bahasa pemrograman scripting atau bahasa script) adalah
bahasa pemrograman komputer yang diterjemahkan secara khas dan dapat diketik langsung dari
keyboard.

Dengan begitu, script sering dibedakan dari program, karena program akan dikonversi
secara permanen ke dalam file executable basis biner (yaitu, nol dan satu) sebelum mereka
dijalankan. Script tetap dalam bentuk aslinya dan menterjemahkan intruksi demi intruksi oleh

setiap kali dijalankan. Script diciptakan untuk mempersingkat proses kompilasi hingga dijalankan.

5.2  Sejarah Scripting

Pada awal era komputer mainframe tahun 1950-an, komputer-komputer pada masa tersebut
tidak bersifat interaktif, semua proses dilakukan secara batch (serangkaian instruksi diekseskusi
dalam satu proses). IBM Job Control Language (JCL) merupakan salah satu bahasa skrip tertua

yang diketahui digunakan untuk mengontrol proses batch.
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File Edit Edit _Settings Menu Utilities Compilers Test Help

EDIT KV01498,.TRG. JCL (IFTHEN) 01.02 ( [ 00001 00072

SR

Sumber Kode 1 Scripting Di Era 1960-an

Antar muka interaktif berbasis text pertama dikembangkan sejak tahun 1960-an yang
memungkinkan pengguna secara langsung berinteraksi dengan komputer-komputer tersebut,
setiap perintah yang diketikkan oleh pengguna akan langsung dieksekusi oleh sistem, pengguna
juga dapat memanfaatkan fasilitas interaktif tersebut untuk menulis instruksi-instruksi dalam satu
berkas yang dapat dieksekusi oleh sistem sebagai proses batch.

5.3  Scripting Pada Unity 3D

Pada Unity3D menyediakan 3 bahasa pemograman untuk menambahkan lebih banyak
interaksi [17]. Bahasa pemograman yang digunakan yaitu :
5.3.1 Javascript

Javascript adalah bahasa pemrograman tingkat tinggi dan dinamis. Javascript merupakan
bahasa yang populer di internet dan biasa digunakan pada website atau digunakan untuk membuat
aplikasi yang interaktif.

.
& JavaScriptClassjs - UniScTE = | B |G|
File Edit Search VWiew Options Language Buffers Help
D& G| & & | | QL ab| N2

1 JavaScriptClassjs

import Com.DankoKozar.Unity.Gui.Core.Behaviours; // import (using, include 1)
— class JavaScriptClass extends CSharpClass { // JTavacript class extends C# class (which extends MonoBehaviour)

—  function Update () { // classic Update
¥

- function onGUI() { // classic OnGUT
GUIL.depth = 0;
- if(GUI.Button(Rect(10, 10, 100, 100), "Click me")) {
Debug.Log({Say("Hello world!"));
¥
¥

- function Say(word:String):String { // OVERRIDES protected C# function
return "JavaScript says: " + super.Say{word); // calls superclass
¥

. . b

Line18 /18, Col 2. INS (LF)

Sumber Kode 2 Contoh Java Script
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5.3.2 Boo

Boo adalah bahasa pemrograman yang berorientasi pada objek, diketik secara statis dan
sintaksis yang terinspirasi dari Python. Boo memiliki beberapa fitur diantaranya generators,
multimethods, macros, true closure dan lain sebagainya.

S0 s

B I L W

.Translate (0, 0, topSpeed * deltaTime)

Sumber Kode 3 Contoh Boo Script

533 C#
C#(C Sharp) adalah bahasa pemrograman modern yang bersifat general-purpose,

berorientasi objek. Bahasa C# memiliki kemiripan terhadap bahasa java, C, dan C++.

@ T LJ Ueoug » @ Uity EOROS @ SOIUTON 10800a.

Solution {fegill 5 First.cs o \aniin
N ¥ vty First » £ Start
¥ [ Assembly-CShamp ing System.Collections;
» 8] References sing System.Coll

S

Second.cs ass First : MonoBehaviour {

Sumber Kode 4 Contoh C# Script

5.4  Memulai Scripting Pada Unity

Pada percobaan kali ini, bahasa pemrograman yang digunakan adalah bahasa C#, karena
C# script berbasis OOP (Object Oriented Programming). Selain itu alasan kenapa memilih C#
script adalah:
1. Banyak dokumentasi mengenai C# script di internet
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2. Flexibility C# script dengan unity script lainnya
3. Aturan coding yang spesifik

Unity Boo
Script [ o.0a

C#

Diagram 1 Diagram Perbandingan Pengguna Script

5.4.1 Fungsi
Sebelum mulai membuat script, ada beberapa fungsi yang harus diperhatikan yaitu:
1. “MonoBehaviour”

“MonoBehaviour” adalah kelas dasar dimana setiap skrip Unity diturunkan.
2. “Start()”

“Start()” adalah fungsi yang akan dipanggil pada frame ketika skrip diaktifkan sebelum
salah satu metode pembaruan disebut pertama kali. Fungsi “Start()” berjalan satu kali saat
permainan dimulai.

using UnityEngine;
using System.Collections;

public class ExampleClass : MonoBehaviour {

private GameObject target;
void Start() {
target = GameObject.FindWithTag("Player™);

}

Sumber Kode 5 Contoh Fungsi Start
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3. “Update()”
“Update()” adalah tempat untuk menempatkan kode yang akan menangani update frame
untuk GameObject. Fungsi “Update()” merupakan fungsi yang paling sering digunakan untuk

mengimplementasikan segala jenis perilaku permainan.

using UnityEngine;
using System.Collections;

public class ExampleClass : MonoBehaviour {
void Update() {
transform.Translate(@, @, Time.deltaTime * 1);
].
.
J

Sumber Kode 6 Contoh Fungsi Update

5.4.2 Variabel
Variable merupakan suatu tempat dimana kita menyimpan nilai-nilai yang ada pada

program tersebut. Tiap variable memiliki sifat tertentu tergantung bagaimana membuat variable

tersebut. Namun secara umum variable mempunyai 3 jenis sifat/tipe data yaitu:

a. Boolean (benar salah)

b. Angka

c. Huruf.

Pada C#, variable variable yang sering digunakan seperti berikut:

a. Int, digunakan untuk menyatakan suatu bilangan bulat, positif maupun negatif

b. String, digunakan ketika menyatakan sekumpulan karakter, baik itu nama, kalimat, password
ataupun kode. String sesungguhnya merupakan suatu array dari char

c. Bool, bernilai true atau false. Paling sering digunakan untuk menyatakan suatu kondisi,
misalnya SedangHujan, SedangLapar, dan lain lain.

d. Float, digunakan ketika kita perlu menyatakan suatu bilangan pecahan, misal nilai suatu

harga atau berat.
54.3 Class

Class merupakan suatu frame yang merupakan definisi yang memuat data dan metod

pengolah data. Sebelum kita mendapatkan objek, kita harus membuat rancangan dari objek
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tersebut (class) terlebih dahulu. Secara umum, class memiliki dua macam anggota, yaitu field dan

method. Ketika kita membuat file C# script maka nama dari file akan otomatis menjadi nama class.

1 » | firstscript.cs

Mo selection
1 using System.Collections;
2 using System.Collections.Generic;

11 using UnityEngine;
i: _— 5 public c'_ass: MonoBehaviour {

Fhic Ffor iniFial s =aFion

| firstScript | 8 woid start () {

}

1 / Indate 15 called once per jframe

13 void Update () {
15 }
63

Gambar 5.1 Contoh Penerapan Class

5.4.4 Method

Secara default akan ada dua method jika kita membuat file C# script baru di Unity. Yaitu
method void start() dan method void update (). Fungsi dari method void start yakni menyimpan
dan melaksanakan aksi yang didalam method tersebut ketika aplikasi dijalankan pertama kali dan
aksi tidak berulang — ulang. Kebalikan dari method void start(), method void update memiliki
peran menyimpan aksi dan melaksanakan aksi tersebut setelah method void start() dilaksanakan
dan aksi tersebut berulang — ulang atau loop.

14 » | firstScript.cs

Mo selection
1 using System.Collections;
2 using System.Collections.Generic;
3 using UnityEngine;

5 public class firstScript : MonoBehaviour {

o

[vold start O] {

¥

ILLed once per jrame

/4 Update is calle
15 [uoid vpdate D¢
15 }
i)

Sumber Kode 7 Contoh Penerapan Method
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545 |If

Setiap bahasa pemrograman pasti mengenal dengan pengondisian,yaitu ketika suatu
kondisi terlaksana maka akan terjadi aksi yang diinginkan. Begitu juga C# pada unity.
Pengondisian pada unity bisa menggunakan if dengan struktur seperti pada gambar

Sumber Kode 8 Contoh Penerapan If

Didalam kurung setelah tulisan if merupakan kondisi yang diinginkan. Kemudian setelah
kondisi yang terdapat didalam kurung, terdapat aksi yang diinginkan didalam kurung kurawal.
5.4.6 Loop

Loop atau looping digunakan untuk pengulangan. Banyak sekali jenis pengulangan yang
sering digunakan untuk membangun sebuah program tertentu, namun yang sering adalah while
loop dan for loop. Masing-masing mempunyai syntax dan cara eksekusi yang berbeda.

While Loop

Pengulangan yang dilakukan dengan memastikan kondisi (bernilai true) sebelum

mengeksekusi pengulangan tsb.

For Loop

for (i=noji<n;i++)

Pengulangan yang dilakukan untuk mengeksekusi sebuah statement sebanyak nilai n / variabel

yang ditetapkan, dimulai dari nilai nO serta digunakan untuk menyingkat sebuah code.

Sumber Kode 9 Contoh Penerapan Looping
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5.4.7 Game Object Script
1. Destroy

Destroy(Object O, Float F); Adalah sebuah method yang digunakan untuk menghapus
objek tertentu (objek O)secara langsung tanpa jeda waktu atau dengan jeda waktu tertentu (float

F). Objek yang dapat dihapus berupa gameobjek dan komponen gameobjek.

d Update () {

o I —} = a
Destrao .-I_gcl"":-._;b:l:-._ C )3

Sumber Kode 10 Contoh Penerapan Destroy

2. Instantiate

Instantiate (Object O, Vector3 V, Quaternion Q); Method ini berfungsi untuk untuk
menggandakan objek tertentu bisa berupa gameobjek atau komponen gameobjek. Pada saat
menggandakan objek yang kita tentukan, Kita juga bisa menentukan nilai posisi dan rotasi dari
objek tsb (Opsional).

| Update ()
Instantiate(gamelbject);
Sumber Kode 11 Contoh Penerapan Instantiate

5.4.8 Collider Script
Collider script Setelah memahami masing-masing fungsi dari method untuk collider maka

di bagian ini akan dijelaskan penerapan dari masing-masing method.

Tabel 4 Fungsi Method Untuk Collider

Nama Method Fungsi
OnGUI Untuk membuat GUI menggunakan
script
OnCollisionEnter Method yang dipanggil ketika collider /

rigidbody telah mulai menyentuh

collider / rigidbody yang lainnya
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OnCollisionStay

Method yang diapanggil tiap frame
setiap collider / rigidbody yang sedang
menyentuh collider / rigidbody.

OnCollisionExit

Fungsi yang dipanggil ketika collider /
rigidbody telah berhenti menyentuh
ollider / rigidbody yang lainnya

OnTriggerEnter

Method yang dipanggil ketika collider

lain menyentuh trigger.

OnTriggerStay

Method yang dipanggil hampir semua
frame untuk setiap kejadian ketika

collider menyentuh trigger

OnTriggerExit

Method yang dipanggil ketika collider
lain berhenti menyentuh trigger.

B. PRAKTIK

Setelah pembaca faham tentang Physic Engine yang dibahas pada Bab sebelumnya. Kali

ini kita membahas tentang Scripting pada Unity 3D. Diharapkan pembaca dapat mengetahui

bahasa pemrograman yang digunakan untuk melakukan scripting pada Unity 3D. Pembaca dapat

mengetahui fungsi dan variabel scripting pada Unity 3D. Pembaca dapat melakukan scripting pada

Unity.

PERALATAN
1. Komputer
2. Software Unity
3. Koneksi Internet

LANGKAH LANGKAH PERCOBAAN

Membuat File Script
1. Piih tab menu Assets

2. Pilih Create
3. C# Script
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) Unity 2017.3.1F1 P

bit) - Untitled - Bismillah Unity Project - PC, Mac & Linux

Fie e T Asee] t Component Window Help

Create >| Folder

ow in Explorer [ T e
E" Shader
[ Testing

Open Scene Additive Playables

Import New Asset...
Import Package
Export Package...
Find References In Scene

Select Dependencies

Refresh
Reimport

Reimport All
Extract From Prefab
Run AP| Updater...

Open C# Project

Assembly Definition

> Scene
Prefab

Audio Mixer

Material
CurieR Lens Flare
Render Texture
Lightmap Parameters
Custom Rendler Texture:

Sprite Atlas

Sprites >
Tile

[ create -

¥ /Favorites | Assets »

© Al Material:
©LAll Models

Animator Controller

Animation

Animator Override Controller
(© Al Prefabs
Avatar Mask

b G ur_lab_asse  ¥i_lab_ass.. Timeline

Physic Material
Physics Material 20

GUI Skin
Custom Font
Legacy >

UlElements View

Gambar 5.2 Langkah Membuat File Script

4. Kilik kanan pada panel project

5. Pilih Create

6. C# Script
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Render Texture
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Custom Render Texture
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[ spites

Tile

Animator Controller
Animation
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Avatar Mask

mea

Timeline

Physic Material
Physics Material 2D

GUI Skin
Custom Font

Legacy

UlElements View

Import New Asset...
Import Package >
Export Package...

Find References In Scene

Select Dependencies

Refresh Ctrl+R
Reimport

Reimport Al
Extract From Prefab
Run AP| Updater..

Open C# Project

Gambar 5.3 Langkah Membuat File Script
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7. Ubah nama file

e-a

F @l
[Behaviourse]

Gambar 5.4 Merubah Nama File Script

= =
#

8. Pastikan Class yang tertulis pada script merupakan nama file

1 using System.Collections;
2 using System.Collections.Generic;
3 using UnityEngine;

5 public clasq firstScript :| MonoBehaviour {

é 6

c# 8 void start () {
9
18 }
12 // Update is called once per fram
13 void Update () {
15 }
16 }

Sumber Kode 12 Class Nama File

Variabel
1. Membuat Empty Game Object Dengan Cara Pilih GameQObject pada menubar
2. Pilih Create Empty

@ Unity 2017.3.1f1 Personal (64bit) - - Bismi
File Edit Assets [GameGBject | C nt Wi
I Create Empty Ctrl+Shift+N
Create Empty Child Alt+Shift+N
3D Object

2D Object

Effects

Light

Audio

Video
ul

vow v v v v v

Camera

Center On Children
Make Parent

Clear Parent

Apply Changes To Prefab

Break Prefab Instance

Set as first sibling Ctrl+=
Set as last sibling Ctrl+-
Move To View Chrl+Alt+F
Align With View Ctrl+Shift+F

Align View to Selected

Toggle Active State Alt+Shift+ A

Gambar 5.5 Cara Mengosongkan GameObject
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€ Unity 2017.3.1f1 Personal (64bit) - Untitled - Bismillzh Unity Project - PC, Mac & Linux Standalone® <DX11> - o X

File Edt Assets GameObject Component Window Help

Gambar 5.6 Hasil Empty GameObject

Memasukkan firstScript ke Game Object

Cara 1: Dengan cara mendrag File firstScrip ke GameObject

) Unity 20173.1f1 Personal (64bit) - Untitled - Bismillah Unity Project - PC, Mac & Linux Stendalone® <DX11>
File Edit Assets GameObject Component Window Help

Account -

Lol @ Inspector

a ¥ GameObject ] Static =

Tag |Mntagged ¢ Layer [Default ¢

¥ .~ Transform -
Position ® -0.0342 -0.0108 0.04242
®o 4]
X|1 1

Rotation

Scale

|- firstScript

Add Component

@ Project
| Craste |
v Faverites
All Material
(1 all Models
(©L All Prefabs

» & vr_lab_asse Vtab_ass |

Gambar 5.7 Cara Pertama Memasukkan FirstScript ke Game Object

Cara 2 : Masukkan firstScript ke Game Object dengan cara memalui panel Inspector
1. Di panel Inspector klik Add Component

2. KIlik Script

3. Pilih First Script
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4.

[+ 'hasilscript
Tag unrauund = Component

Add Component

[
[
[
[E
[& Fir
[
[
[
[

E
Gambar 5.8 Cara Kedua Memasukkan FirstScript ke Game Object

Tipe Data
1. Double Click pada file firstScript
2. Tuliskan tipe data sesuai gambar di bawah ini

selection
1 using System.Collections;
2 using System.Collections.Generic;
3 using UnityEngine;
4
5 public class firstScript : MonoBehaviour {

B

7 int AngkaPertama = 18;

8 string Huruf = "huruf”;

g bool AktifBoolean = true;

18 float AngkaKedua = @.5F;

11

12 S/ Use this for initialization
13 void start () {

14

15 3

16

17 S/ Update is called once per frame
18 void Update () {

19 Debug.Log (AngkaPertama);
20 Debug.Llog (Huruf);

21 Debug.log (AktifBoolean);
22 Debug.Log (AngkakKedua);

23

24 3

25 }

Sumber Kode 13 Contoh Tipe Data Script

[T m]

Gambar 5.9 Play Button

3. Kilik play button
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4. Lihat hasilnya pada panel Console seperti di bawabh ini
3 Project E console

| Clear | | Collapse | Clear on Play | Error Pause | Editor '|

1y 10

!
A/ UnityEngine.Debug:Leg(Object)
1y huruf
< UnityEngine.Debug;Log(Object)
1y True
=7 UnityEngine.Debug:Log(Object)
(1) 0.5 ) .
" UnityEngine.Debug:Log(Object)
A 10
= UnityEngine.Debug:Log(Object)

Gambar 5.10 Panel Console

Membuat Public Variabel

Tujuan penambahan public dalam variable berfungsi untuk menginputkan data dalam panel

Inspector.

1. Tambahkan public di depan tipe data

1 » firstSeript.cs

 firstScript » EF] AngkaKedua
1 using System.Collections;
2 using System.Collections.Ge
3 using UnityEngine;

5 public class firstScript

@

7 public| int AngkaPertama
3 public| string Huruf = "h
9 public| bool AktifBoolea
18 public| float AngkaKedua
13 void start () {

15 }

18 void Update () {

19 Debug.Log (AngkaPer
28 Debug.log (Huruf);
21 Debug.log (AktifBoo
22 Debug.Log (Angkaked
24 1

25 }

neric;

: MonoBehawviour {

18;
T
n = true;

]

tama);

lean);
uaj;

Sumber _Kode 14 Menambahkan Public Pada Script

2. Kilik play button

3. Pada inspector panel dapat dirubah nilai variabelnya
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8 Inspector
. [+ |GameObject | [] static =
Tag |Untagged  :| Layer [Default ¢

-0.0108 £ 0.04242

-0.0342
0

0o jzo
[Eal

0s
Add Component

Gambar 5.11 Panel Inspector

Operasi Bilangan Aritmatika

1. Tuliskan kode seperti gambar di bawabh ini

43 firstScript » L] Update ()
1 using System.Collections;
2 using System.Collections.Generic;
3 using UnityEngine;
4
5 public class firstScript : MonoBehawiour {
6
7 public int AngkaPertama = 18;
3 public string Huruf = "huruf™;
] public bool AktifBoolean = true;
1a public float AngkaKedua = 8.57;
11
12 /7 Use this for initialization
13 vold Start () {
14
15 1
16
17 /4 Update is called once per frame
18 void Update () {
19 Debug.Log (AngkaPertama);
2@ Debug.Log (Huruf);
21 Debug.Log (AktifBoolean);
22 Debug.Log (AngkaKedua);
23
24 |Debug.Log (5 + 5 + "sama dengan” + 1@);'
25
26 }
27}
28

Sumber Kode 15 Script Aritmatika
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2. KIlik play button

3. Lihat hasilnya pada panel Console seperti di bawah ini

3 Project | B Consale |
| Clear | | Collapse | Clear on Play | Error Pause | Editor ~
~ 10
¥ UnityEngine .Debug:Log{Object)
vy huruf
» UnityEngine.Debug:Log{Object)
1 True
~ UnityEngine Debug:Log{Object)
o 0.5

=~ UnityEngine.Debug:Log(Object)

v 10sama denganl0
~ UnityEngine Debug:Log{Object)

"

Gambar 5.12 Panel Console

Class

Membuat Class Baru

1. Klik Assets pada menubar
2. Pilih Create

3. C# Script

4 D017.3.1F1 Personal (64bit) - Untitled - Unity Scripting - PC, Mac & Linux Standalone® <DX11>
i 1 GameObject Component Window Help
Ea Creste ) Folder l

C# Script I

112

= ot Showin Explorer
Lewnec | Open 2 Shade |
¥ €] untit Delete 3
e Testing >
Directi  Open Scene Additive Playables >
[ hasilsd
———— Assembly Definition
Import Package > Scene
Export Package... Prefab
Find References In Scene oo Mixer
Select Dependencies
Material
Refresh CuleR Lens Flare
(s Render Texture
Reimport All Lightmap Parameters
Etract From Prefab S Vi
Run API Updater... Sprite Atlas
Sprites >
#
Open C# Project iy
u Animator Controll
& Project Hl Console nimstor Lontrofler

| create -
¥ | /Favorites | Assets

(©L All Matarial

©1 Al Models

(LAl refabs .

L
| = Assets |
FirstScript

Animation
Animater Override Controller
Avatar Mask

Timeline

Physic Material
Physics Material 2D

GUI Skin
Custom Font
Legacy

I o

Gambar 5.13 Langkah Menulis Script
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4. Ubah nama file

|SecondScript|

liBehaviourse

Gambar 5.14 Mengubah Nama File

5. Pastikan Class yang tertulis pada script merupakan nama file
6. Setelah itu buat variable baru float dengan menambahkan public static sebelum jenis variable

tersebut dengan cara klik dua kali pada SecondScript dan ketikan code di bawah ini

ﬂ Unity Scripting - Microsoft Visual Studio Y & QuickLaunct
File Edit View Project Build Debug Team Tools  Analyze  Window
0-0|@-2 W9 | Debug - AnyCPU - b Atta

s ES

=] | Unity 5cripting ~ | %3 SecondScript +| @, Start() -
1 Slusing System.Collections; +
using System.Collections.Generic; -

using UnityEngine;

MonoBehaviour {

2
3
5 Slpublic class SecondScript :
6
7
a

public static fleat floatKedua = 1.5f; Ly
|

[/ Use this for initialization

1@ = vold start () {

12 3

13

14 // Update is called once per frame
15 = volid Update () {

16

17 1

18 ¥

Sumber Kode 16 Script Public Static

7. Kembali ke firstScript, tambahkan code Debug.Log seperti gambar di bawah pada method void
update.
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;‘QJ Unity Scripting - Microseft Visual Studio Y &' | Quicklaunck
File Edit View Project Build Debug Tearn Tools Analyze Window
e' |{ﬁ";—|um|9' '| Debug = Any CPU ~ P Attac

condScript.cs FirstScript.cs™ = X
] gﬁUnity Scripting vI #3 FirstScript -IE’ﬁ Update() -
1 Eusing System.Collections; \i
2 using System.Collections.Generic; a
3 using UnityEngine;
4
5 Epublic class FirstScript : MenoBehaviecur {
6
7 public int AngkaPertama = 1@;
8 public string Huruf = "huruf";
9 public bocl AktifBoolean = true;
1@ public float AngkaKedua = 8.5T;
11 [/ Use this for initialization
12 = void Start () {
13
12 } b
15
16 // Update is called once per frame
17 [ void Update () {
18
19 Debug. Log(AngkaPertama) ;
28 Debug. Log(Huruf);
21 Debug. Log(AktifBoolean);
22 Debug. Log(Angkakedua);
23
24 Debug.Log(s 4 5 & ~cams dengan o 16);
25 I Debug,Log(SeccndSc’W
26 i
27 }
28

Sumber Kode 17 Script Debug.Log

8. Setelah itu, tambahkan firstScript pada GameObject pada scene dengan cara klik hasilscript

Q Unity 2017.3.1f1 Personal (64bit) - Untitled - Unity &
File Edit Assets GameObject Component W

N + EIEAIC)

= Hierarchy

| Create *l oAl

v € Untitled* -=
Main Camera

Directional Liiht

Sumber Code 18 Halascript

9. Klik Add Component
10. Klik Script
11. Pilih firstScript
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® Inspector
a |E hasilscript ' Static ¥

Tag | Untagged t| Layer | Default

¥ .~ Transform L] %
Position X0 v [0 [zo |
Rotation X0 v [0 2o |
Scale X1 KA | z[1 |

|7 [c| ¥ First Script (Script) @
Script - Firstseript [5]
Angka Pertama 10 |
Huruf [huruf |
Altif Boolean [
Angka Kedua 0.5 |

l Add Component ]

Gambar 5.15 FirstScript Terpasang

12. Setelah firstScript terpasang pada GameObject, tekan tombol play

13. Lihat pada bagian console maka akan muncul hasil dari debugging

[El Console

| Elear | | Collapse | Clear on Play | Error Pause | Editor ~ | D7 Ao [@0]
Puruf 7o)
UnityEngine .Debug:Log{Object) 70,
True =
UnityEngine .Debug:Log(Object) or

o 0
UnityEngine Debug:Log(Object) L

@ 10sama denganl0 70
UnityEngine.Debug:Log(Object) ;
o 70

UnityEngine.Debug;Log(Object)

I

Gambar 5.16 Panel Console

Method

Menambahkan Code Pada Bagian Method Start

1. Kembali ke firstScript

2. Tambahkan code debug.log variable pada bagian method start seperti dibawah ini

SecondScript.cs FirstSeriptcs” = X
¥ Unity Scripting - | % FirstSript - | @a sterto
1 Susing System.Collections;

using system.Collections.Generic;
using UnityEngine;

2
3
a
5 Spublic class FirstScript : MonoBehaviour {
[
7
8

public int AngkaPertama = 18;
public string Huruf = "huruf";

B public bool aktifScolean = true;

10 public float AngkaKedua = @.5f;

1 // Use this for initialization

12 E void Start

=

14

15

16 // Update is called once per frame

17 G void Update () {

18

19 Debug. Log(AngkaPertama) ;

20 Debug. Log(Huruf) ;

21 Debug. Log(aktifBoolean);

22 Debug. Log(AngkaKedua) ;

23

24 Debug.Log(5 + 5 + "sama dengan” + 18);

25 Debug.Log(SecondScript. floatKedua);

26 }

27 1

Sumber Kode 19 Debug.log
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3. Setelah itu play dan lihat pada console

€0 Unity 2017.2.1f1 Personal (64bit) - Untitled - Unity Scripting - PC, Mac & Linux Standalene® <DX11>

File Edit Assets GameObject Component Window Help

@ collab - | [ & | [Account -
© Inspector

o P | [] Static v

Tag [Untagged + Layer [Default A
¥.~ Transform [WE
hasilscript = Y B postion o v Jzlg |
- \I_t & Y0 Zjo
relative to

The local position of this
the parent.

v [T zZ[L

|| M First Script (Script) G =
Script . FirstSeript @

Angka Pertama 10 |
Huruf Thuruf |
Alktif Boolean

Angka Kedua 0.5 |

Add Component

[l console
Clear | | Collapse | Clear on Play | Error Pause | Editor =

i) et o
=/ UnityEngine Debug:Log(Object) <
off 2
=/ UnityEngine Debug:Log(Object) \Z8/
© ]
=/ UnityEngine Debug:Log(Object) \Z8/

1) True
=/ UnityEngine Debug:Log(Object)

T) 0.5
[ UnityEngine Debug:Log(Object)

Gambar 5.17 Panel Console

Membuat MethodBaru Pada SecondSCript
1. Klik dua kali pada Script SecondScript
2. Ketikan code pada void update seperti gambar

SecondScript.cs* + X |FlEsayl X
gﬁUnity Scripting 'I #3 SecondScript vI @ methodBaru()

bl

1 Elusing System.Collections;

2 using System.Collections.Generic;

3 using UnityEngine;

4

5 Elpublic class SecondScript : MonoBehaviour {
[

7 public static fleat floatKedua = 1.5F;
3

9 // Use this for initialization

1@ El vold Start () {

11

12 | 1 i |
13

14 // Update is called once per frame

15 El void Update () {

16

17 .

18 —

199 © public static void methedBaru(){|

28 Debug. Log(floatkedua);

21 | T

22 B

23

Sumber Kode 20 Void Update Pada SecondScript

3. Setelah itu kembali ke firstScript
4. Tambahkan ke update nama method seperti dibawah ini
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FirstScript.cs™ & X

'I 2 FirstScript vI @, Update()

Blusing System.Collections; |
using System.Collections.Generic;

Elpublic class FirstScript : MonoBehaviour {

int AngkaPertama = 18;
string Huruf = "huruf”;
bool AktifBoolean = true;
float AngkakKedua = 8.5f;
this for initialization

Debug.Log(Huruf);
// Update is called once per frame

Debug.Log(AngkaPertama);
Debug.Log(Huruf);
Debug.Log(AktifBooclean);
Debug.Log(AngkaKedua);

Debug.Log(5 + 5 + "sama dengan™ + 18);

Debuz. Log({Secondscript. floatkKedua);
SecondScript.methodBaru();

gﬁUnityScripting
1
2
3 | using UnityEngine;
a4
5
[
7 public
g public
] public
1@ public
11 [/ Use
12 =] void Start () {
13
14 o
15
16
17 =] void Update () {
18
19
28
21
22
23
24
25
26
27 o
28 1

Sumber Kode 21 Menambahkan Update Nama Method

If

1. Tuliskan kode seperti dibawah ini

1 » / firstScript.cs

x V ifScript.cs x A

@ ifscript » Mo selection

1 using System.Collections;

u

e s TV S WY R 6

=
L ]

using System.Collections.Generic;

]
sing UnityEngine;

public class ifScript : MonoBehaviour §

bool budiMakan = true;

1

i
AU
void

"/ Update

vold Update () {

;tart 01

this for initiaglization

is called onc

m
-
m

“h
g

=]
m

[iF}budirakan){

Debug.Log ("budi makan bersama ibu™};

}

21 }f

Sumber Kode 22 Code If
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2. Terapkan pada GameObject
3. Kilik play button
4. Lihat hasilnya pada panel Console seperti di bawah ini

£3 Project ' El Console |

| Clear | | Collapse | Clear on Play | Errar Paus

1y budi makan bersama ibu

= UnityEngine.Debug:Log{Object)

.-"-r"\. 10

i UnityEngine .Debug:Log(Cbject)

1y huruf

= UnityEngine.Debug:Log{Object)

5 True

his UnityEngine Debug:Log(Object)

I.-"r"\. D.S

= UnityEngine.Debug:Log(Object)
Gambar 5.18 Panel Console

Loop

1. Tuliskan kode seperti dibawah ini
¥ firstScript.cs ', ifscript.cs ! loopScript.cs
loopScript » ‘EStartD
1 using System.Collections;

2 using System.Collections.Generic;
3 using UnityEngine;

[V Y

public class loopScript : MonoBehaviour {

void Start () {
for(int i = 8; 1 < 5; i++) {
Debug.Log ("for looping™ + 1i};

TR R

=
[<~]

11 T
13 }

15 // Update is called once per frame

16 void Update () {

Sumber Kode 23 Code Loop

2. Terapkan pada GameObject
3. Kilik play button

4. Lihat hasilnya pada panel Console seperti di bawah ini
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£3 Project ' El console |
| Clear | | Collapse | Clear on Play | Error Pause | Editar =

1y for looping0d
" UnityEngine.Debug:Log(Object)
-y~ for loopingl
M UnityEngine.Debug:Log(Object)
1y for looping2
" UnityEngine.Debug:Log(Object)
-y~ for looping3
il UnityEngine.Debug:Log{Object)
1y for looping4
" UnityEngine.Debug:Log(Object)

Gambar 5.19 Panel Console

Game Object Script
Destroy
1. Buat C# Script baru dengan nama destroyScript

2. Tuliskan kode seperti dibawah ini

» | firstSerip \ifScript. \loopScr | Collider, destr * | Destroy | MeshRe | destroy
destroyScript » L] Update ()

1 using System.Collections;

2 using System.Collections.Generic;

3 using UnityEngine;

5 public class destroyScript : MonoBehaviour {
8 void Start () {
18 1

12 // Update is called once per frame
1 void Update () {
15 {
16 Destroy(gameObject);
17 }
13 }

Sumber Kode 24 DestroyScript

3. Terapkan pada Gameobject dengan nama destroyResult
4. KIlik tombol play

5. DestroyResult akan terhapus dari panel Hierarchy
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(1 & Unity 2017.3.171 Personal (84bit) - bisrmillsh.unity - Bismillah Unity Project - PC, Mac & Linux Stendalone® <DX11> - [m] X

Instantiate
1. Buat C# Script baru dengan nama Instantiate
2. Tuliskan kode seperti dibawah ini

instantiate.cs B X [Tyl fes SecondScript.cs
aUni'tyScripting vI‘I;instantiate ,I&‘:la Update()

1 Blusing System.Collections;

2 using System.Collections.Generic;

3 | using UnityEngine;

4

5 Elpublic class instantiate : MonoBehaviour {

6

7 /{ Use this for initialization

8 Bl wvolid start () {

9

10 3

11

12 f/ Update is called once per frame

13 = wvoid Update () {

14 Instantiate(gameObject);

15 1

16

17 |

18 LY

Sumber Kode 25 Code Instantiate

3. Terapkan pada Gameobject dengan nama hasilscript
4. KIlik tombol play
5. Lihat hasil pada panel Hierarchy
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<) Unity 2017.3,1f1 Personal (64bit) - unity scripting.unity - Unity Seripting - PC, Mac & Linux Standalone” <DX11> - X
File Edit Assets GameObject Component Windew Help

Gambar 5.21 Panel Hierarchy

Collider Script
OnCollisionEnter
1. Buat C# Script baru

2. Tuliskan kode seperti dibawah ini

-.&uupScli Collidﬂ‘iestleKDestleMeshRe‘ieshw collic O-

3 collider » L] Update ()

1 using System.Collections;

2 using System.Collections.Generic;

3 using UnityEngine;

4

5 public class collider : MonoBehaviour {

6

7 public void OnCollisionEnter(Collision Col){
3 if (Col.gameObject.name == "Erlenmayer”) {
9 Debug.Log ("Enter Gelas Breaker™);
18 3

11 1

12

13 S/ Use this for initialization

14 void Start () {

15

16 1

17

18 S/ Update is called once per frame

19 void Update () {

28

21

22 }

Sumber Kode 26 OnCollisionEnter Script

3. Terapkan pada Gameobject meja > Rectangle02
4. Klik tombol play
5. Lihat hasil pada panel console
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Q Unity 2017.4.0f1 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone* <DX11> = =] X
t Component Window Help

| Collapse | Clear on Play | Error Pause |
@

Gambar 5.22 Hasil GameObject Meja Dengan OnCollisionEnter

OnCollisionExit
1. Buat C# Script baru
2. Tuliskan kode seperti dibawah ini

moopStl&Zollidﬂ‘:lestle Destm]ri‘hl'leshlle‘ieshw;tollid .‘

G collider » [l OnCollisionExit (Collision Col)

1 using System.Collections;

2 using System.Collections.Generic;

3 using UnityEngine;

4

5 public class collider : MonoBehawiour {

6

7 public void OnCollisionExit(Collision Col){

8 if (Col.gameObject.name == "Erlenmayer”) {
Debug.Log (“Exit| Gelas Breaker");

1@ }

11 1

12

13 A Use this for initialization

14 void Start () {

15

16 1

17

18 // Update is called once per frame

19 void Update () {

28

21 1

22 }

23

Sumber Kode 27 OnCollisionEXxit Script

3. Terapkan pada Gameobject meja > Rectangle02
4. Klik tombol play
5. Lihat hasil pada panel console
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€ Unity 2017.4.0f1 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone® <DX11> = g X

[©z]A0]@0]

Gambar 5.23 Hasil GameObject Meja Dengan OnCollisionExit

OnTriggerEnter

1. Pastikan rectangle02 telah dicentang is Triggernya
2. Buat C# Script baru

3. Tuliskan kode seperti dibawah ini

triggerExit.cs ay.cs
aBABd vI‘I;triggerEnter vI&l OnTriggerEnter(Colli
1 Elusing System.Collections;

using System.Collections.Generic;
using UnityEngine;

triggerEnter.cs & 3

3

4

5 E||pub1:i.c class triggerEnter : MonoBehaviour {

6 E public wvoid OnTriggerEnter(Collider Col}{

7 =] if (Col.gameObject.name == "Erlenmeyer”){
8

Debug.Llog(“Trigger Enter Erlenmeyer™});
s | }
10 |
11 // Use this for initialization
12 =] void Start () {
13
14 | }
15
16 !/ Undate is called once per frame
17 =] public class triggerEnter
18
19 o
20 3

Sumber Kode 28 OnCollisionEnter Script

4. Terapkan pada Gameobject meja > Rectangle02
5. KIlik tombol play
6. Lihat hasil pada panel console
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€ Unity 2017.3.1f1 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone® <DX11> = [: X

File

Edit Assets GameObject Component Window Help

MoBepXHOCTL 2,

Shader

Topel, ,
Shader [Standard =]

Gambar 5.24 Hasil GameObject Meja Dengan OnCollisionEnter

OnTriggerStay

1. Pastikan rectangle02 telah dicentang is Triggernya
2. Buat C# Script baru
3. Tuliskan kode seperti dibawah ini

124

triggerStay.cs # X QOB

o8
5

'I #2 triggerStay vl @ OnTriggerStay(Collider

L R I Y I

El

5
&

El

3

using System.Collections; |
using System.Collections.Generic;
using UnityEngine;

public class triggerStay : MonoBehaviour {
public void OnTriggerstay(Collider Col){
if (Col.gameObject.name == "Erlenmeyer™)

Debug.Log("Trigger Stay Erlenmeyer™);

h
1

// Use this for initialization
void Start () {

b

// Update is called once per frame
void Update () {

b

Sumber Kode 29 OnTriggerStay Script
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4. Terapkan pada Gameobject meja > Rectangle02
Klik tombol play
6. Lihat hasil pada panel console

& Unity 2017.3.1f1 Personal (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone® <DX11> - o X
File Edit Assets GameObject Component Window Help

+ IR

Rectangle 02 (Mesh Filt g
TWRectangle02 | ©

@
3 °
B:ynambt)uc‘luded 4

v i ¥ Box Collider .

-A Edit Collider
Is Trigger o
Material 'None (Physic M ©

Center
x0 ¥ -1.4210€/ 2 0.00585(
[ Console Size
Clear || Collapse | Clear on Play | Error Ph - X[1.174 Y 0.72400( 2/0.0117
@ Trigger Enter Erlenmeyer .
UnityEngine.Debug:Log(Object)

Trigger Stay Erlenmeyer o)
© UnityEngine .Debug:Log(Object) 'r;";m’.’:"' Stey; "strlggarsuy ot

MoBepxHOCTL %,
N S i —

Topey #
> Shader | Standard -+

[ Add Component ]

Gambar 5. 25 Hasil Game Object Meja Dengan OnTriggerStay

OnTriggerExit

1. Pastikan rectangle02 telah dicentang is Triggernya
2. Buat C# Script baru

3. Tuliskan kode seperti dibawah ini

™ BaB4 - | %5 riggerbxit -| @ OnTriggerEit(Collider
1 Fusing Ssystem.Collections; ‘
2 using System.Collections.Generic;
3 using UnityEngine;
1
5 El|pub1ic class triggerExit : MoncBehaviour {
[ =] public veid OnTriggerExit(Cellider Col)
7 {
8 = if (Col.gameObject.name == "Erlenmeyer”)
9 {
1@ Debug.Log("Trigger Exit Erlenmeyer”);
11
12
13 // Use this for initialization
14 = wvoid start () {
15
16 }
17
18 // Update is called once per frame
19 = wvoid Update () {
28
21 }
22 1
23

Sumber Kode 30 OnTriggerExit Script
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4. Terapkan pada Gameobject meja > Rectangle02
5. KIlik tombol play

6. Lihat hasil pada panel console

Q Unity 2017.3.1f1 Personal | (64bit) - BAB4.unity - BAB 4 - PC, Mac & Linux Standalone® <DX11> = a X
File Edit Assets GameObject Component Window Help
(O BN S = 1] 6 L= conter | @ Local I > 1 1] (& coteb - J [ & [ Account -] [Layers -] ca

B 0 inspecr, INIRN

] A
= ¥ Rectangle 02 (Mesh Filt [@ %
Main Camera Mesh | WRectangle02 | ©
fenol s ¥ . ¥ Mish Rend @

X ... ¥ Mish Renderer
» BeakerStand DJr‘ iy
» graduated cylinder
» Beaker

¥ Materials

» microscope Size (2 |
» Volumetric Flask Element 0 ‘WTopeu 1o

Element 1 [@Mosepxnocts | ©
Dynamic Occluded ¥

= 7' ¥Box Collider *,

» Retort Stand 1
pipet

» burret_titrasi

» room

Edit Collider
Is Trigger
| Material ‘None (Physic M ©
Center
X0 Y -1.4210¢ 2[0.00585(

GameObject SIzE

X1.174 | ¥ 0.72400(20.0117
r—ifﬁmih EETT. - v |G| [ Trigger Enter (Script) 2%,
| Clear | | Collapse | Clear on Play | Error Payse | Editor = | D3] Aoc|@o | Script triggerEnter ©
(1) Trigger Enter Erfenmeyer 6 | ¥ICICiTrigger stay (Script) B
-/ UnityEngine.Debug:Log(Object) S Seript ricnerstey 1
1 Trigger Stay Erlenmeyer . . =
(L) UnityEngine.Debug:Log(Object) 110 /| v |G| M Trigger Exit (Script). @
Script triggerExit | ©

7 Trigger Exit Erlenmeyer
%/ UnityEngine.Debug:Log(Object)

MoeepxHOCTL &,

» Shader | Standard
Topey &,
> Shader [ Standard B
[ Add Component ]
(D Trigger Exit Erl |

Gambar 5.26 Hasil GameObject Meja Dengan bnTriggerExit

C. KESIMPULAN

Bahasa script yang umum digunakan pada Unity adalah C# script karena terdapat banyak
referensi mengenai C# script di internet, selain itu C# script fleksibel dengan unity script lainnya

dan C# script memiliki aturan coding yang spesifik.

D. SOAL

1. Bahasa pemrograman modern yang bersifat general-purpose, berorientasi objek disebut...

a. C# b. HTML c. Boo d. Java Script

2. Kelas dasar dimana setiap skrip Unity diturunkan disebut ...
a. Awake() b. Update() c. MonoBehaviou d. Start()

3. Fungsi yang akan dipanggil pada frame ketika skrip diaktifkan sebelum salah satu metode
pembaruan disebut pertama kali adalah ...
a. Awake() b. Update() c. MonoBehaviou d. Start()

4. Fungsi sebagai tempat untuk menempatkan kode yang akan menangani update frame untuk
GameObject adalah ...
a. Awake() b. Update() c. MonoBehaviou d. Start()
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Suatu tempat dimana kita menyimpan nilai-nilai yang ada pada program disebut ...

a. Variabel b. Class c. Method d. Object

Pada C# variable yang menyatakan sekumpulan karakter, baik itu nama, kalimat, password
ataupun kode adalah ...

a. Int b. String c. Bool d. Float

Sebuah method yang digunakan untuk menghapus objek tertentu secara langsung tanpa jeda
waktu atau dengan jeda waktu tertentu disebut ...

a. While Loop b. For Loop c. Instantiate d. Destroy

Yang berfungsi untuk menyimpan dan melaksanakan aksi yang didalam method tersebut
ketika aplikasi dijalankan pertama kali dan aksi tidak berulang — ulang adalah ...

a. Method Void Start

b. Method Void Update

c. Method Void Exit

d. Method Void Enter

Method ini akan dijalan setiap frame selama collider lain masih menyentuh trigger yang telah
ditentukan adalah ...

a. OnColliderStay b. OnTriggerStay c. OnTriggerEnter d. OnTriggerExit
Method yang dijalankan ketika collider lain mulai berhenti menyentuh trigger adalah ...

a. OnColliderStay b. OnColliderExit c. OnTriggerEnter d. OnTriggerExit
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Halaman Ini Sengaja Dikosongkan
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BAB 6
UNITY USER INTERFACE

TUJUAN

1. Pembaca dapat mengetahui komponen User Interface (Ul) pada Unity.
2. Pembaca dapat membuat User Interface (Ul) sederhana pada Unity.

3. Pembaca dapat menginteraksikan antar komponen Ul

A. DASAR TEORI
6.1  Pengertian Ul

User Interface (UI) merupakan bentuk tampilan grafis yang berhubungan langsung dengan
pengguna (user). User interface berfungsi untuk menghubungkan pengguna dan aplikasi agar
bisa berkomunikasi dengan mudah, dimana terdapat input dari pengguna dan output dari
aplikasi.Pada versi Unity 3D terbaru sudah dilengkapi dengan fitur untuk membuat user interface
secara mudah. Salah satu contoh user interface yang bisa dibuat menggunakan unity3D

adalah text, input field dan button.

6.2  Sejarah dan Perkembangan Ul
Ada lima generasi perkembangan user interface yaitu :
6.2.1 Antar Muka Sistem Berkelompok.
Generasi pertama dari Ul, user berinteraksi dengan sistem melalui pengantar kerja secara
berkelompok. Semua perintah disampaikan terlebih dahulu sebelum dicetak hasilnya daya guna

antarmuka rendah.
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i Pertama Ul

6.2.2 Antar Muka Berorientasi Baris Perintah.

Diperkenalkan tahun 1960-an. Sistem ini mula-mula menggunakan antar muka baris
perintah berupa mesin Tele-type (TTY). Pengguna berinteraksi dengan mengetikkan perintah baris
demi baris. Interaksi user dengan menggunakan perintah berbentuk dialog soal jawab. Antar muka
ini memberikan daya guna yang rendah dan tidak memberikan kebebasan untuk berinteraksi
dengan komputer, misalnya pengguna tidak dapat bergerak di sekitar tampilan. Dalam hal ini

komputer lebih mengontrol user, tidak boleh ada kesalahan, dan membebani ingatan user.
ann Wordpress testsite

Cc + | 3 np //themes wordpress. met Testrun =3 = Q-

(] Hackssine P ng Matform Apple (115) v Amazon clay Yahoo! News (144%5)+

Uncal.qo riged

cat

cd

cle
current
editing
gpl
help

htalescape last

Gambar 6.2 Generasi Pertama Ul
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6.2.3 Antar muka full screen
Interaksi jenis ini membolehkan pengisian beberapa data untuk dimasukkan oleh user,

Berbentuk pengisian borang , Sistem menu berbentuk user interface full screen.

aRnE Home

TV Channels Categories

Mock the Week
EastEnders

Top Gear

The Making of Me

Summer Heights High

Gambar 6.3 Menu Berbentuk User Interface Full Screen

6.2.4 Antar Muka Pengguna Grafik

Berbentuk visual (GUI : Graphic User Interface) menggunakan grafik, ikon, dan animasi,
kemunculan sejak awal 1960-an dan baru digunakan pada tahun 1980-an pada sistem 8010 Star
Information System oleh Xerox Corporation, Interaksi berdasar WIMP (window, icon, menu, dan
pointer). Manipulasi langsung dari user dengan objek visual melalui mouse atau peranti lain, Point

and Click, Drag and Drop dan menggerakkan objek merupakan ciri utama dalam GUI.

Gambar 6.4 Graphic User Interface
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6.2.5 Antar Muka Pengguna Masa Depan
Antar muka pada masa yang akan datang mengarah pada penambahan berbagai unsur
animasi objek dan audio (suara dan bunyi), unsur tiga dimensi (spasial atau ruang) dan dalam
realitas maya dan berorientasi objek. Interaksi yang digunakan lebih ke bahasa alami (natural
language) dan membenarkan pengunaan input tidak berformat. Selain itu komputer juga dapat
menganalisa terhadap aktivitas user, seperti:
a. Embodied Interaction
Interaksi yang menggunakan gerakan tubuh untuk memberikan input ke komputer seperti
gerakan tangan atau yang lain tanpa menggunakan mouse atau keyboard, misalnya pada film

Minority Report.

Gambar 6.5 Minority Report

b. 3D Virtual Reality
Interaksi ini memberikan bentuk seolah user benar-benar berada di dalam komputer, atau
perwujudan interaksi dunia nyata dibentuk ke dalam dunia maya, misalnya pada permainan
The Sim 2.
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c. Sensing Affect
Membantu manusia dalam melakukan aktivitas sehari-hari sesuai dengan keadaan lingkungan
misalnya merasakan suhu, suara, melihat lingkungan dan sebagainya. Sistem ini biasa

digunakan pada wearable compute dan aksesoriesnya.

TeraHz Remo’fe Sensing

FIANY - YE—bE LT

Pollution Global Warming

AT % S 1L

CO, CO,. HCN I A
BrTs 0y, CO.0CS, HCHO, HCI, NHs/ |/

Gambar 6.7 Sensmg Affect

d. Sensor Network
Suatu sensor yang diletakkan pada tempat yang jauh dari komputer serta bisa mendeteksi

penglihatan dan suara yang ada di sekitar lingkungannya.

Gambar 6.8 Sensor Network

e. Cyborg
Komputer mini yang dimasukkan ke dalam suatu robot dan dapat berfungsi sebagaimana

mestinya anggota tubuh manusia.

133



MARI BELARMAIN VIRTUAL REALITY DENGAN UNITY 3D

6.4
6.4.1

Ul Pada Unity 3D

Untuk menambahkan user interface cukup klik menubar GameObject

kemudian pilih salah satu komponen yang ingin ditambahkan.

Komponen pada menu Ul hanya akan muncul pada panel game.

File Edit Assets

%= Hierarchy
Create ~| (orAll
¥ € untitled*
Main Camera
Directional Ligl
Canvas
EventSystem

i3 Project l
Create ~

YﬁFavorites

C pty

& pty Child
3D Object

20 Object

Effects

Light

Audio

Video

3t Unity 2017.3.1f1 Personal (64bit) - Untitled - user interface - PC, Mac & Linux Standalone™ <DX11>

GameObject | Component  Window Help

Ctrl+ Shift+ N
Alt+Shift+N

ul

Camera
Center On Children

Make Parent
Clear Parent
Apply Changes To Prefab

Break Prefab Instance

Set as first sibling

Set as last sibling
Move To View

Align With View
Align View to Selected

Toggle Active State

Ctrl+=
Ctrl+-
Ctrl+Alt+F
Ctrl+5hift+F

Alt+Shift+A

Text
Image

Raw Image

Button
Toggle
Slider
Scrollbar
Dropdown

Input Field

Canvas
Panel

Scroll View

Event System

@AH Material
(© all Models
@AH Prefabs

Komponen Pada Ul

Text

This folde

Gambar 6.9 Komponen Menu Ul

lalu pilih menu U,

Memiliki teks area yang digunakan untuk menambahkan teks pada tampilan. Kita dapat

melakukan beberapa pengaturan seperti jenis font, font style dan ukuran font. Adapula opsi untuk

mengatur perataan pada teks.
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al (64bit) - Untitled - user interface -

Mac & Linu

s GameObject Component Window Help

ollab - | [ &> || Account - Layers | [Layout -

® Inspector
Create Empty Ctrl+Shift+M v O static v =
Create Empty Child Alt+Shift+ N Tag [Umagged <) Layer (U1 B
= voL  RectTransf £
T 3D Object > ¢| Scale Qe 1" oeer o Rosx Post  pesz
0 Obiect R - C—
= s Width Height
B Efecs >
ig » Anchors
Light » Pivat xosIv[os ]
e > Retaton P — i —
Scale x Y i
Video > rr——ye :
q I ul N I Text v M Text (script)
Text
Camera Image W=l )
Center On Children Rowmage 4 Character
Font
Make Parent Erim G Sl
Font Size
Clear Parent foogls Line Spacing
Apply Changes To Prefab dher o et
Break Prefab Instance Sl bzt
Dropdown Align By Geometr[_)
s first s = Default UT Material ¢
Set as first sibling Ctrl+= Input Field
Set as last sibling Chrl+-
Move To View Ctrl+Alt+F S
Align With View Ctrl+Shift+F g
I Align View to Selected Sl i
| ] Toggle Active State Alt+Shift+A Event System

ald

Gambar 6.10 Komponen Menu Ul Text

Digunakan untuk menambahkan gambar. Fitur image memiliki dua komponen yaitu rect

transform component dan image component. Pada image component kita dapat mengatur sprite,

warna, material dan tipe gambar.

I

GameObject Component Window Help

Personal (64bit) - Untitled - user interface - PC, Mac & Linux Standalon

8 I[nspector

Create Em Ctrl+Shift+N
o 9 @mme s
Create Empty Child Alt+Shift+N
Tag | Untagged 2| Layer [UI &l
3D Object > —
R ¥+ RectTransform
2D Object 2 center  Pos X Pos Y Pos Z
Effects > w -391.5 |[-133 J[o |
Light 5 = @ Width Height
) E 1800 1000 tilR
Audie >
» Anchors
Video > Pivot x[05 ¥
ul > Text
| ' Rotation X[o_[v[o__12[0 ]
Ews 1 o | o —
Center On Children [EmimEE
Button ¥ ®a ¥ Image (Script)
Make Parent =
Toqgle Source Image |- papers.co-na%s @
ClesrPaent . Coler —
Apply Changes To Prefab Sl Material None (Material) | @
Bresk Prefab Instance Sl RaycastTarget o
) : Dropdown Image Type
Set as first sibling Ctrl+= Input Field Preserve Aspect [
Set as last sibling Ctrl+-
. Canvas
Move To Vi Ctrl+Alt+F
ove o few i Panel Default Ul Material %,
Align With View Ctrl+Shift+F B 'Defanl
) ) Scroll View > Shader | UL/Default -
Align View to Selected |
Toggle Active State Alt+Shift+A Event System [ Add Component I |
-

als

Image type atau tipe gambar pada image component memiliki fungsi masing-masing yaitu:

Gambar 6.11 Komponen Menu Ul Image
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Simple membagi keseluruhan sprite sama rata.

Sliced membagi sprite menjadi 3x3 bagian sehingga ketika ukuran dirubah

tidak akan

mendistorsi sudut namun hanya merentangkan bagian tengah.

Tiled mirip dengan sliced, namun tiled mengulangi bagian tengah daripada merentangkannya.

Filled menampilkan sprite seperti tampilan simple namun mengikuti arah, metode dan jumlah

yang ditentukan.

T AEEE W AN ERIEELEIE RaE

e

¥ ®u ¥ Image (Script)

FES

Source Image

|Hpapers .cu-na":‘lE| o]

Color | | #
Material None (Material) @ ©
Raycast Target [+
Image Type Simple ™
Freserve Aspect | .- Simple
Sliced
Default UI M Tiled
[ Shader | WL/ Filled

Add Component

| \

Gambar 6.12 Image Type

e. Set Native Size digunakan untuk menyetel ulang gambar ke ukuran sprite asli. Opsi ini akan
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muncul ketika simple atau filled dipilih.

7 % ¥ Image (Script)

Source Image

“lpapers.co-na%s ©

Colar |

Material

v

Raycast Target

‘None (Material) | @

Image Type | simple

Preserve Aspect | |

@ *

Gambar 6.13 Set Native Size

%,
|
: |
I Set [Mative Size I
Default UI Material
[ Shader | WI/Default
Add Component l
w



Texture Type
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f. Gambar dapat di-import sebagai Ul Sprite

dengan memilih Sprite (2D/UI) dari pengaturan

6.4.3 Raw Image

i @ Inspector Services B =
I . papers.co-nag9s-lake-mour [ % <
| Open |
Texture Type | Sprite (20 and UI) 4|
Texture Shape | 2D § |
What shape is this texture?|ale ¢
Packing Tag | |
Pixels Per Unit 100 |
Mesh Type [ Tight
Extrude Edges (|1
Pivot [ center
Sprite Edltnr
b Advanced
Wrap Mode | clamp
Filter Mode [ Bilinear
Aniso Level o — ]
Default | L 3
Max Size | 2048 el
Resize Algorithm | Mitchell ™
Compression | Marmal Quality $ |
Farmat Auto i
Use Crunch Compre | |
[ Revert || Apply |

AssetBundle Mone

1366K7685 {NP%}EEBZ4 bit

papers co-na9%5s- Iake muuntaln sk'r—-

3.0 MB
.

Gambar 6.14 Set Native Size

Berbeda dengan Image component. Jika Image Component mengambil sprite, Raw Image

mengambil teksture (tanpa tepi dsb) Raw Image sebaiknya hanya digunakan jika diperlukan.
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GameObject Component Window Help

7 “m ¥ Raw Image (Script)

. Texture Mone (Texture)

[ Create Empty Ctrl+ Shift+ N

Create Ei Child Alt+Shift+ N Color

reate Em| i -+ Shifts+
| | o dPtY , Bnualr Store Sfceicl None (Materia)

+| scale Qrm—|
N . il Raycast Target I
|| 2D Object >
UV Rect

al Effects > . .

Light » I X B

Audio >

Video > Default UI Material ¥,
I ul > Text [ Shader | UI/Default -

Camera Image

Center On Children

Make Parent
Clear Parent
Apply Changes To Prefab

Break Prefab Instance

Set as first sibling Ctrle=

ibling Ctrl+-

Ctrl+Alt+F

|| Align With View Ctrl+Shift+F
1 Align View to Selected

| | Toggle Active State Alt+Shift+ A

nJ

[

RawImage #

Add Component ]

Butten
Toggle
Slider
Scrollbar

Dropdown
Input Field
Canvas
Panel

Scroll View

Event System

Gambar 6.15 Komponen Menu Ul Raw Image

6.4.4 Button

Mengontrol respon klik dari peng

suatu tindakan.

guna dan digunakan untuk memulai atau mengkonfirmasi

Personal (B4bit) - Untitled - user interface - PC, Mac & Linux Standalone* <DX11> [ o ¥ Button (Script) G %
5 GameObject Component Window Help Interactable 7 3
I Create Empty Ctrl+Shift+N Transition 4
Create Empty Child Alt+Shift+ N £ Asset Store Target Graphic “wButton (Image) @
Z 3D Object > 2| Scale r— Normal Color =
|| 2D Object > Highlighted Color &
’g\ Effects > Pressed Color v
Light 3 Disabled Color =
Audio 3 Color Multiplier (1|
1 Video y Fade Duration 0.1
i Ul > I Text Navigation
Camera Image
Center On Children Ealipaus on Click ()
Make Parent E, List is Empty
Clear Parent Uzzgla
Apply Changes To Prefab Slider
Break Prefab Instance Ealbay
Dropdown
Set as first sibling Ctrl+= Input Field
Set as last sibling Crl+-
Move To View Ctrls Alt+F s
. Align With View Ctrle ShiftF e
1z Align View to Selected Szallifsm
| | Toggle Active State Alt+Shift+ 4 Event System
ald

Gambar 6.1

6 Komponen Menu Ul Button

Button Memiliki beberapa properti yaitu :

a.
b.
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Interactable : menandai apakah komponen tersebut menerima input

Transition : properti yang menentukan bagaimana cara mengontrol respon secara visual pada

aksi yang dilakukan user

Navigation : properti yang menetukan urutan kontrol
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Button (Script
Interactable [

Transition Calar Tint 0

Target Graphic ".BuTe}l‘ [o]
Normal Color j‘f
Highlighted Calor
Pressed Color
Disabled Color
Color Multiplier (Or———— |1 |

Fade Duration '01—|
Navigation c

S % S

On Click ()
List is Empty

Gambar 6.17 Properti Menu Ul Button

6.4.5 Toggle
Kotak centang (checkbox) yang memungkinkan pengguna untuk mengaktifkan atau
menonaktifkan opsi.

YHToggle (Script) (Gl
"~ Interactable ™
Transition | Colar Tint t]
Target Graphic J Background (Image) Q
Normal Color Vi
Highlighted Color f
Pressed Color v
Disabled Color v
Color Multiplier Cr |1 |
Fade Duration |0.1 |
Navigation | Autamnatic i)
1s On i)
Toggle Transition | Fade s
Graphic [TiCheckmark (Image) ]
Group |None (Toggle Group) | o]

On Value Changed (Boolean)
List is Empty

Gambar 6.18 Komponen Menu Ul Button
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6.4.6 Slider

Kontrol Slider memungkinkan pengguna untuk memilih numeric value dari rentang yang
telah ditentukan dengan mendrag mouse. Perhatikan bahwa kontrol ScrollBar yang sama
digunakan untuk scrolling daripada memilih numeric value. Contoh yang dikenal termasuk

pengaturan kesulitan dalam permainan dan pengaturan kecerahan pada editor gambar.

T
v = [V slider (Script) &,
Interactable )
Transition | ColarTint ™
Target Graphic . .Background (Image) | ©

NormaiCoor [
Highlighted Colar I:'/
pressed Color [ 7
Disabled Color [T 2
Color Multiplier s r——— 2

Fade Duration 0.1

Navigation | Automatic ™
[ Visualize ]

Fill Rect “CFill (Rect Transfarm) | ©

Handle Rect None (Rect Transform) | @

Direction | LefiTaRight ™

Min Walue 1]

Max Value 1

Whaole Numbers -

Value —) | 1

On Value Changed (Single)

[ Label @ O] srowsiseres [ ]

g

Gambar 6.19 Properti Menu Ul Slinder

6.4.6 Scrollbar
Scrollbar memungkinkan pengguna untuk scrolling gambar atau tampilan lain yang terlalu
besar untuk dilihat sepenuhnya. Contoh yang dikenal termasuk scrollbar vertikal di sisi teks editor

dan pasangan bar vertikal dan horizontal untuk melihat bagian dari gambar besar atau peta.

| M scrolibar (Script) 2,
Interactable )
Transition | ColorTint ™

Target Graphic 1 .Scroll Bar - Vertical (In @

NormalColor [ | #
Highlighted Caolar I:lf
Pressed Color [N ¥
Disabled Color [ 2
Color Multiplier s r——— 2

Fade Duration 0.1
Navigation | Automatic ™
| Visualize |
Handle Rect - -Handle ]
Direction | BottomToTop ™
Value —— | 1
Size e [0.2

Number Of Steps | )

On Value Changed (Single)
= M | Label (S 0] Showsliderv: [ ]

+ -

Gambar 6.20 Komponen Menu Ul Scollbar
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6.4.7 Dropdown

Dropdown digunakan pengguna untuk memilih satu opsi dari daftar opsi. Kontrol
menunjukkan opsi yang saat ini dipilih. Setelah diklik, ia membuka daftar opsi sehingga opsi baru
dapat dipilih. Setelah memilih opsi baru, daftar opsi ditutup lagi, dan kontrol menunjukkan opsi
yang baru dipilih. Daftar ini juga ditutup jika pengguna mengklik kontrol itu sendiri, atau di mana

pun di dalam Canvas.

[ Option A
[ Option A o } e
v Option A
Option B
Option C

Gambar 6.21 Komponen Menu Ul Dropdown

6.4.8 Input Field
Input Field adalah cara untuk membuat teks menjadi Text Control yang dapat diedit.
Seperti kontrol interaksi lainnya, input field bukan elemen terlihat yang berdiri sendiri namun

harus dikombinasikan dengan elemen lain.

=======

GameObject Compoenent Window Help

Create Empty Ctrl+Shift+N
1 ’ Target Graphic
Create Empty Child Alt+Shift+N N
I 3D Object Highlighted Color
1 X pressed Color
1 2D Object Disabled Color
Effects Color Multiplier
| Fade Duration
| Light
Audio
Video Text Compenent [ Text (Text) |
Text
I ul Character Limit
e Image Content Type
1 Raw Image Line Type
Center On Children Placehold Placehelder (T ©
Make Parent Button Caret Blink Rate == [0.85

Clear Parent o i e :
Apply Changes To Prefab — :S:Tauh‘izl:;m O &
Break Prefab Instance SRl Read only
Dropdown on Value Changed (String)
Set as first sibling Ctrl+= m (Ui i st
Set as last sibling Ctrl+-
Move To View Ctrl+ Alt+F Comes =
1 Align With View Crl+ ShiftsF el
i AlignView to Selected seroll View
| Toggle Active State Alt+Shift+A Event System
o

Gambar 6.22 Komponen Menu Ul Input Field
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Gambar 6.23 Tampilan Input Field

6.4.9 Scroll View

Scoll View dapat digunakan ketika konten yang memakan banyak ruang perlu ditampilkan
di area yang kecil. Scroll view menyediakan fungsionalitas untuk menggulir konten ini.

Eﬂml Rect (Script) o,
Content o Content (Rect Tr, ©
Harizontal ™)
Vertical 4
Maovement Type Blasue 3]
Elasticity 0.1
Inertia ™
— Deceleration Rate  0.135
Scroll Sensitivity 1
Scroll View vew Vemon e T o
[ Horizontal Scrollbar  |_|Scrollbar Horize ©
Visibility | Auta Hide And Expand ¢ |
Spacing -3 |
H Vertical Scrollbar [scrollbar Vertica ©
A SCI'O” Rec'- IS Visibility Auto Hide And Expand
usually used to spacing =
0On Value Changed (Vector2)
scroll a large e
image or panel of
i Lax LS | + =

Gambar 6.24 Komponen Menu Ul Scoll View Dan Komponennya

B. PRAKTIK

Setelah pembaca faham tentang scripting pada Unity 3D dan mengetahui fungsi dan
cariabel pada Scripting. Kali ini kita membahas tentang User Interface pada Unity 3D. Diharapkan
pembaca dapat mengetahui komponen User Interface (Ul), membuat User Interface (Ul) sederhana
daan menginteraksikan antar komponen Ul pada Unity 3D.

142



PERALATAN
1. Komputer

2. Software Unity
3. Koneksi Internet
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LANGKAH LANGKAH PERCOBAAN

Membuat File Script

Menambahkan Ul

1. KIlik menubar “GameObject”

2. Pilih “Ur1”

Menambahkan Ul Image

Ctrl+Shift+N
Alt+Shift+N

*= Hierarchy
Greate | (@Al 3D Object ,
¥ € untitled* 2D Object R
Main Camera
Directional Ligl Effects. >
Canvas Light N
EventSystem i) N
Video 5
0 5| Te
Camera Image
Center On Children Raw Image
Make Parent Button
Clear Parent Toggle
Apply Changes To Prefab Slider
Break Prefab Instance Scrollbar
Dropdown
cr= Input Field
Ctrl+-
Ctrbe Alt+F Gz
e Align With View Ctrl+Shift+F Fenel
i Broiect Align View to Selected Screll View
Creata ™

v |/ Favorites Toggle Active State Alt+Shift+ A Event System

L All Material
©\All Models This folde
©LAll Prefabs

Gambar 6.25 Cara Menambahkan Ul Di Unity

1. KIlik menubar "GameObject"

2. Klik “UI”
3. Pilih “Image”
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i | GameObject nent  Window Help

Create Em Ctrl+Shift+N

Create Empty Child Alt+Shift+N

O 3D Object

s 2D Object

Ig| Effects
Light

I Audio
Video

[ w
Camera
Center On Children Raw Image
Make Parent Button
Clear Parent Toggle
Apply Changes To Prefab Slider
Break Prefab Instance Scrollbar
Dropdown

Set as first sibling Ctrl+= Input Field
Set as last sibling Chrl+-
Move To View Ctrl+ AltsF Eapvas
Align With View Ctrl+Shift+F banel

I Align View to Selected Scroll View

| | Toggle Active State Alt+Shift+ A Event System

ale

Gambar 6.26 Cara Menambahkan Ul Image Di Unity

4. Import gambar, lalu klik gambar tersebut pada kolom assets
5. Ubah tipe gambar pada texture type menjadi sprite (2D and Ul) agar bisa digunakan untuk
image background.

» papers.co-nadS-ake-mountain-sky-cle & &
| Open.

EventSystem Texture Type
¥ Canvas

Image ‘Sprite Mode
Packing Tag
Pixels Per Unit.
Mesh Type
Extrude Edges
Pivot.

» Advanced
Wrap Mode

Filter Mode
Anisa Level —-—1
Outauit e

Max Size 2048 -

.....

vert ABEIY
Only tastures vith videh height baing multiple of 4 can
/\ b comprassed to OXTE farmat

bee76MObMIda  Inputlnteractio

1366x768 (NPOT) RGB 24 bit 3.0 MB
03

Bpapers.co-nad5-lake-mountain-sky-clear-nature-29-wallpaper.ipg

Gambar 6.27 Cara Menambahkan Image Background

6. Klik image pada hierarchy

7. Masukkan gambar tersebut pada source image
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8. Pilih gambar
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yang akan dimasukkan

| Gcoliab - | & [ Account - | Layers - [ Layout _~ |

™ image [staic~v
Tag | Untagged. 3 Layer (UL ™

Main Camera
Directional Light
Eventsystem

@ Project

¥.©  RectTransform
< PosX  PosY  PosZ

3 loooossago |
Width Height
FETLI i —
X05 v[os

xo__vlo zo |
X1 1¥[111250/2 71 ]
G

_©__Canvas Renderer

None (Material)
RaycastTarget
image Type [simple |
Preserve Aspect [
[ Settatvesie
Default Ul Material "L %
» Shader | Ul/Default .

| Greaee -]

¥ | Favorites
LAl Materials
. All Models
(Al prefabs

Assets
: . Add Component
FESE AT -

—
C#

30bdScy bes76f40bf19ds.  Inputinteraction  papers.ca-nads-l.  sovereign-laptop

9. Atur posisi dan scale image

< Uni

& Project

Gambar 6.28 Cara Mengganti Image Background
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Gambar 6.29 Cara Menggatur Posisi Dan Scale Image Image Background

Menambahkan Ul Text

1. Klik menubar “GameObject”

2. Klik “UI”

3. Pilih “Text”
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1 Personal (64bit) - | Intitled - user interface - PC, Mac & Linux Standalone™

GameObject

bonent  Window  Help

Create Empty Ctrl+Shift+MN
Create Empty Child Alt+Shift+MN
|| 3D Object > 4| Scale (r—
- 2D Object ¥
?gl Effects >
Light 3
Audio >
Video >
[ w > Text
2 era Image
-er On Children Eatlimage
Malke Parent Eution
Clear Parent jlcaake
Apply Changes To Prefab SEy
Break Prefab Instance Seellle
Dropdown
Set as first sibling Ctrl+= Input Field
Set as last sibling Ctrl+-
Move To View Ctrl+Alt+F ez
Align With View Ctrl+ Shift+ F P
l Align View to Selected Eerciliieal
|| Toggle Active State Alt+Shift+A Event System
ale

Gambar 6.30 Cara Menambahkan Ul Text Di Unity

4. Atur posisi text pada rect transform

5. Atur text pada inspector text.
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File Edit Assets GameObject Component Window Help
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Gambar 6.31 Cara Menggatur Posisi Dan Scale Image Image Background
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Ul Input Field

1. Klik menubar “GameObject”
2. Klik “Ur”

3. Pilih “Input Field”

‘ersonal (64bit) - Untitled - user interface - PC, Mac & Linux Standalone®

Window Help

Ctrl+Shift+M
| Create Empty Child Alt+Shift+N
3D Object 5
2D Object 5
| Effects 5
| Light N
Audio . ,
Video 2 >
[ w > | Te
Camera Image
Center On Children Raw Image
Make Parent Button
Clear Parent Toggle
Apply Changes To Prefab Slider
Break Prefab Instance Scrollbar
Dropdown

Set as first sibling Chrl+= put Field
Set as last sibling Ctrl+- I—I
Move To View Cirl+ Alt+F Canvas
Align With View Ctrl+ Shift+F Panel

Scroll View

s Align View to Selected
Toggle Active State Alt+Shift+ A Event System

Gambar 6.32 Cara Menambahkan Ul Input Field Di Unity

4. Atur posisi dan ukuran dari input field pada bagian Rect Transform.

i [ static v
Tag [ Untagged o) Layer (Ut
¥.©  Rect Transform "
center PosX  PosY  PosZ

71 Jea6 |0 |
Width _ Height
24385 14637 | [Li]R]

x0s x[os

Inputfield

Material
Raycast Target
Image Type

Fill Center
¥ ¥ Input Field (Script)
Interactable

@ Project

Transition Color Tint

Create * :
‘v | ERRo el Assets Target Graphic [ *InputField (Image) °
(L All Matarials Normal Color V4
(2 All Models - - Highlighted Color 2
(CL Al prefabs Pressed Color P4
Disabled Color 7
Color Multpli —

InputField

Gambar 6.33 Cara Mengatur Posisi Dan Ukuran Ul Input Field Di Unity
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Ul Button

1. Klik menubar “GameObject”
2. Klik “Ur”

3. Pilih “Button”

onent  Window Help
Create E Ctrl+Shift+N
Create Empty Child Alt+Shift+N

3D Object > 3| Scale (—
= 2D Object 5
’gl Effects 5
Light 3
Audio 5
Video 5
'II g > Ter
Camera . Image
Center On Children 2 Raw Image
Make Parent Button
Clear Parent Toggle
Apply Changes To Prefab Slider
Break Prefab Instance Scrollbar
Dropdown
Set as first sibling Ctrl+= Input Fild
Set as last sibling Ctrl+-
Move To View Ctrl+Alt+F Canvas
Align With View Ctrl+Shift+F e
l Align View to Selected Scroll View
| | Toggle Active State Alt+Shift+A Event System

ale
Gambar 6.34 Cara Menambahkan Ul Button Di Unity

4. Ubah ukuran dan posisi button pada inspector

imeObject Component Window Help

© tnspector

center

i I:
» Anchars
Pivot

Rotation
Scale

W ¥ Eaen 5
Tag (Unssaged . Layer U

Raycast Target
image Type
Fil Center

(script)
[EUisprite 5

;um Wisterial)
2

| ¥ o« ¥ Button (Script)
o

Interactable

Transition
Target Graphic

k.

Color Tt
®Button (Image)

Highlighted Color
Pressed Color
Disabled Color.
Color Multiplier

—

Gambar 6.35 Cara Mengatur Posisi Dan Ukuran Ul Button Di Unity
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5. Pada hierarchy klik pada Text (child di button)

i= Hierarchy
| Create "l (o All ),
¥ € Untitled* =
Main Camera
Directional Light
EventSystem
¥ Canvas
Image
Text

b InputField
¥ Button

Gambar 6.36 Hierarchy

6. Ketik “input” pada properties text bagian inspector

© Inspector

Pivot x[os Jrfos ] E
Rotation X0 v o lzlo |
Scale X1 Y1 Z|1
#*
ey

Character
Font | Arial ]
Font Style | Mormal t]
Font Size ‘20 |
Line Spacing 1 |
Rich Text I~

Paragraph

Alignment

Align By Geometr|[_|

Horizontal Overflo| Wrap ol

Vertical Overflow | Truncate i)
Best Fit -

Color —

Material None (Material) @
Raycast Target ¥

Default UI Material 2%,

» Shader | UI/Default -

Add Component ]

Default UI Material *

Gambar 6.37 Properties Text Pada Inspector

7. Ubah warna button pada bagian komponen button script
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¥ ok [ Button (Script) ) %,
Interactable [
Transition | calor Tint al

get Graphic " Button (Image) !
| Normal Color

il
Highlighted Colar Vi
Pressed Color f
Disabled Color f

Color Multiplier |1
Fade Duration 0.1 |

MNavigation | Automatic a
[ Visualize ]
on Click ()
List is Empty
+ =

Gambar 6.38 Komponen Button Script

Interaksi Antara Input Field Dan Button
1. Buat file script dengan cara :

a. Kilik pada panel project

b. pilih create

C. c# script

Folder © Inspector
G Scrpt & 2 - Assets
Main Camera Shader
Directional Light
EventSystem
¥ Canvas ! Floyables
Image & Assembly Definition
Text
¥ InputField
¥ Button
Text

Testing

Scene
Prefab

Audio Mixer

Shy Exple
oW EXpIOree Material

Open
Delete

Lens Flare
Render Texture

Open Scene Additive Lightmap Parameters

Custom Render Texture

Import New Asset...
Import Package > Sprite Atlas

Export Package... Sprites >
Find References In Scene Tile

@ Project

Select Dependencies
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Animator Controller

¥ [ /Favorites | Assets Refresh Ctrl+R Animation
©L All Material Reimport Animator Override Controller
©L All Models
©Lall prefabs Reimport All Avatar Mask
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Run API Updater... Physic Material
30bd5e) bee76f40bf13da.. . Physics Material 2D
Open C# Project
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L L3
egacy >
&5 Assets
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Gambar 6.39 Cara Menambahkan Script

2. Ubah nama file
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“1 1
J-L (| I__.-—\- :-“ |
i S Wi
MewBehaviourScr.. | InputInteraction
Gambar 6.40 Mengubah Nama File
3. Pastikan class yang tertulis pada script merupakan nama file
4. Double click pada file Inputinteraction
5. Tuliskan tipe data sesuai gambar di bawah ini
No selection
. 1 using UnityEngine;
i1sing System.Collections;
3 using UnityEngine.UI;
public class|Inputinteraction |: MonoBehaviour {
public InputField EnterText;
public Text ShowEnterText;

|
public void OnClick(){

ShowEnterText.text = EnterText.text;

Sumber Kode 31 Script Interaksi Input Field Dengan Button

6. Masukkan script Inputinteraction ke dalam Game Object option
7. Pada Inputinteraction script ubahlah :

Enter Text : InputField (InputField)

Show EnterText : Text (Text)
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Fil t ts  GameObje dow Help
& o= > M & Collab - [ & | Account - | ayers - | Layout _~
= Hierarchy © Inspector
Craate - | @A a % |4 |- Gizmos - o Image Type ‘|
v € untitled* Assets Scene Fill Center ] 1
~ Main Camera None < ——
Directional Light @ Placeholder . TSN (e CE
EventSystem WText e :
¥ Canvas  Text Transition Color Tint. + \
it Target Graphic  aButton (Image) | ©
Text Normal Color [ 2
» InputField Highlighted Color 2|
o New Text e | Pressed Color il
Text ; Disabled Color 2|
Color Multplier 1

Fade Duration (0.1
Navigation
on Click ()

= List is Empt
Text |
cs t + —

S Uijans
¥ G Input Interaction (Scri o
= So ©
\.c:::.-ﬂ - (a8 % | cmerTet Inputrield (Inputrield) | ©
¥ Favorites | Assets - Show Enter Text | Text (Text) o
%::: :rlrliil Default UI Materi. “,
Clan PM:;I [ % > Shader [ULDefault .
R ’ C#| re——
: v

bea76f40bf19da.  Inputnteraction  papers.co-nasS-l.  sovareign-laptop

Gambar 6.41 Input Interaksi Script Antara Button Dengan Input Field

8. Jalankan scene yang aktif dengan mengklik play button

> | 11|

Gambar 6.42 Play Button

9. Ketikkan sesuatu pada input Field
10. Klik Input Button

New Text

Gambar 6.43 Cara Interaksi Button Dengan Input Field
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Gambar 6.44 Tampilan Gabungan Beberapa Ul Meliputi Text, Input Field Dan Image

C. KESIMPULAN

User interface berfungsi untuk menghubungkan pengguna dan aplikasi agar bisa
berkomunikasi dengan mudah, dimana terdapat input dari pengguna dan output dari aplikasi.

D. SOAL

1. Media yang mengandung pesan dalam bentuk auditif (hanya dapat didengar) yang dapat
merangsang pikiran, perasaan, perhatian, dan kemauan anak untuk mempelajari isi tema adalah

a. Media Image b. Media Audio c. Media Cetal d. Media Visual
2. Format file audio yang support pada unity, kecuali...
a. AlIFF b. WAV c. Ogg d. AVI

3. Jenis Metode Kompresi (Berdasar mode penerimaan data yang diterima manusia) yang
merupakan proses penerimaan data tidak dilakukan secara real time disebut ...
a. Manual Mode b. Auto Mode c. Dialogque Mode d. Retrieval Mode

4. Jenis Metode Kompresi (Kompresi Data Berdasarkan Output) yang merupakan Teknik
kompresi dimana data hasil kompresi dapat didekompres lagi dan hasilnya tepat sama seperti
data sebelum proses kompresi. contoh aplikasi: ZIP, RAR, GZIP dan 7-Zip disebut ...
a. Loseless Compression
b. Lossy Compression
c. Opto Compressor
d. Tube Compressor

5. Format file audio yang dikembangkan oleh Microsoft dan IBM sebagi standar untuk
menyimpan file audio pada PC disebut ...
a. AIFF b. WAV c. Ogg d. AVI

6. Format file audio standar yang digunakan untuk menyimpan data suara untuk PC dan
perangkat audio elektronik lainnya, yang dikembangkan oleh Apple pada tahunv1988 disebut
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a. AIFF b. WAV c. ACC d. Ogg
7. Format audio yang Maximum Simple Rate nya 48 kilohertz, kecuali ...

a. Mp3 b. Ogg c. ACC d. WAV
8. Format audio AIFF Maximum Simple Rate nya adalah ...

a. 48 Khz b. 96 Khz c. 192 Khz d. 196 Khz
9. Format audio WAF Maximum Simple Rate nya adalah ...

a. 48 Khz b. 96 Khz c. 192 Khz d. 196 Khz

10. Cara menambahkan audio source pada component adalah ...
a. Pilih object > Add Componen > audio source
b. Pilih object > Transform > audio source
c. Pilih object > Add Componen > Play on awake
d. Pilih object > Transform > audio source
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BAB 7
AUDIO

TUJUAN

1. Pembaca dapat mengetahui langkah dalam memasukkan Audio dalam project Unity 3D.
2. Pembaca dapat memberi efek ruang dalam project Unity 3D.

3. Pembaca dapat memperkuat emosi cerita dan karakter dalam project yang dibuat.

A. DASAR TEORI
7.1  Pengertian Audio

Sebuah permainan tidak akan lengkap tanpa beberapa jenis audio, baik itu musik latar
belakang atau efek suara. Unity Dapat mengimpor sebagian besar format file audio standar dan
memiliki fitur untuk memutar suara dalam ruang 3D. Audio sendiri digunakan sebagai media
pendukung selama bermain game.

Media Audio (media dengar) adalah media yang isi pesannya hanya diterima melalui
indera pendengaran. Dengan kata lain, media audio berkaitan dengan indera pendengaran. Pesan
yang disampaikan melalui media audio berupa lambang-lambang auditif baik verbal maupun non
verbal.Pesan atau informasi yang disampaikan dituangkan ke dalam lambang-lambang auditif
yang berupa kata-kata, musik, dan sound effect.Media audio diartikan sebagai media yang
mengandung pesan dalam bentuk auditif (hanya dapat didengar) yang dapat merangsang pikiran,

perasaan, perhatian, dan kemauan anak untuk mempelajari isi tema.

)

Gambar 7. 1 Simbol Audio
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Media Audio menurut Sadiman (2005:49) adalah media untuk menyampaikan pesan yang
akan disampaikan dalam bentuk lambing-lambang auditif, baik verbal ( ke dalam kata-kata atau
Bahasa lisan ) maupun non verbal. Sedangkan menurut Sudjana dan Rivai (2003:129) Media
Audio untuk pengajaran adalah bahan yang mengandung pesan dalam bentuk auditif ( pita suara
atau piringan suara ), yang dapat merangsang pikiran, perasaan, perhatian dan kemauan siswa

sehingga terjadi proses belajar-mengajar.

7.2 Sejarah Audio

Pada tahun 1844 Morse mengirim berita lewat kawat dari Baltimore ke Washington, maka
dikenallah teknologi yang dinamakan telegrafi. Dari temuan tersebut, Alexander Graham Bell
kemudian berpikir bahwa tidak hanya bunyi saja yang dapat disalurkan melalui kawat, suara pun

juga bisa.

Gambar 7.2 Alexander Graham Bell

Pada tahun 1875, Alexander Graham Bell melakukan percakapan lewat telepon sebagai
temuan baru di bidang komunikasi suara.Beberapa tahun kemudian, yaitu pada tahun 1895
ditemukanlah radio oleh Marconi.Temuan tersebut menjadi temuan yang paling akrab dan dikenal

masyarakat.
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Sebelum ditemukannya alat komunikasi lain, hampir semua informasi disampaikan dari
generasi ke generasi melalui media audio (pendengaran). Banyak orang menghabiskan waktu

untuk mendengarkan informasi melalui radio.

Gambar 7.3 Radio Awal Di Temukan

Setelah ditemukannya radio, kemudian mulai ditemukannya alat perekam suara oleh
Thomas Alfa Edison yaitu dikenal dengan phonograph.Melalui alat phonograph ini, orang dapat
melakukan perekaman suara dengan menggunakan piringan hitam.Temuan ini kemudian
berkembang seiring dengan perkembangan zaman yaitu orang mulai merekam dengan
menggunakan cassette tape recorder. Di masa sekarang, peran kaset juga telah digantikan dengan

perangkat baru yang bersifat digital seperti Compact Disc (CD), Flashdisc, dan sebagainya.

Gambar 7.4 Compact Disc Dan Flashdisc
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Antar muka interaktif berbasis text pertama dikembangkan sejak tahun 1960-an yang
memungkinkan pengguna secara langsung berinteraksi dengan komputer-komputer tersebut,
setiap perintah yang diketikkan oleh pengguna akan langsung dieksekusi oleh sistem, pengguna
juga dapat memanfaatkan fasilitas interaktif tersebut untuk menulis instruksi-instruksi dalam satu

berkas yang dapat dieksekusi oleh sistem sebagai proses batch.

Gambar 7.5 Komputer Tahun 1960

7.3 Audio Pada Unity

Sebagai contoh Unity membutuhkan suara yang berasal dari Sumber Audio yang melekat
pada objek. Suara yang dipancarkan kemudian diambil oleh Audio Listener yang melekat pada
objek lain. Suara yang dapat di dengar juga dapat digunakan untuk mensimulasikan Efek benturan

untuk menambahkan realisme.

AUDIO

R

Gambar 7.6 Logo Audio
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7.4  Format Audio
Format file audio yang support pada unity yaitu format AIFF, WAV, MP3,AAC dan

Oggo.

Gambar 7.7 Logo Format File Audio Yang Support Unity

Jenis Metode Kompresi (Berdasar mode penerimaan data yang diterima manusia) :

a. Dialoque Mode: yaitu proses penerimaan data dimana pengirim dan penerima seakan berdialog
(real time), seperti pada contoh video conference. Dimana kompresi data harus berada dalam
batas penglihatan dan pendengaran manusia. Waktu tunda (delay) tidak boleh lebih dari 150
ms, dimana 50 ms untuk proses kompresi dan dekompresi, 100 ms mentransmisikan data dalam
jaringan

b. Retrieval Mode: yaitu proses penerimaan data tidak dilakukan secara real time. Dapat
dilakukan fast forward dan fast rewind di client.

Jenis Metode Kompresi (Kompresi Data Berdasarkan Output ) :

a. Lossy Compression : Teknik kompresi dimana data hasil dekompresi tidak sama dengan data
sebelum kompresi namun sudah “cukup” untuk digunakan. Contoh: Mp3, streaming media,
JPEG, MPEG, dan WMA.. Kelebihannya ukuran file lebih kecil dibanding loseless namun

masih tetap memenuhi syarat untuk digunakan.
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b. Loseless Compression : Teknik kompresi dimana data hasil kompresi dapat didekompres
lagi dan hasilnya tepat sama seperti data sebelum proses kompresi. Contoh aplikasi: ZIP,
RAR, GZIP, 7-Zip.

Original Lena Image Lena mage, Lena Image. Highly

(1ZKB size} Compressed [{H% Compressed {86%
less information, less information,
1.0K0) 0.56KB)

Gambar 7.8 Contoh Lossy Compression

74.1 MP3

Pada awalnya format MP3 ini dikembangkan oleh seseorang yang berasal dari Jerman yang
bernama Karlheinz Brandenburg dan memakai pengodean PCM (Pulse Code Modulation). Prinsip
yang dipergunakan oleh MP3 adalah mengurangi jumlah bit yang diperlukan dengan
menggunakan model psychoacoustic untuk menghilangkan komponen-komponen suara yang tidak
terdengar oleh manusia, sehingga dapat digolongkan file audio dengan kompresi lossy. Pada tahun
1991, file MP3 distandarisasi pada tahun 1994 hingga akhir tahun 2000. Popularitas dari MP3
semakin meningkat dengan semakin mudahnya akses Internet. Munculnya software untuk
menjalankan file MP3 seperi Winamp di tahun 1997 yang dikembangkan oleh Nullsoft, dan player
console untuk Linux, juga membuat file MP3 semakin digemari

MP3

Gambar 7.9 Logo MP3
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742 WAV

WAV merupakan format file audio yang dikembangkan oleh Microsoft dan IBM sebagi
standar untuk menyimpan file audio pada PC, dengan menggunakan coding PCM (Pulse Code
Modulation). Tidak seperti AAV, file WAV adalah file audio yang tidak terkompres sehingga
seluruh sample audio disimpan semuanya di media penyimpanan dalam bentuk digital. Karena
ukurannya yang besar, file WAV jarang digunakan sebagai file audio di Internet. Ekstensi nama

file: .wav atau .wv

Gambar 7.10 Logo WAV

743 AIFF

File AIFF merupakan format file audio standar yang digunakan untuk menyimpan data
suaravuntuk PC dan perangkat audio elektronik lainnya, yang dikembangkan oleh Apple pada
tahunv1988. standar daru file AIFF adalah uncomressed Pulse Code Modulation (PCM adalah
teknik memproses signal analog menjadi signal digital melalui kode-kode pulsa), namun ada juga
varian terkompresi yang dikenal sebagi AIFF-C dengan berbagai kompresi codec. Ekstensi nama

file: .aiff, .aif, .aifc

AlFF

Gambar 7.11 Logo AIFF
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744 0OGG

Ogg adalah format pemuat berkas video dan audio standar terbuka bebas oleh Xiph.Org
Foundation. Para pencipta format Ogg mengaku bahwa format ini tidak dibatasi oleh paten
perangkat lunak dan dirancang untuk menyediakan streaming dan manipulasi yang efisien

terhadap multimedia digital bermutu tinggi.

Gambar 7.12 Logo OGG

745 AAC

AAC merupakan format audio yang menggunakan lossy compression (data hasil kompresi
tidak bisa dikembalikan lagi ke data sebelum dikompres secara sempurna, karena ada data yang
hilang) [6]. Kepopuleran format AAC dikarenakan audio codec-nya yang menyempurnakan MP3.
Seperti pada jangkauan samplerate yang lebih banyak (8 Hz — 96 kHz), memiliki 48 channel dan
suara yang lebih bagus untuk bit yang lebih rendah (dibawah 16 Hz). Portabel player untuk format
file AAC adalah Archos, SanDisk Sansa, Sony PlayStation Portabel (PSP), Sony Walkman.

Nintendo DSi dan Cowon.

AAC

Gambar 7.13 Logo AAC
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75 Perbedaan Format Audio

MP3 AAC OGG WAV AlFF

» Format audio » Format audio yang [*Alternatif format |+ Format t Format
lossy yang memiliki audio MP3 dan audio audio yang
paling banyak karakteristik mirip [ AAC, berlisensi yang support
digunakan. dengan MP3 tidak berbayar support dengan Mac

» Format audio namun sedikit lebih | (gratis) dan open dengan OS X
yang paling efisien dalam hal source. windows

banyak ukuran file (file
didukung oleh size).

semua audio

player

Tabel 5 Perbedaan Format Audio

7.5.1 Perbedaan format audio berdasarkan sample ratenya

MP3, AAC dan OGG WAV AlFF
48 kHz/ 96 kHz/ 192 kHz/24kbps
320kbps 24kbps

Gambar 7.14 Perbedaan Format Audio Berdasarkan Sample Ratenya

B. PRAKTIK

Setelah pembaca dapat membuat User Interface sederhana. Kali ini kita membahas tentang
Audio pada Unity 3D. Diharapkan pembaca dapat mengetahui langkah dalam memasukkan Audio,

memberi efek dapat memperkuat emosi cerita dan karakter dalam project Unity 3D.
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Kita menyediakan asset gratis buat pembaca untuk belajar. Bisa di download di

https://intip.in/soundeffect dan https://intip.in/Asset.

PERALATAN

1. Komputer

2. Software Unity

3. Koneksi Internet

4. Asset Audio (https://intip.in/soundeffect dan https://intip.in/Asset)

LANGKAH LANGKAH PERCOBAAN
Download Audio

1. Download Audio pada link berikut ini : https://intip.in/soundeffect

Google Drive Q  Telusuri Drive - PR ) 3
BARU Drive Saya > Sound Effect ~ ® 4 O § o =
¥ g Drive Saya Nama Pemilik Terakhir diubah Ukuran file
» [0 Komputer | o Sound Effect Boom.wav % saya 13.15 saya 574KB ]
&%  Dibagikan dengan saya
® Terbaru

Y Berbintang

Gambar 7.15 Tampilan Link Download

Import Audio

L All Madels
(CLAllprefabs

BT e

Gambar 7.16 Cara Mengimport 3D Object Plane
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. Klik pada Hierarchy
Klik “3D object”
Pilih Plane

Pilih Plane lalu klik
. Klik “3D object”

. Pilih Cube

< Unity 2017.3,11 Personal (84bit) - Untitled - Audio kelompok 7 - PC, Mac & Linux Standalone® <D11> - X
File Edit Assets GameObject Component Window Help

o g A W N P

# Scene
| Craante »| (GAT Shaded E Gizmos *| (v AT
v € untitled*

b4
|
Rotaon X0 Yo 20 |
x

Scale

Persp

Copy ¥ .. Plane (Mesh Filter)

Mesh
v . ¥Mesh Collider

Rename Convex (m]

Is Trigger
Cooking Optians
Material
Mesh

¥ . #Mesh Renderer

¥ Lighting

= Light Probes

Paste

[u]
None (Physic Materie,

Duplicate
Delete

Select Prefab

Create Empty
3D Object.

20 Object Sphere Reflection Probes
Effects Capsule e °
Lgnt Cylinder Cast shadoms

7 17 Favorites
@) All Materi Aits
(©1 Al Models Video
(© All Prefab u

Receive Shadows (¥

Plane
Hotion Vectors

This folder is empty
Quad Lightmap Static [

Ragdoll. To enabl
o enable gensration of lightmaps for
- . . (D) his Mexh Randaper, laazs aneble e
amera errain “Lightmap Static' praperty.
Tree ¥ Materials

‘Wind Zone Dynamic Occluded (¥
30 Text Default-Material 4
» Shader [ Standard B

Add Component

Gambar 7.17 Cara Mengimport 3D Object Cube

7. Drag audio yang sudah di download, masukkan ke asset.

Q Unity 2017.3.1f1 Personal (64bit) - Untitled - Audio kelompok 7 - PC, Mac & Linux Standalone™ <DX11> - X
File Edit Assets GemeObject Compenent Window Help

= Hierarchy # Scene
| Greate - | (AT Shaded = Gizmos - | (o ATl
v € untitled*

Directional Light
¥ Plane
Cube.

@ Project
| createsr]
¥ Favorites Assets
©\ All Materials

©1 All Models
(@) All Prefabs
| = Ascets |

Gambar 7.18 Mengimport Asset Audio Ke Unity
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Menambahkan Component Pada Audio Source
1. Klik “Plane”

2. Pada inspector pilih “add component”

3. Search “audio source”
4

Klik “audio source”

v~ Transform
Position X0 |
Rotation

Vi Plane (Mesh Filter)
Wesh

¥ i ¥ Mesh Collider
Convex L]

15 Trigger

Cooking Option:

Material

h e TP —
[Caudi] 9w

Search

iV’ Audia Chorus Filter
{lvAudio Distortion Filter
| create Al Audio Echo Filter
7 Favorites |7 Audio High Pass Filter

©) All Materials (@audio Listener
©\ All Models 7 Audio Low Pass Filter
LAl Prefabs o Reverb Filter 4

| New Seript

& Project

Add Component:

Gambar 7.19 Menambahkan Komponen Audio Source

5. Pada Audio Clip masukkan audio yang ada dalam Asset (bisa dengan cara drag audio pada
Asset kedalam Audio Clip.
6. Centang Loop pada Audio Source

& Unity 2017.2.1f1 Personal (64bit) - Uy

udio kelompok 7 - PC, Mac & Linux Standalone® <DX11> - x

¥ Materials
Dynamic Occluded ¥

| v | AudioSource |
‘AudioClip "~ Sound Effect Boon ©
Output
Mute
Bypass Effects o

Bypass Listener Effe (]
B o

None (Audio Mixer G| ©

Volume
pitch
@ Project
T
¥/ Favorites Assets
All Materials
O All Models
{©) Al Prefabs

Stereo Pan

¥ 3D Sound Settings

Doppler Level (e
Spread |

Volume Rolloff [ Loga lofl &

Min Distance

Gambar 7.20 Menambahkan Komponen Audio Source
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Menambahkan C# Script
1. KIlik pada Asset

2. Kilik “Create “

3. Pilih C# Script

€0 Unity 2017.3.1f1 Personal (64bit) - Untitled - Audio kelormpok 7 - PC, Mac & Linux Standalone* <DX11>
File Edit Assets GameObject Component Window Help

1 + EIEAENS]
= Hierarchy

[ Crass =| (AT
v Quntitled* =

Main Camera Sheder
Directional Light Testing
¥ Plane
= Show in Explorer Playables
Open 2 Assembly Definition
Delete
Scene

Open Scene Additive Prefab

Import New Asset.

Import Package 5 Audio Mixer |
Export Package. Material
Find References In Scene Lens Flare
Select Dependencies. Render Texture
Lightmap Parameters

[0 CELE Custom Render Texture:
Reimport
Sprite Atlas
@ Project Reimport All Spites N
ool T
¥ {/Favorites Assets
CLall Materials Run AP| Updater... Animator Controller
©1 Al Models i
(©. all Prefabs Open C# Project ST

Animator Override Controller

Avatar Mask

Sound Effec.
1 Timeline
Physic Materal

Physics Material 2D

GUI Skin
Ganssets Custom Font

Legacy >

UlElements View

Gambar 7.21 Menambahkan File C# Script

4. Rename pada C#
5. Ubah nama nya menjadi PlayAudio

~

(# C#

MewBehawi.. FlayAudia

Gambar 7.22 Mengubah Nama File

6. Tambahkan Script seperti pada dibawah ini.

using System.C
using System.C
using UnityEagin

neric:

Elpublic class Playludic : MencBeh

pdate 13 called onee per frame

Bl 1 Update () {

void OnCollisienEnte
if (other.gameb
Debug.Log ( )
AudioSource audic = GetComponent<AudicSources () :
sudic. Blay()

Lision other) |

)
I )
]

Sumber Kode 32 Script Audio

' Inspector

- Assets

AssetLabels

AssetBundle  [Wane

12:46

) ENG B

28/04/2018 V2
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Menambahkan component pada Rigidbody
1. Klik “Cube”

2. Klik “ Add Component”’pada Inspector
3. Kemudian klik “RigidBody”

<

dow  Help

Lo K3 |4 Center | @Local |
Scene

¥ ¥ Box Collider
Edit Collider

1= Trigger: W]

Material [None [‘ﬁju; E‘IHJJ e

Gambar 7.23 Menambahkan Komponen Rigibody Pada Object Cube

4. Selanjutnya penampakan RigidBody akan tampak seperti gambar dibawabh ini

RigidBody mempunyai peran untuk menambahkan gravitasi.

< Unity 2017.3,1f1 Personal (64bit) - bab7 kita.unity - Audic kelompok 7 - PC, Mac & Linux Standalone <DX11>

o vfp Tz ]
Size
ol | 3 S S—

bab7kita  PlayAudic  Sound Effec

Gambar 7.24 Hasil Dari Rigibody Objek Akan Jatuh
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Uncheck Play on awake
1. Kembali ke inspector pada plane

2. Uncheck Play on awake pada Audio Source

& Unity 2017.3.1F1 Personal (64bit) - Untitled - Audio kelompek 7 - PC, Mac & Linux Standalone* <DX11> - X
File Edit Assets

.......

Spatial Blend
Reverb Zone Mix

¥ 3D Sound Settings
Doppler Level (e 1
Spread
Volume Rolloff
Vin Distance

Gambar 7.25 Uncheck Play On Awake Pada Audio Source

3. Selanjutnya buka GamePlay dan jalankan Project anda. maka suara akan terdengar ketika

Cube terjatuh.

Q unity 20173111 - bab7 kita.unity - ~ PC, Mac &Li > =] X

Gambar 7. 26 Hasil Object Cube Bisa Jatuh Dan Keluar Audio Akibat Benturan Dengan Object Plane
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Procedural Audio
1. Download Asset pada link berikut ini : https://intip.in/Asset

_Audic _Materials _Mesh _Prefabs _Scripts

Gambar 7.27 Asset Yang Terdapat Pada Link

2. Drag semua folder ke dalam project
3. Buka folder _scripts

€ Unity 2017.3.1f1 Personal (B4bi

SERVICES

Ads

Monetize your games
Analytics

Discover player insights
Cloud Build

3 Build games faster
Sciipts

Collaborate

Create together seamlessly
Performance

Gambar 7.28 Tampilan Impoer Asset Pada Unity

4. KIlik pada project
5. Lalu pilih create
6. Kilik C# script
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< Unity 20173.11 Personal (64bit) - audioo3.unity - audio3 - PC, Mac & Linux Standalone <DX11>
File Edit Asset €Object Component Window Help

M + FEE S

= Hierarchy 4 Scene Folder © Inspector
Shaded ~[[20] 3 | <) Gizmos ~| (@Al St

Rz T N— E—

Main Camera Shader
Directional Light: Ty
Audiopeer Show in Explorer

instantiateCubes

Playables
Assembly Definition

Open
Delete

Scene

Open Scene Additive:

Prefab
Import New Asset
& Audio Mixer
Import Package >
Export Package. Material
Find References In Scene Lens Flare
Select Dependencies Render Texture
Lightrmap Parameters
Refresh cuier S
Custom Render Texture
Reimport
Sprte Atlas
Reimport All
sprtes >
Btract From Prefab ey
v 1 Favorites
Al Material Run AP Updater.. Animator Controller
Al Model
Qo rosee EmETTm pu—
Animator Override Controller
s et Avatar Mask
S rudio instantizee
haterials imeline
= L Timel
Physic Material
Physics Material 2D —
6U1 Skin
Custom Font AssetBundle
Legacy >

UlElements View

Gambar 7. 29 Menambahkan Script

7. Rename file C# script menjadi “AudioPeer”

|
o
x

€ Unity

File Edit

1 Personal (64bit) - Untitled - audio3 - PC, Mac & Linux Standalone* <DX11>

GameObject Component Window Help
& Local @collab - | [ & | [Account - Layout -

“i= Hierarchy © Inspector

4 [ static

v € untitled* = -
IMEF = Laer
Directional Light ¥~ Transform @ #
Audio Source Positon %[0 |yo  lzo |
Rotation X010 |20
Scale
¥ ] ¥ Audio Source

AudioClip None (Audio Clip) | ©
Output None (Audio Mixer G
0

Mute
Bypass Effects -
Bypass Listener Effe (]
Bypass Reverb Zone[ |

Play On Awake "4
Loop (]
Priority T
Volume —C)

& Project pitch ——

| create 7| 1

¥ 7Favorites  Asscts » _Scripts Stereo Pan T L__J

All Material Spatial Blend
(©) All Models ) 3D

(© Al Prefabs C'”' Reverb Zone Mix s (1

i
¥ & Assets 3D Sound Settings
Audia AudioPear
Materials Add Component ]
> & _Mesh

&l _Prefabs

Gambar 7.30 Mengganti Nama File

8. Buka file C# script
9. Tambahkan Script seperti gambar disamping
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AudioPeer.cs — aud ripts AudioPeer.cs — audi

m.Collect
em.Collectio Generic;
UnityEngine;

[RequireComponent (
AudioPeer :

ource _Aud

t[] _samples =

ree = GetComponent <AudioS

te () {

spectrumAud

2, FFTWindow.Blackman);

Sumber Kode 33 AudioPeer Script

10. Klik pada hierarchy
11. Pilih audio
12. Lalu klik Audio Source

Q) Unity 2017.3.11 Personal (84bit) - sudioo3.unity - sudio3 - PC, Mac & Linux Standalone <DX11>

File Edit Assets GameObject Component Window Help

(O KA S o | S = center | Stocat D> [ 11> e | e e
& =) #Scene | € Game £ Asset Store .= ©Inspector | Services o=

|| shaded RIEDIEAEI]

- X

= Hierarchy |
e AT

Directional Light
AudicPeer
instantiate Cubes

Copy

Paste

Rename

Duplicate

Delete

Select Prefab

Create Empty

30 Object
TRk

-
T [a]%]*

Create Effects

>
B
>
viiFa 5 bts
&) Light J:
Q > Audio Source 1 2
Q. 5
>

Camera

&
» & _Mesh
(5 _Prefabs

= scripts |

M) sscts/_Scripts/instantiateS12Zcubes cs(26,59): error CS0103: The name ' AudioP eer’ does not exist in the current context

Gambar 7.31 Menambahkan Audio Source

13. Rename audio source menjadi “AudioPeer”
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€ Unity 2017.3.111 Personal (54bit) - Untitled - audio3 - PC, Mac & Linux Standalone” <DX11> = B i
File Edit Assets GameObject Component Window Help

Bypass Listener Effe | |

Bypass Reverb Zone |

Play On Awake W

Loop a
Priority ]
Volume. —_—r ]
‘vi}ém Assets - _Scripts Stxine Pais o o

All Maters
S w‘.'l"“Q . ‘Spatial 8lend Ge—0__]
= All Prefabs o Reverb Zone Mix = T |
i
viAssors L_ ¥ 3D Sound Settings
- _Audio AvdigPeer ¥ | o Audio Peer (Script) e,
- _Materials Seript AudioPeer ‘o
» i _Mesh

Gambar 7.32 Merubah Nama Object Audio Source Menjadi AudioPeer

14. Pada Hierarchy Klik AudioPeer
15. Lali pada inspector Klik pada add component
16. Lalu isi dengan tulisan audio

17. Maka muncul audio peer dan klik

Echo Filter
udio High Pass Filter
il 1 7
< Audio Lo 'ass Filter
:

CRCIC I

] Audio Source
@ Audio Spatializer Microsoft
New Script

IE] A
B

Add Component

Gambar 7.33 Menambahkan Komponen AudioPeer

18. klik pada project
19. Pilih create
20. Lalu klik pada C# script
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& Unity 2017.3.11 Personal (64bi) - aud - audio3 - PC, Mac & L 1> - X
File Edit Assets GameObject Component Window Help

K + EIAce]

>
## Scene Folder
Shaded MIECHESE Gizmos | (@ All
L ey [ Gsew ] e ——

© Inspector

- _Scripts

= Hierarchy

V@iudinns C# Script

Audiopeer Show in Explorer

Playables
Assembly Definition

instantiateCubes Open

Delete

Scene
Open Scene Additive

Prefab
Import New Asset.
Audio Mixer
Import Package
Export Package. Material
Find References In Scene Lens Flare
Render Tevture

Select Dependencies
Lightmap Parameters

Refresh CuleR
Custorn Render Texture
Reimport
Sprite Atlas
Reimport All &
“merojer |0 Consele | Spries >
Crasts - Extract From Prefab Tile
¥ {/Favorites | Assefs . Script:
O\ all Material Run APT Upaater.. “Animator Controller
©LAll Models
en C# Proje Animation
(©) all prefabs| Cr @G
Animator Override Controller
v & Assets Avatar Mask
& _Audio
& _Materials Timeline
> & _Mesh
& Prefabs Physic Material
= seripts
_Scrip Physics Material 20 AssctLabels
GUI Skin
Custom Font AssetBundle (1TG7E
Legacy >

UlElements View

Gambar 7.34 Menambahkan File C# Script

21. Rename nama C# script menjadi “instantiateS12cubes”

€0 Unity 2017.3.1f1 Personal (64bit) - Untitled - audio3 - PC, Mac & Linux Standalone® <DX11> - X
Object Component Window Help

= Hierarchy 4 Scene
Shaded

v & untitled*
Wiain Camera

Directional Light
Audiopeer

& Project
|Crastas]
¥ [ /Favorites | Assets - _Scripts
(O Al Material
(©) Al Models
(©L Al Prefabs

sets
_Audio
Materials

Gambar 7.35 Mengubah Nama File C# Script

22. Klik pada GameObiject
23. Lalu klik Create Empty
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< Unigeaizatet Personal (64bit) - audioz.unity - audio2 - PC, Mac & Linux Standalone <DX11> - X
File s [Gameobject Jcomponent Window Help
o] 22' Create Empty Culssniten_| m—— r— m——
Create Empty C! ‘Al Shifte
(oAl 3D Object 3 |- D

>
v 02 2D Object >
Main Camera
parametric-cul  Erfects ’
Directional Ligl ~ Light B
il Audio B
Video >
o N ource
c [ Happy MusicFunn ©

output
Mute ]

Bypass Effects o

Bypass Listener Effe ]

Bypass Reverb Zone |

Play On Awake
Loop

Center On Children
Make Parent

Clear Parent

Apply Changes To Prefab
Break Prefab Instance:
Priority

Volume

Move Te View Ctri+Alt+F
‘Align With Vi Ctrl+Shift+F
¥ Favorites fon With View eshitef |

©LAll Material: Align View to Selected
LAl Mod Toggle Active State Alts Shift-A -
(O, All prefabs

pitch
Stereo Pan —_— ]
Spatial Blend H o
Reverb Zane Mix  ———m[1 |

» 3D Sound Settings

_Audio  _Materisls _Mesh _Prefabs +[6) @ Audio Peer (Seript) 5
Seript. © AudioPeer °

& _Prefabs
& _scripts

Add Component.

Gambar 7.36 Mengosongkan GameObject

24. Rename GameObject menjadi “instantiateCubes”

25. Lihat pada inspector dan pastikan nilai position “0”

Q Unity 2017.2.1f1 Personal (64bit) - Untitled - audio3 - PC, Mac & Linux Standalone® <DX11> - x
File Edit Assets GameObject Component Window Help
1 + EEAIEIG)

= Hierarchy

Quntitied” - = L ——  [instantiateCubes [ static ~
e i b

Main Camera
ctional Light

& Project
cre.

©1 Al M

(L All Prefabs

& 4
# Cfr
v Assets
& _hudio Audiopaer iat
(&5 _Materials
» & _Mesh
&3 _Prefabs

—

Gambar 7.37 Mengganti Nama GameObject menjadi InstantiateCubes

26. Masukan C# script dengan nama “instantiate512cubes” kedalam inspector dengan cara men-

drag
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Account - ] [La\rers = ] [ Layout = ]
W‘ Services e
@ o [instantiateCubes | [ Static
Tag | Untagged ¢ | Layer | Default ]
¥ .~ Transform 3,
Position X0 Y0 Z0

Rotation 3|0 0 Z0

Scale X1 1 Z|1

|G| |¥ Instantiate 512cubes (Scr 1] gvl
Cript Instantiates 12 cuby

Gambar 7.38 Memasukkan C# Script Ke Inspector

27. Buka script “instantiate512cubes”

28. Dan tambahkan script seperti di bawah ini

AudioPeer.cs instantiate512cubes.cs — audio

UnityEngine;

instantiate512cubes : Mo viour {
GameObject _sampleCubePrefab;
GameObject[] _sampleCube = GameObject[512];

Sumber kode 34 Script Sample Cube Prefab

29. Maka akan muncul kolom sample cube prefab pada inspector

Account - ] [La\rers - ] [Layout - ]

© Inspector Services =

"4 [ |instantiateCubes || static =

Tag | Untagged = Layer | Default s |

¥ .~ Transform #*,
Position ¥ 0 Y0 Z0
Rotation X 0 Y0 Z0
Scale X|1 ¥l Z1

7@ [+ Instantiate 512cubes (Scr ,

Script instantiate51Zcub) @

| Sample Cube Prefab None (Game Object’ © |

[ Add Component ]

Gambar 7.39 Inspector

30. Klik pada lingkarang yang berada di samping kolom sample cube prefab
31. Maka akan muncul window baru lalu pilih assets

32. Lalu pilih dan klik pada cube yang berwarna kuning
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S [ [ fo1 [ 6| [ecenter | @ cocal ] > [ [Ccomb - | [ & ] [Acsourt -] [Lovers =] [tayort -

= Hierarchy +# Scene ==/ © Inspector | Services
Creste~| GeAl Shaded Gizmos * | (GATl -
v Qaudio2*
Wain Camera
Directional Light

Select GameObject

4 [stantatecubes | (] Stati
Tag [Untagaed %) Layer [Defaut %)

Y~ Transform #

AudioPeer Position X0 Yo z[o
instantiatecubes Rotation X [0 ¥o 2[0
Scale X1 [T

(6 W Instantiate S12cubes (Ser @ %
Script instantiates1zcubi @
Sample Cube mrahml :]
Max Scale 0

Add Companent 30

parametric

3 Project | Oconsole
create - a |a]~]*
¥ /Favorites | Assets - _Scripts
(©L Al Materials
©Lll Models
(LAl Prefabs P r

GG

v EaAssets

& _Audio AudioPeer  instantiate
(& _Materials

» &5 _Mesh
(&5 _Prefabs

m P EBE S

Gambar 7.40 Memasukkan Cube Kuning Pada Sample Cube Prefab

33. Buka script “instantiate512cubes”

34. Dan tambahkan script seperti di samping

instantiate! AudioPeer.cs

.Generic;

mpleCubePrefab);

r._samples[i] * _ma»

Sumber Kode 35 Prosedural Audio Script

35. Jika sudah maka akan muncul kolom baru bernama ‘“Max Scale”
36. Ubah nilai Max Scale menjadi 1000
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8 Inspector
| instantiateCubes | [] static =
Tag Taver
¥ .~ Transform #
Position X 0 Al ‘ZlD
Rotation X 0 INal: ‘ZlD
Scale ®[1 (1 lz[1
¥ || ¥ Instantiate 512cubes (Scr #
Script ||_- instantiateSlZcub-| L]
Sample Cube Prefab i parametric-cube ]
Max Scale 1000 |

l Add Component ]

Gambar 7.41 Inspector

37. Setelah itu buka folder audio pada project ,terdapat satu file audio
38. Klik audio peer pada hierarchy

39. Lalu drag dan arahkan file audio ke audio clip pada inspector

&) Unity 20173, ", Mac & Linux Stanc X
File Edit A

Spatial Blend
s S
Reverb Zone Mix
¥ 3D Sound Settings
e

Sa

Add Component

¥ Audio Peer (Script)
ript Audi

FE
- AudioPeer o

Gambar 7.42 Menambahkan Audio Ke AudioClip

40. Jika sudah silahkan play, maka akan muncul spectrum yang mengikuti irama music
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Gambar 7.43 Spectrum Akan Muncul Mengikuti Irama Musik

C. KESIMPULAN

File format Audio yang support dengan unity format AIFF, WAV, MP3, dan Ogg.

Dibutuhkan penambahan C# Script untuk menempatkan audio sesuai keinginan kita pada project.

D. SOAL

1.

Media yang mengandung pesan dalam bentuk auditif (hanya dapat didengar) yang dapat

merangsang pikiran, perasaan, perhatian, dan kemauan anak untuk mempelajari isi tema adalah

a. Media lmage b. Media Audio c. Media Cetal d. Media Visual
Format file audio yang support pada unity, kecuali...
a. AIFF b. WAV c. Ogg d. AVI

Jenis Metode Kompresi (Berdasar mode penerimaan data yang diterima manusia) yang
merupakan proses penerimaan data tidak dilakukan secara real time disebut ...

a. Manual Mode b. Auto Mode c. Dialoque Mode d. Retrieval Mode

Jenis Metode Kompresi (Kompresi Data Berdasarkan Output) yang merupakan Teknik
kompresi dimana data hasil kompresi dapat didekompres lagi dan hasilnya tepat sama seperti
data sebelum proses kompresi. contoh aplikasi: ZIP, RAR, GZIP dan 7-Zip disebut ...

a. Loseless Compression

b. Lossy Compression

c. Opto Compressor

d. Tube Compressor

Format file audio yang dikembangkan oleh Microsoft dan IBM sebagi standar untuk
menyimpan file audio pada PC disebut ...

a. AlFF b. WAV c. Ogg d. AV
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6. Format file audio standar yang digunakan untuk menyimpan data suara untuk PC dan
perangkat audio elektronik lainnya, yang dikembangkan oleh Apple pada tahunv1988 disebut

a. AIFF b. WAV c. ACC d. Ogg
7. Format audio yang Maximum Simple Rate nya 48 kilohertz, kecuali ...

a. Mp3 b. Ogg c. ACC d. WAV
8. Format audio AIFF Maximum Simple Rate nya adalah ...

a. 48 Khz b. 96 Khz c. 192 Khz d. 196 Khz
9. Format audio WAF Maximum Simple Rate nya adalah ...

a. 48 Khz b. 96 Khz c. 192 Khz d. 196 Khz

10. Cara menambahkan audio source pada component adalah ...
a. Pilih object > Add Componen > audio source
b. Pilih object > Transform > audio source
c. Pilih object > Add Componen > Play on awake
d. Pilih object > Transform > audio source
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TUJUAN

1. Pembaca dapat mengetahui build pada Unity 3D.
2. Pembaca dapat melakukan proses build pada Unity 3D.

A. DASAR TEORI
8.1  Pengertian Build

Seperti halnya export dan rendering pada software editing, unity menggunakan Build

Setting untuk melakukan proses Build yang bertujuan untuk mengahasilkan suatu output dari

projek yang telah dikerjakan.

8.2  Fungsi Build Pada Unity 3D
1. Untuk mengkompile file pada projek menjadi suatu file berekstensi .exe.

2. Memberi dan mengatur gambar pada icon shortcut dan background pada tampilan awal

sebelum memasuki aplikasi.

¥ Unity 2018.1.0f2 Personal (64bit) - CharacterThirdPerson.unity - Mew Unity Project - P(
File Edit Assets GameObject Component Meobile Input  Window  Help

MNew Scene Ctrl+N Center
Open Scene Ctrl+0

Save Scenes Ctrl+5 Display 1+ | Free Aspect
Save Scene as... Ctrl+Shift+5

MNew Project...

Open Project...
Save Project

Build Settings... Ctrl+Shift+B
Build & Run Ctrl+B
Exit

Gambar 8.1 Build Settings
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8.3  Komponen pada Build
1. Scenes in Build

Sebagai indikator scene suatu projek yang akan dibuild. Terdapat 2 cara untuk
menambahkan scene pada Scenes in Build, yaitu dengan mengklik tombol ‘Add Open Scenes’,

atau dengan cara drag and drop pada jendela Scenes in Build.

Build Settings

Scenes In Build

| Scenes/SampleScene

[l scenes/New Scene

[_|Scenes/azmi

[ |sampleScenes/Scenes/Car

vl SampleScenes/Scenes/CharacterThirdPerson i

Gambar 8.2 Scene In Build

2. Platform
a. Platform List
Merupakan daftar platform yang tersedia di unity. Didalamnya terdapat beberapa platform

dan development kit-nya, diantaranya; PC (Visual Studio), Mac (Mono Develop), Android
(SDK), i0OS (Xcode), tvOS, Xbox One, PS Vita, PS4, Universal Windows Platform,
WebGL, Facebook.

Platform

-{Pﬁ¢ PC, Mac & Linux Standalone <y é_, PC, Mac & Linux Standalone

a Android Target Platform | Windows &

Architecture | x86_g4 i)

ﬂ i0s Copy PDE files O
Development Build LJ

itv tvOS Autoconnect Profiler

Script Debugaging

@ ®box One Scripts Only Build

PS Wita
=r.a PS4 Compression Method | Default &l
| Universal Windows Platform
LiL b Learn about Unity Cloud Build
| Switch Platform HPIaver Settings...] [ Build H Build And Run J

Gambar 8.3 Platform List
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Integrated Development Kit (IDE)
Aplikasi perangkat lunak (software) yang menyediakan fasilitas lengkap bagi pemrogram
komputer untuk pengembangan perangkat lunak lainnya. Berikut adalah beberapa IDE
yang digunakan Unity pada proses build :
1. Visual Studio
Visual Studio merupakan Integrated Development Environment (IDE) tool dari
Microsoft. Integrasi Visual Studio Unity memungkinkan Anda untuk membuat dan
mengelola file proyek Visual Studio secara otomatis. VisualStudio akan terbuka ketika

Anda mengklik dua kali pada skrip atau pada error message di console Unity.

Gambar 8.4 Logo Visual Studio

2. Mono Develop
Mono Develop adalah IDE yang disediakan oleh Unity. IDE ini menggabungkan
operasi teks editor yang sudah dikenal dengan fitur tambahan untuk debugging dan

tugas manajemen proyek lainnya.

Gambar 8.5 Logo Mono Develop
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3. Xcode
Xcode adalah IDE untuk macOS yang berisi seperangkat software development tools
yang dikembangkan oleh Apple untuk mengembangkan software untuk macOS, iOS,
watchOS, dan tvOS.

Gambar 8.6 Logo Xcode

4. Android SDK
Android SDK merupakan tools bagi para programmer yang ingin mengembangkan

aplikasi berbasis google android.

Foio
l'l
AaN>30I1D

SDK

Gambar 8.7 Logo Android SDK
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3. Player Settings
Merupakan jendela yang berisi kumpulan pengaturan dari platform yang telah dipilih.

8 Inspector

ﬁ'} PlayerSettings [ 5 &,
Company Name |DefauItCumpan',r |
Product Name ‘Mew Unity Project |

Default Icon

Select
Default Cursor
Cursor Hotspot )(|U |‘f |U |
3 | #

Settings for PC, Mac & Linux Standalone

Icon

Resolution and Presentation

Other Settings

|
|
| Splash Image
|
|

XR Settings

Gambar 8.8 Player Setting

Terdapat 5 opsi utama yang bisa diatur, diantaranya:
1. lcon
Untuk mengatur tampilan icon dari aplikasi yang akan dibuild.
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@ Inspector
Icon 5
_ _ r
¥ Override for PC, Mac & Linux Standalor
1024x1024
Selact]
512x512
Select V
256x256
Select

Gambar 8.9 Icon Pada Unity 3D

2. Resolution and Presentation

Untuk mengatur resolusi dari aplikasi yang akan dibuild.

| Icon

Resolution and Presentation

Resolution
Fullscreen Mode | Fullscraen Win 3
Default Is Native Resolutii |«
Mac Retina Support o
Run In Background* =

Standalone Player Options
Capture Single Screen [ |

(Enabled ¢

Display Resolution Dialog

&

Use Player Log

Resizable Window =

Visible In Background =

Allow Fullscreen Switch o

Force Single Instance [l
P Supported Aspect Ratios

* Shared setting between multiple platforms,

| Splash Image

| Other Settings

| XR Settings

Gambar 8.10 Resolution And Presentation Pada Unity 3D
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3. Splash Image

Untuk mengatur background pada tampilan awal aplikasi yang akan dibuild.

© Inspector

-

Splash Image =

Application Config Dialog

Virtual Reality Splash Ime

Splash Screen
Show Splash Screen

Splash Style
Animation

Logos*

Show Unity Logo

Draw Mode
Logos
Logo Duration 2

Splash Screen Duration: 2 D =

Gambar 8.11 Splash Image Pada Unity 3D

4. Other Settings
Pada pengaturan ini terdapat beberapa pengaturan lainnya untuk aplikasi yang akan

dibuild.
© Inspector _ SERIGES NGRS

Other Settings ,‘,_
Rendering
Color Space (Gamma

Auto Graphics API for Wilo

Auto Graphics API for Malsf

Auto Graphics API for Linlyf
Color Gamut For Mac*

— sRGBE

Static Batching ™4
Dynamic Batching il
GPU Skinning™* il
Graphics Jobs (Experimer[_|

Lightmap Encading High Quality

Virtual Reality moved to ¥R Settings

Mac App Store Options

Bundle Identifier com.Company.
Version*

Build i

Category public.app-cate

Mac App Store Validation []

Gambar 8.12 Other Settings Pada Unity 3D
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5. XR Settings
Pengaturan yang digunakan untuk sebuah projek yang menggunakan vitur VR.

i | I‘I
Settings for PC, Mac & Linux Standalone

Icon
Resolution and Presentation
Splash Image

Other Settings

XR Settings
Virtual Reality Supported [
360 Stereo Capture [

XR Support Installers

Vuforia Augmented Reality

Gambar 8.13 XR Setting

c. Button
1. Build

Tombol Build untuk membuild aplikasi.

Compression Method | Default s ]

Learn about Unity Cloud Build

| Build || Build And Run_ |

Gambar 8.14 Tombol Build

2. Build and Run

Tombol Build and Run untuk membuild aplikasi dan langsung menjalankannya setelah
aplikasi selesai dibuild.

188



MARI BELARMAIN VIRTUAL REALITY DENGAN UNITY 3D

Compression Method | Default ™

Learn about Unity Cloud Build

I ﬁud I[ Build And Run ]

Gambar 8.15 Tombol Build And Run

B. PRAKTIK

Setelah pembaca dapat membuat sebuah 3D dari proses Praktik Bab 1 sampai dengan Bab
7. Pada Bab ini kami membahas tentang Build atau sering disebut export dan rendering pada
software editing. Yang berfungsi untuk mengkompile file pada projek menjadi suatu file

berekstensi .exe.

PERALATAN
1. Komputer
2. Software Unity
3. Koneksi Internet
4. Asset Build

LANGKAH LANGKAH PERCOBAAN
Mengimport Asset
Buka File Asset Yang Anda Miliki.

Gambar 8.16 Contoh Asset
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Menambahkan Build
1. Klik menubar “File”
2. Pilih “Build Settings...”

2 Unity 2018.1.0f2 Personal (64bit) - CharacterThirdPerson.unity - New Unity Projes
B Assets  GameObject Component  Mobile Input  Window Help

New Scene cut+N

Open Scene Ctrl+0

Save Scenes Chl+5 Display 1  #|| Free Aspect
5ave Scene as... Ctrl+Shift+5

Mew Project...

Open Project...
Save Project

Build Settings... Ctrl+ Shift+B
Build & Run Ctrl+B
Exit

Gambar 8.17 Build Setting

Menambah Scene in Build

1. Klik menubar “File"

2. Kiik “Build Settings”

3. Pilih “Add Open Scenes” lalu pilih Scene yang akan dibuild

(Memasukkan scenes juga bisa dilakukan dengan cara “Drag” and “Drop”)

Ctrl+M

Open Scene Ctrl+O
Save Scenes Ctrl+5
Save Scene as... Ctrl+Shift+5
; Scenes In Build
Mew Project...

[ Seenes/SampleScene

[l Scenes/New Scene

[ Scenes/azmi

[l sampleScenes/Seenes/Car

Open Project...
Save Project

[¥ SampleScenes/Scenes/CharacterThirdPerson o
Build Settings... Ctrl+5Shift+B
Build & Run Ctrl+B
Exit [[Add open Scenes |
Gambar 8.18 Menambah Scene in Build
Platform

1. Pilih platform yang akan digunakan dengan cara klik pada target platform
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2. KIlik Player Settings

é" PC, Mac & Linux Standalone

ﬁ Android ITarqet Platform | Windaws #]I
Architecture | x86_64 3]
E 105 Copy PDB files -
Development Build -
&y vos Autoconnect Profiler O
— Script Debugging O
¥box One Scripts Only Build LJ
PS vita
=ra PS4 Compression Method | Default

.- A 3
| Universal Windows Platform

| Switch Platform || Player Set‘tings...l

Learn about Unity Cloud Build

2

[ Build || Build And Run

Gambar 8.19 Platform Build Unity

3. Centang Default Is Full Screen
4. Pilih Enabled pada bagian Display Resolution dialog

Resolution and Presentation

Resolution

Default Is Full Screen
)

Default Is Native Resoluti

Run In Background® O

Standalone Player Options

Capture Single Screen [

Display Resolution Dialog [ Enabled = ]
Use Player Log [+

Resizable Windaow N

Mac App Store Validation [

Mac Fullscreen Mode | Fullscreen Window With Manu B4 |
0309 Fullscreen Mode | Fullscreen Window s |
03011 Fullsereen Mode | Fullsereen Window s |

Visible In Background O
Force Single Instance O

Gambar 8.20 Resolution And Presentation

5. Masukkan berbagai macam ukuran Icon

6. Masukkan texture image sebagai splash image sebelum masuk ke dalam aplikasi.

191



MARI BELARMAIN VIRTUAL REALITY DENGAN UNITY 3D

L] Inspector
Icon
[Joverride for Standalone

1024x1024 .

512x512

256x%256

Splash Image
Config Dialog Banner

128x128

Virtual Reality Splash Image

48x48

37432 |:| Show Unity Splash Screen™ [
* Shared setting between multiple platforms.

Gambar 8.21 Cara Memasukkan Ukuran Icon Dan Texture Image

7. KIlik tombol build untuk membuild aplikasi, simpan dengan nama virtual_reality.
8. Kilik build and run untuk langsung menjalankan aplikasi ketika aplikasi telah dibuat.

Gambar 8.22 Build Aplikasi
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C. KESIMPULAN

Build merupakan suatu perintah untuk mengompile scene pada unity agar menjadi file

berekstensi .exe yang dapat dijalankan.

Build
HOST PLATFORM
WIN MAC 10S ANDROID
PC v v v v
MAC v v v v
Tabel 6 Build
Catatan :

Semua platfrom bisa dijalankan, dengan catatan menggunakan emulator yang dibutuhkan.

D. SOAL

1.

Suatu perintah untuk mengompile scene pada unity agar menjadi file berekstensi .exe yang
dapat dijalankan adalah ...

a. Play b. Instalasi c. Setting d. Build
Kepanjangan dari IDE adalah ...

a. Integrated Development Kit

b. Integrasi Development Kit

c. Interview Development Kit

d. Interlocal Development Kit

IDE yang dibutihkan untuk Build platform macOs adalah ...

a. Visual Studio b. Mono Develop c¢. Xcode d. Android SDK
IDE yang dibutihkan untuk Build platform Android adalah ...

a. Visual Studio b. Mono Develop c¢. Xcode d. Android SDK
IDE yang dibutihkan untuk Build platform windows adalah

a. Visual Studio b. Mono Develop c¢. Xcode d. Android SDK
Pada player setting yang berfungsi untuk mengatur resolusi dari aplikasi yang akan dibuild disebut

a. lcon c. Resolution and Presentation

b. Resolution and Presentation d. XR Settings

Pada player setting yang berfungsi untuk mengatur tampilan icon dari aplikasi yang akan dibuild
adalah ...

a. lcon c. Resolution and Presentation

b. Resolution and Presentation d. XR Setting
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8. Pada player setting yang berfungsi untuk mengatur background pada tampilan awal aplikasi
yang akan dibuild adalah ...
a. Icon c. Resolution and Presentation
b. Resolution and Presentation d. XR Setting

9. Pada player setting yang berfungsi untuk mengatur yang digunakan sebuah projek yang
menggunakan vitur VR adalah ...
a. lIcon c. Resolution and Presentation
b. Resolution and Presentation d. XR Setting

10. Pada player setting yangberfungsi sebagai pengaturan terdapat beberapa pengaturan lainnya
untuk aplikasi yang akan dibuild.adalah ...
a. lcon c. Other Settings
b. Resolution and Presentation d. XR Setting
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BAB 9
VIRTUAL REALITY

TUJUAN

1. Pembaca dapat mengetahui perangkat pendukung Virtual Reality.
2. Pembaca dapat membuat Virtual Reality.

3. Pembaca dapat membuat projek sederhana dari Google Cardboard dan VR Box.

A. DASAR TEORI
9.1  Pengertian Virtua Reality

Virtual Reality (VR) atau Realitas Maya adalah sebuah teknologi yang membuat
pengguna atau user dapat berinteraksi dengan lingkungan yang ada dalam dunia maya berdimensi
3D yang disimulasikan oleh komputer, terhadap suatu objek nyata atau imajinasi, sehingga
membuat user seolah-olah terlibat secara fisik pada lingkungan tersebut.

Virtual Reality (VR), kadang-kadang disebut Virtual Environments (VE) telah menarik
banyak perhatian beberapa tahun terakhir. Liputan media yang luas menyebabkan minat ini
berkembang pesat. terminologi dasar dan kelas dari sistem VR terdaftar, diikuti oleh teknologi

aplikasi ini dalam sains, pekerjaan, dan area hiburan. [1].

!

f -

Gambar 9.1 Virtual Reality
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9.2  Sejarah Virtual Reality

Gambar 9.2 Sejarah Virtual Reality

9.2.1 Sensorama
Pada tahun 1960-1962 Morton Heilig menciptakan simulator multi-sensorik. Sebuah film
yang direkam sebelumnya dalam warna dan stereo, ditambah dengan binaural suara, aroma, angin

dan getaran pengalaman. Ini adalah pendekatan pertama untuk menciptakan sistem virtual reality.

Gambar 9.3 Sensorama

9.2.2 Head Mounted Display

Pada tahun 1966, Ivan Sutherland menemukan Head Mounted Display yang merupakan
jendela ke dunia virtual. pada tahun 1965 lvan Sutherland mengusulkan solusi akhir dari realitas
virtual: konsep konstruksi dunia buatan yang mencakup grafik interaktif, force-feedback, suara,

bau dan rasa.
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Gambar 9.4 Head Mounted Display

9.2.3 Videoplace
Seorang ilmuwan bernama Myron Krueger (1975) menemukan Videoplace yang

memungkinkan penggunanya dapat berinteraksi dengan objek virtual untuk pertama kalinya.
“a conceptual environment, with no existence”.Dalam sistem ini siluet pengguna yang ditangkap
oleh kamera diproyeksikan pada layar besar. User dapat berinteraksi satu dengan yang lain dengan

teknik pemrosesan gambar yang menentukan posisi user di ruang layar 2D.

Gambar 9.5 Videoplace
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9.24 VCASS (The Visually Coupled Airborne Systems Simulator)

Thomas Furness 111 memiliki latar belakang dalam membuat tampilan visual sejak tahun
1966. Dia memiliki gagasan untuk mengelola banjir informasi yang diberikan kepada pilot. Dia
berhasil mengamankan pendanaan untuk sistem prototipe yang akan dikembangkan di Pangkalan
Angkatan Udara Wright-Patterson di Ohio. VCASS dibuktikan pada tahun 1982. Uji Pilot
mengenakan helm Darth Vader dan duduk dalam maket kokpit.

The Super Cockpit (1980’s)
-, ®

>

= Furness - USAF

Gambar 9.6 The Visually Coupled Airborne Systems Simulator

9.25 VIDED
VIVED ( Vlrtual Visual Environment Display ) - dibangun di NASA Ames pada tahun
1984 dengan teknologi off-the-shelf HMD monokrom stereoskopik.

Gambar 9.7 Vlrtual Visual Environment Display

9.26 VPL
Perusahaan VPL memproduksi DataGlove populer (1985) dan Eyephone HMD (1988) -

perangkat VR pertama yang tersedia secara komersial.
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The VPL DataGlove (1987)

Gambar 9.8 VPL DataGlove

9.2.7 BOOM

BOOM - dikomersialkan pada tahun 1989 oleh Lab Ruang Palsu. BOOM adalah kotak
kecil berisi dua monitor CRT yang dapat dilihat melalui lubang mata. Pengguna dapat mengambil
kotak, menyimpannya dengan mata dan bergerak melalui dunia maya, karena lengan mekanik

mengukur posisi dan orientasi kotak.

Gambar 9.9 Boom

9.28 CAVE

CAVE (1992) adalah sistem realitas virtual proyeksi yang dikembangkan di Lab
Visualisasi Elektronik. Cave dibuat oleh Carolina Cruz-Neira, Dan Sandin, dan Tom DeFanti,
bersama dengan mahasiswa lain dan staf EVL.

Sistem VR yang lebih baru dari CAVE adalah ImmersaDesk dan IWall. The ImmersaDesk
adalah perangkat gaya meja drafting satu layar. The IWall adalah layar, layar besar tunggal
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menggunakan empat pipa grafis ubin untuk peningkatan resolusi. CAVE pertama kali ditunjukkan
pada konferensi SIGGRAPH '92.

Gambar 9.10 Cave

9.3  Perangkat dan Element Virtual Reality

Untuk memunculkan sensasi nyata dari virtual reality diperlukan perangkat pendukung.
Perangkat yang digunakan untuk mendukung teknologi virtual reality biasanya berupa helm,
walker, headset, suit dan sarung tangan (glove). Perangkat-perangkat tersebut bertujuan untuk
melibatkan sebanyak mungkin indra yang dimiliki manusia. Tentunya dengan banyak indra yang
terlibat dalam vertual reality akan berbanding lurus dengan tingkat sensasi nyata dari dunia virtual

yang dimunculkan.

Gambar 9.11 Perangkat Virtual Reality
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Untuk memasuki Virtual Environment, pengguna mengenakan joystick, earphone, dan kacamata
khusus (HMD) yang terhubung dengan komputer dan sistem yang di dalamnya. Melalui cara ini,

setidaknya tiga indera tubuh kita terkontrol oleh komputer.

9.3.1 HMD (Head Mounted Display)

Jenis perangkat HMD dibagi menjadi dua kategori. Pertama yang menggunakan
smartphone dan kedua yang membutuhkan peralatan eksternal performa tinggi seperti PC. Pada
HMD yang menggunakan smartphone, kita memasangkan smartphone yang telah dilengkapi
aplikasi khusus untuk menampilkan video VR ke headset yang kompatibel. Sedangkan untuk tipe
yang menggunakan PC, kita harus terlebih dahulu menginstal software khusus di dalamnya. Video
VR kemudian akan ditampilkan pada HMD dengan menghubungkannya ke PC.

a. Entry-Level Mobile VR

Entry-Level Mobile VR ini adalah perangkat Virtual Reality yang harganya murah , tidak
ada komponen elektronik didalamnya dan dalam menggunakannya memerlukan sebuah
smartphone berukuran layar 4 hingga 5 Inch keatas . Salah satu contoh dari Entry-Level Mobile
VR adalah Google Card Board.

Gambar 9.12 Google Card Board
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b. Mobile Virtual Reality

Mobile Virtual Reality hampir sama dengan Entry-Level Mobile VR karena keduanya
menggunakan Smartphone sebagai Processing Source nya . Namun pada Mobile Virtual Reality
Headset biasanya dilengkapi dengan komponen elektronik didalamnya . Mobile Virtual Reality
biasanya dilengkapi dengan tracking sensor , built-in control dan focus adjustment yang
menambah keseruan ketika bermain game Virtual Reality . Contoh dari mobile virtual reality

adalah Samsung Gear VR.

Gambar 9.13 Samsung Gear VR

C. High-Level Virtual Reality

Perangkat VR ini berbeda dengan Mobile Virtual Reality Headset , karena kita harus
menggunakan sebuah Komputer atau perangkat game konsol untuk bisa menggunakan High-Level
Virtual Reality Headset. Contoh perangkat VR yang termasuk kedalam golongan High-Level
Virtual Reality adalah Oculus Rift dan HTC Vive dimana keduanya menggunakan Komputer
sebagai processing sourcenya .

Perangkat VR HMD keluaran HTC ini memiliki dua kamera untuk menjalankan
fungsi position tracking sehingga memungkinkan penggunanya bergerak bebas sambil menikmati
dunia VR. Ini merupakan fitur paling menonjol dibandingkan HMD lainnya di mana dunia virtual

yang ditampilkan relatif lebih statis.
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Gambar 9.14 HTC

d. Virtual Mobile Theater

Seperti namanya , Virtual Mobile Theater adalah perangkat VR Headset namun bukan
untuk bermain game , melainkan untuk memberikan sensasi yang mengagumkan pada pengguna
saat menonton film dengan menggunakan perangkat Virtual Mobile Theater.

Virtual Mobile Theater membutuhkan processing source berupa komputer atau
smartphone, dengan menggunakan perangkat sejenis ini , maka film yang kalian tonton akan terasa
seperti theater sungguhan dengan layar yang besar dan suara yang stereo Salah satu contoh dari
Virtual Mobile Theater adalah Sony HMZ-T1 .

Gambar 9.15 Sony HMZ-T1
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e. Augmented Reality Headset

Augmented Reality adalah teknologi yang menggabungkan dunia nyata dengan objek
grafis yang diciptakan / generated melalui komputer. Contoh perangkat Augmented Reality ini
adalah Microsoft HoloLens.

Gambar 9.16 Microsoft HoloLens

9.3.2 Perangkat Input
a. Leap Motion

Leap Motion merupakan salah satu sensor pendeteksi tangan yang bias digunakan untuk
controller sebuah simulasi. Leap Motion mendeteksi pergerakan tangan secara alami dan
memungkinkan pengguna untuk berinteraksi dengan computer dengan cara yang baru, seperti
point, wave, reach, grab.

Leap Motion dapat melacak 10 jari hingga 1/100 milimeter. Hal ini menunjukkan bahwa
leap motion merupakan sensor control gerak yang sensitive dibandingkan dengan sensor control
yang ada. Leap Motion memiliki bidang pandang yang cukup lebar yaitu 150° dan z-axis untuk
kedalaman. Itu menunjukkan bahwa ketika menggerakan tangan dalam 3D, hampir sama
menggerakan tangan dalam dunia nyata. Leap Motion dapat melacak gerakan tangan pada tingkat
lebih dari 200 frame per detik.

Gambar 9.17 Leap Motion
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b. Joystick / Gamepad
Joystick/Gamepad merupakan perangkat yang berfungsi sebagai controller untuk bermain
di dalam VR.

Gambar 9.18 Joystick

C. Controller Wands
Controller wands merupakan perangkat yang berfungsi sebagai controller untuk berinteraksi atau

bermain di dalam VR.

Gambar 9.19 Controller Wands

d. Data Gloves
Data gloves adalah perangkat interaktif, menyerupai sarung tangan yang dipakai di tangan,
yang memfasilitasi sentuhan penginderaan dan kontrol gerak halus dalam robotika dan realitas
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virtual. Sarung tangan data adalah salah satu dari beberapa jenis perangkat elektromekanik yang

digunakan dalam aplikasi haptics.

Gambar 9.20 Data Gloves

e. Voice Recognition
Perangkat voice recognition berfungsi untuk berbicara di dalam VR. Biasanya digunakan

untuk berbicara kepada NPC (Non Player Character).

Gambar 9.21 Voice Recognition

f. Motion Trackers/Bodysuits

Bodysuits berfungsi untuk menangkap gerakan seluruh tubuh dengan alat yang berbentuk
seperti pakaian. Menggunakan EMS (Electro Muscular Stimulation) yang diumpankan ke sistem
saraf tubuh melalui setelan ketat, prototipe terbaru dapat mensimulasikan rasa sentuhan atau
tekanan. Artinya, jika seseorang di dunia maya menyentuh Anda atau menusuk Anda, Anda akan

merasakannya dalam waktu nyata. Baru-baru ini, teknologi ini didemonstrasikan dalam film
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dokumenter TV di mana subjek dapat "merasakan™ pelukan dari seorang demonstran yang
ditangkap di seberang ruangan.

Selain umpan balik EMS, setelan ini juga dilengkapi dengan kontrol suhu yang
memungkinkannya mensimulasikan perubahan suhu untuk meniru lingkungan di VR secara lebih
akurat. la juga mampu menangkap gerakan tubuh pengguna setelah unit Mocap dipasang ke dalam

teknologi.

Gambar 9.22 Bodysuits

g. Treadmills
Treadmills pada VR digunakan sebagai menangkap gerakan kaki pemain. Fungsinya
yaitu untuk berjalan dan berlari di VR.

N mY<<40403V

TE—I-ZOMo <y

Gambar 9.23 Treadmills
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9.3.2 Virtul Reality Software Supported
a. Unreal Engine

The Unreal Engine sangat terkenal di industri game. Paket ini sangat serbaguna,
memungkinkan pembuatan game dari 2d ikoner yang digambar tangan hingga film sinematik
hampir seperti pengalaman. Mereka telah dimasukkan ke dalam realitas virtual secara langsung
dan mendukung teknologi terkini secara asli. Ada pasar yang dibangun di mana Anda dapat
menemukan dan membeli aset untuk dimasukkan dalam proyek Anda dan berbagi tutorial dan
inspirasi komunitas yang sangat besar.

Yang paling mengesankan, Unreal Engine benar-benar gratis. Anda dapat mengunduhnya

sekarang dan mulai menciptakan pengalaman realitas virtual dengan biaya nol.

Gambar 9.24 Unreal Engine

b. Unity 3D

Selama beberapa tahun terakhir, Unity telah tumbuh dari startup kecil yang berani untuk
bekerja sama dengan Unreal Engine. Rilis yang akan datang dari headset VR besar pertama yang
tersedia secara komersial hanya membantu menyamakan bidang permainan karena Unity telah
secara agresif mendekati komunitas ini. Anda dapat mengunduh Unity dan mulai membangun

lingkungan VR segera tanpa pengalaman sebelumnya.
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Gambar 9.25 Unity 3D

C. Cryengine

Cryengine telah lama dikenal karena kemampuan visualnya yang kaya, game unggulan
dari mesin ini sering digunakan sebagai tolak ukur untuk menentukan kekuatan komputer. Hingga
baru-baru ini, ada biaya yang terkait dengan mesin ini yang menjauhkannya dari tangan banyak

pengembang kecil. Sekarang, ini adalah model pay-what-you-want yang berarti Anda dapat

mengunduhnya secara gratis hanya untuk mencobanya dan melihat apakah Anda menyukainya.

::::::

Gambar 9.26 Cryengine
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B. PRAKTIK

Setelah pembaca dapat membuat sebuah 3D dan Build file. Pada Bab ini kami membahas
tentang mempersiapkan perangkat Virtual Reality berupa Google Cardboard dan VR Box. Dan
kita dapat membuat project VR sederhana menggunakan VR Box dan smartphone Android serta

mengetahui tampilan VR dari smartphone dengan VR Box

PERALATAN
Komputer
. Software Unity

Koneksi Internet

1
2
3
4. Smartphone
5. Google Cardboard
6

. VR Box

LANGKAH LANGKAH PERCOBAAN

Cara Merangkai Google Cardboard
Google cardboard premium memiliki perbedaan dibandingkan versi lainnya, dimana

paketnya terbungkus menjadi satu, lebih rapi dan untuk menyusunnya tinggal merangkainya

’ =
4

= pA

be g
B

Gambar 9.27 Langkah Langkah Merangkai Google Cardboard

mengikuti alur petunjuk label-label angka yang tersedia.
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Bagian depan

Bagian belakang

Tarik bagian yang bisa disobek

Buka semua lipatan hingga tidak ada yang terlipat
Lihat bagian yang bergambar gunting

Sobek atau gunting bagian tersebut

Bagian yang berlensa lipat seperti gambar

Lipat seperti pada gambar, ini bagian paling susah

Lipat lagi rolling ke arah Kiri, pastikan tanda angka-angka-nya masuk sesuai pasagannya

. Lipat bagian sisi Kiri yang terdapat magnet, buka double tip agar merekat s/d google cardboard

siap digunakan.

Pasang smartphone di google cardboard

Hp terpasang di google cardboard

Tempelkan google cardboard bagian depan biyar smartphone tertutup
Google cardboard siap pakai tampak belakang

Google cardboard siap pakai tampak samping

Google cardboard siap pakai tampak depan

Cara Memasang Smartphone ke VR Box

Lauch VR app or 3D(Side.bysidBmevies Embed phonelinto the drawer

SlideltheldrawerntolVRiheadset throughisideisiots Pushitheldrawer: to the end

Gambar 9.28 Langkah Langkah Merangkai VR Box
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Buka aplikasi VR
Masukkan smartphone ke dalam drawer

Pasang drawer ke dalam VR Box

A wnhoE

Slide drawer ke dalam Box

Membuat Project VR Sederhana Menggunakan VR Box

1. Buat Project 3D baru
» Buka Aplikasi unity dan kemudian buat project 3d baru
» Nama project SampleVVRUniversal.

» Kemudian klik Create Project.
Q

Gambar 9.29 Buat Project 3D baru

2. Kemudian masukkan Object 3D sederhana dengan cara :
» Pada Hirachy-> 3D Object -> Cube.
» Atur posisi di 0,0,0 supaya terlihat di kamera.
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9 Unity (64bit) - Untitled - SampleVRUniversal - PC, Mac & Linux Standalone* <DX11> - u} X

File Edit Assets GameObject Component Window Help

Gambar 9.30 Memasukkan Object 3D

3. Kemudian tambahkan pointer.
» KIlik kanan pada Main Camera -> 3D Object -> Sphere.

» Atur posisi z dengan nilai 2 dan scale 0.05.

» Hapus Component Sphere Collider.

Gambar 9.31 Menambahkan Pointer

Membuat Project VR Sederhana Menggunakan VR Box
1. Masukkan SDK Cardboard ke project.
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2. Download terlebih dahulu Google VR For Unity. Unity Package atau lebih lengkapnya
download di Google VR for Unity.

3. Masukkan package yang telah didownload dengan cara: Klik Assets > Import
Package> Custom Package..

4. Kemudian cari file Google VR For Unity.unitypackage yang telah didownload.
Untuk  mengubah  tampilan camera  menjadi mode VR  cukup, drag
file GvrViewerMain ke Hierarchy. Secara otomatis Main Camera akan terlihat modus VR
ketika terinstal di Android.

Q Unity (64bit) - Sampleunity - SampleVRUniversal - Android* <DX11 on DX9 GPU > - o X

File Edt Assets GameObject Component GoogleVR Window Help

Gambar 9.32 Menambahkan Pointer

6. Menambahkan Script pada Cube
Kemudian membuat script yang digunakan untuk Cardboard maupun di GearVR.
Tambahkan  script pada Cube. Add Component > New script. (Contoh  nama

script TeleportUniversal.cs.)

214



MARI BELARMAIN VIRTUAL REALITY DENGAN UNITY 3D

Script untuk melakukakn Select object pada cube yang telah dibuat seperti dibawah ini:

void Update () {
RaycastHit hit;
3 posMainCam =

Camera.main.transform.position;
era.main.transform. TransformDirection(Vvector3d .forward);
=ics.Raycast(posMainCam, direction, out hit})
if (hit.transform.name.Equals( "Cube"))
{
// ketika pointer diatas object yang bernama "Cube”
if ( Input.GetMouseButtonDown(@))
-
[/ ketika klik/tap Object yang bernama "Cube"
}
¥
)
I
else
r
L
// Ketika pointer diluar object

Sumber Kode 36 Scrip Untuk Select Object

7. Contoh sederhana yang kita lakukan terhadap object "Cube™ adalah yang pertama mengubah
warna ketika pointer diatas object. Ketika pointer berada diatas objek, maka cube akan berubah

warna dari hijau menjadi merah.

public void IsSelected(bool selected)
1

GetComponent<Renderer>() .material.color = selected ? Color.green : Color.red;

Sumber Kode 37 Script Untuk Mengubah Warna Pada Object

8. Kemudian membuat object Cube berpindah ketika diklik/ditap.

public void Teleport()
1
Vector3 direction = Random.onUnitSphere;
float distance = 5 * Random.value + 1.5f;

transform.localPosition = Camera.main.transftorm.localPosition + direction * distance;
Sumber Kode 38 Script Untuk Membuat Object Berpindah Ketika Ditekan Tap

9. Code untuk keluar dari aplikasi.

if (Input.GetKeylp(KeyCode.Escape))
1
Application.Quit();
1
1

Sumber Kode 39 Script Untuk Keluar Dari Aplikasi
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10. Jadi keseluruhan script dapat ditulis seperti ini

using UnityEngine;
public class TeleportUniversal : MonoBehaviour

woid Updatel)

RaycastHit hit;
posMainCam =

ra.main.transform.position;

irection a.main.transform.Transformbirection(Vectors .forward)
if { Physics.Raycast{posMainCam, direction, out hit})
{
if (hit.transform.name.Equals{ "Cube™))
£/ ketika pointer diatas object yang bermana Cube
Isselected( true)
if { Input.GetMouseButtonDown (&) )
il
ff ketika klik Object yang bernama Cube
Teleport();
}
else
{
'f Ketika pointer diluar object
Ishelected| false)
if { Input.GetKeyUp{ KeyCode.Escape))
{
Application.Quit();
}
public void Teleport()
Vector3 direction = Random.onUnitSphere;
float distance = 5 * Random.value + 1.5fF;

transform.localPosition = Camera.main.transform.localPosition + direction * distance;

}
public woid IsSelected( bool selected)

GetComponent< Renderer:().material.color = selected ? Color.green : Color.red;

Sumber Kode 40 Keseluruhan Script

Menjalankan Di Device Android

1. Pastikan device andorid Anda support Gyroscope.

2. Kemudian masuk ke Build Settings yang berada di menu File > Build Settings.

3. Jangan lupa untuk menyimpan Scene dan menambahkannya di list scenes.

4. kemudian switch ke platform Android.

5. buka player settings, atur Default Orientation menjadi Lanscape Left dan isi Bundle
Indetifier.

6. Kemudian Klik Build and Run pada jendela Build Settings.
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Gambar 9.33 Hasil Build Android

Cara mengujinya dengan arahkan pointer ke arah box merah dan tap layer. Setiap object di

tap maka akan berpindah tempat.

C. KESIMPULAN

Pada percobaan ini kita dapat membuat project VR sederhana menggunakan VR Box dan

smartphone Android serta mengetahui tampilan VR dari smartphone dengan VR Box.
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D.
1.

218

SOAL

Perangkat Virtual Reality yang harganya murah , tidak ada komponen elektronik didalamnya
dan dalam menggunakannya memerlukan sebuah smartphone berukuran layar 4 hingga 5 Inch
keatas adalah ...

a. Oculus Rift

b. Samsung Gear VR

c. Google Card Board

d. Microsoft HoloLens

Salah satu sensor pendeteksi tangan yang bias digunakan untuk controller sebuah simulasi
Virtual Reality adalah ...

a. Oculus Rift DK 2 b. Leap Motion c. Samsung Gear VRd. Sony HMZ-T1
Inputan VR sebagai perangkat interaktif, menyerupai sarung tangan yang dipakai di tangan,
yang memfasilitasi sentuhan penginderaan dan kontrol gerak halus dalam robotika dan realitas
virtual adalah ...

a. Data Gloves b. Leap Motion c. Treadmills d. Bodysuits

Inputan VR yang berfungsi untuk menangkap gerakan seluruh tubuh dengan alat yang
berbentuk seperti pakaian dalam Virtual Reality adalah ...

a. Data Gloves b. Leap Motion c. Treadmills d. Bodysuits
Inputan VR yang berfungsi untuk menangkap gerakan kaki pemain adalah ...
a. Data Gloves b. Leap Motion c. Treadmills d. Bodysuits
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BAB 10

PENGEMBANGAN VIRTUAL REALITY DENGAN
OCULUS

TUJUAN

1. Pembaca dapat mengetahui proses kerja oculus

2. Pembaca dapat mengetahui cara mengintegrasikan VR dengan Oculus

A. DASAR TEORI
10.1  Pengertian Oculus

Rift adalah peranti layar ikat kepala untuk menampilkan realitas virtual yang saat ini
sedang dikembangkan oleh Oculus VR. Oculus Rift diciptakan oleh Palmer Luckey awalnya
khusus untuk para gamers sebagai pengganti layer dengan visi utamanya adalah “satu langkah

masuk ke dalam dunia game” karena pengguna akan merasakan benar-benar dalam dunia game.

Gambar 10.1 Palmer Luckey
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Oculus merupakan bagian dari perkembangan VR yang terjadi pada tahun 2014.
Dikembangkan selama sekitar empat tahun, perusahaan ini mengalami cukup banyak rintangan
sampai akhirnya siap memasarkan perangkat ini pada Maret 2016.

Menariknya, dalam mengembangkan teknologi baru ini, Oculus memilih langkah dengan
sangat hati-hati. Salah satu caranya adalah dengan terlebih dahulu meluncurkan versi prototype
bagi para konsumen yang sangat antusias. Setidaknya terdapat 5 tipe prototype yang telah hadir

sebelum akhirnya versi finalnya siap diluncurkan.

10.2  Sejarah Oculus
10.2.1 Rift Development Kid 1 - 2012

Merupakan prototype pertama yang dihadirkan oleh Oculus setelah mereka meluncurkan
kampanye di Kickstarter pada tahun 2012 lalu. DK 1 memiliki layar 7” dengan resolusi 1280 x 800,

dan dalam paketnya perangkat ini dilengkapi dengan tiga pasang lensa.

Gambar 10.2 Oculus Development Kit 1

10.2.2 HD Prototype — 2013
Oculus menghadirkan versi upgrade dari DK1 yang memiliki tingkat resolusi HD 1920 x

1080 piksel—resolusi standar di masa Kini.
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Gambar 10.3 Oculus VR HD Prototype

10.2.3 Crystal Cove Prototype — 2014

Versi kali ini mengusung layar OLED yang lebih fleksibel dan hemat energi dibanding
layar LED. Crystal Cove juga memiliki tambahan untuk membaca 24 titik infra merah yang
terdapat di sekujur headset prototype-nya. Dengan teknologi ini, Crystal Cove mampu membaca

pergerakan secara lebih mendetail.

Gambar 10.4 Oculus Crystal Cove Prototype
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10.2.4 Development Kit 2 (DK2) — 2014

Versi ini menghadirkan kombinasi dari segala kelebihan tiga prototype sebelumnya, seperti
layar OLED dengan resolusi HD 1920 x 1080 piksel, pengembangan teknologi tracking, hingga
kabel yang bisa dilepas.

Gambar 10.5 Oculus Development Kit 2

10.2.5 Rift Consumer Version — 2015
Selain hadir dengan resolusi yang lebih tinggi (2160 x 1200 piksel), fitur 360 positional
tracking milik Crescent Bay, dan teknologi audio terbaru, Rift akan hadir dengan Oculus Remote,

Oculus Touch, bahkan bundling dengan controller Xbox One.

Gambar 10.5 Oculus Rift Consumer Version
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10.3 Kegunaan Oculus
Oculus Rift tidak hanya akan digunakan di dunia game, tapi juga dapat diimplementasikan

di bidang lainnya. Aplikasi Oculus Rift antara lain adalah :

1. Tour Wisata : Sobat yang pengen jalan-jalan liburan ke luar negeri, gak perlu ribet cukup
dengan Oculus rift di rumah, sobat langsung dibawa untuk mengunjungi tempat-tempat
tersebut dengan format Video 360.

2. Bidang Kedokteran : Oculus Rift digunakan bagi mahasiswa untuk melihat pembedahan
secara langsung dari mata pertama, seakan-akan mahasiswa tersebut yang melakukan
pembedahan.

3. Sejarah dan Geografi : Oculus Rift digunakan untuk mengunjungi tempat-tempat
bersejarah, serta memudahkan para siswa dalam mempelajari letak Geografis.

4. Membuat Desain 3 Dimensi : Oculus Rift bisa digunakan untuk membuat desain 3
dimensi, desain interior, produk, dan berbagai aktivitas desain lainnya termasuk desain

arsitektur berformat 3 dimensi.

10.4 Head Tracking and Sensor

Perangkat kacamata Virtual Oculus Rift DK2 terdiri dari berbagai sensor hardware
pendukung yang lain, seperti gyroscope, accelerometer, dan magnetometer. Perangkat kacamata
Virtual Oculus Rift DK2 juga terdapat hardware yang berfungsi untuk melacak posisi kacamata
pada waktu dipakai atau digunakan. Informasi dari masing masing sensor tersebut dikombinasikan
melalui beberapa proses yang dijadikan satu untuk menentukan gerakaan posisi gerakan kepala
dengan kacamata virtual tersebut seperti layaknya di dunia nyata dengan sinkronisasi pengguna
asecara real-time.

Sensor pada hardware kacamata oculus, yang pertama kali dijalankan pada tracking dengan
menjalankan fungsi ovrHmd_ConfigureTracking. Fungsi ini memiliki script seperti berikut:
1. ovrHmd_ConfigureTracking di ditandai dengan dua fungsi didalamnya sebagai fungsi

masukan. Masukan ini dinyatakan di dalam vrTrackingCaps.

2. supportedTrackingCaps merupakan fungsi yang melakukan pelacakan pada HMD atau

perangkat kacamata virtual.
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3. requiredTrackingCaps berfungsi untuk menetukan kemampuan yang bisa dilakukan oleh
perangkat agar pada saat dijalankan bisa beropasi dengan benar. Namun jika ada fungsi yang

tidak terdeteksi, maka ovrHmd_ConfigureTracking akan gagal.

oeresu ovrHmd ConfigureTracking|(ovrHmd hmd, unsigned int |supportedTrackingCaps
unsigned int |[requiredTrackingCaps);

Sumber Kode 41 Fungsi Trecking Script Oculus

Setelah tracking di ini selesai di inialisasi, maka perangkat akan meneruskan fungsinya
untuk menetukan posisi kepala dan orientasi kacamata yang digunakan dengan memanggil
ovrHmd_GetTrackingState.

Pada Oculus Rift DK2 tracking posisi berbasis tracker pada perangkat kamera kecil di
depan kita yang dipasang pada LCD computer atau laptop yang berbeda dengan DK1 yang
digunakan secara manual dan hanya dasar saja. Tracker ini bisa diaktifkan inialisasinya tersebut

jika keadaan camera tracker terpasang dan diaktifkan oleh SDK.

Gambar 10.6 Oculus Trecking

Pada symbol x-y merupakan bagian dimana camera di orientasikan. Seperti pada gambar
tersebut, kordinat system menggunakan mengikuti arah :
* Y adalah posisi ke atas dan bawah.
» X adalah posisi kekanan dan kekiri.

» Z adalah posisi untuk maju dan mundur.
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Y
A

L) Yaw

Gambar 10.7 Sistem Penggunaan Oculus

10.4.1 Camera Rig

Positional pada Oculus Rift DK2 didefiniskan dengan posisi horizontal dan vertical dengan
arah kedepan dan ke belakang. Secara default, posisi kamera tracker berada dalam satu meter
jarak dari kacamata yang kita gunakan. Dengan ketinggian pengguna sama dengan ketinggian

dipasangnya kamera tracker.

tracking frustum

Gambar 10.8 Camera Rig
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10.4.2 Control

Untuk memberikan control dengan nyaman, presisi dan dapat digunakan antar pengguna,
kacamata virtual harus diintgrasikan dengan skema control yang ada seperti aplikasi yang lain.
Misalnya, dalam first person shooter (FPS) game, pemain umumnya bergerak maju, mundur, Kiri,
dan kanan menggunakan joystick kiri, dan bagian kiri, kanan, atas, bawah menggunakan joystick
ke kanan.

Bila menggunakan Oculus Rift DK2, pemain sekarang dapat melihat kiri, kanan, atas, dan

bawah, dengan menggunakan kepala mereka.

Gambar 10.9 Control

10.5 Bagian-bagian Oculus DK2
Headset dengan kabel yang bisa dilepas
Lensa - 2 ukuran

Position Tracker

Kabel USB pelacak posisi

Kabel sinkronisasi pelacak posisional

1 DVI ke adaptor HDMI

Power Adapter

N o gk~ e e
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Gambar 10.10 Bagian Bagian Oculus

10.5 Unity
Unity merupakan salah satu game engine yang support untuk membuat sebuah project
virtual reality dengan Oculus Rift DK2. Dengan Unity ini nanti kita akan menciptakan sebuah 3D

world yang nantinya akan dijalankan dengan Oculus Rift DK2.

B. PRAKTIK

Setelah pembaca dapat membuat project VR sederhana menggunakan VR Box dan Google
Cardboard dari smartphone Android serta mengetahui tampilan VR dari smartphone dengan VR
Box. Sekarang kami akan membahas tentang perangkat Virtual Reality Oculus Rift.

PERALATAN

1. Komputer

2. Software Unity
3. Koneksi Internet
4. Oculus
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LANGKAH LANGKAH PERCOBAAN
Integrasi Oculus
1. Mengatur Headset

Lepaskan penutup (cover) di bagian depan headset untuk memastikan bahwa kabel
dimasukkan dengan aman ke port di bagian depan headset. Silakan pasang kembali di bagian depan
headset. Jangan letakkan stiker atau apa pun di bagian depan headset yang dapat menghalangi

LED, karena ini dapat memengaruhi kinerja.

USB and HDMI
connectors

Cover

Gambar 10.11 Kabel Headset Oculus

2. Hubungkan Kabel Headset ke Komputer.

Buka kabel yang terpasang ke headset. Ujung kabel headset memiliki konektor HDMI dan
konektor USB. Tancapkan kedua konektor HDMI dan konektor USB ke komputer Anda. Jika
komputer Anda tidak memiliki antarmuka HDMI tetapi memiliki antarmuka DVI, gunakan

adaptor DVI ke HDMI yang disertakan untuk menyambungkan HDMI ke port DVI.

[T Haard =t

HDMI cable

cabla
Gambar 10.12 Menghubungkan Kabel Headset Dengan Komputer

usBe
cabla
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3. Hubungkan Kabel Sync Positional Tracker

Masukkan salah satu ujung kabel sinkronisasi ke konektor bagian atas di sisi kanan pelacak
posisi dengan pelacak posisi menghadap Anda. Sambungkan ujung lain dari kabel sinkronisasi ke
kotak konektor kabel pada kabel headset.

Sync cable to
tabde connector box

Gambar 10.13 Kabel Sync Positional Tracker

4. Hubungkan Kabel USB Positional Tracker
Masukkan ujung USB mini dari kabel USB pelacak posisi ke konektor bawah di sisi kanan
pelacak posisi. Hubungkan ujung lain dari kabel USB pelacak posisi ke salah satu port USB di

komputer.

Sync cable to
cable connector box

HDMI cable
to computer

USB cable
to computer

Gambar 10.14 Kabel USB Trecker dan Port USB Komputer

5. Pasang Pelacak Posisi ke Tripod atau Monitor
Pelacak posisi digunakan untuk melacak posisi headset dalam ruang 3D. Pasang pelacak
posisi ke tripod atau bagian atas monitor Anda, atau letakkan di atas meja Anda. Pastikan lensa

pelacak posisi menghadap Anda. Pelacak posisi harus stabil, karena mengguncang pelacak posisi
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dapat menyebabkan gambar ditampilkan pada panel layar menjadi bergoyang. Pastikan posisi
pelacak ke headset terpasang lurus. Untuk kinerja optimal, posisikan diri Anda sekitar 1,5 meter

atau 5 kaki dari pelacak posisi.

Gambar 10.15 Pelacak Posisi dan Monitor

6. Sambungkan Kabel Daya ke Kotak Konektor (opsional)

Adaptor daya digunakan untuk memungkinkan penggunaan port aksesori USB pada
headset. Pasang konektor kabel listrik ke kotak konektor kabel. Anda harus mencolokkan adaptor
daya dengan steker negara yang sesuai ke sumber listrik. Pastikan Anda hanya menggunakan
adaptor daya yang disertakan dengan headset.

Power cord

USB cable
to computer  HDMI cable
to computer

Gambar 10.16 Kabel Power dan kotak Konektro
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7. Tekan tombol power pada Oculus

Gambar 10.17 Tombol Power Oculus

Install SDK

Setelah semua alat tersambung, kemudian install software pendukungnya
1. Buka link https://developer.oculus.com/downloads/

2. Klik pada bagian UNITY

& > C 0| @ sdeure | nitps//developer.oculus.com/downloads/ | I
E ° / developers Design Develop Digtribule Support Manage Q ﬁ
> Discove

Do Downloads
> Desig
The Cculus SDKs, samples, and asset packs are built to help you quickly and easily develop your VR app in your preferred
v
ezl development envirenment.
? Docs
Reference
Downloads —
AT =
) =
> \t:v/ X
= s
> Dist T

Unity Unreal Engine Web VR

e -\l e

Gambar 10.18 Web Developer Oculus
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3. Pilih beberapa pendukung seperti pada “Oculus Utilities for Unity”.

€& > C {} | & Secure | https//developer.oculus.com/downloads/unit e

E ° / deve|oper5 Design Develop Distribute Support [ ELET-TY Q Q

>

> e Unity packages
v Develop
> Docs
T, Unity
ownloads
Core Packages
» Tools Unreal Engine
> [ ; i
- Oculus Utilities for Unity Native Windows
> s
Native Android
Unity 4 Legacy Integration 3
Audio
Web VR
Supporting Packages
Legacy
Oculus Avatar SDK Misc
Oculus Platform SDK
& 2 -
el Sacoole L gkt Lo, S Decioct hd

Gambar 10.19 Web Developer Oculus

4. Sesuaikan dengan komputer anda.
5. Centang pada bagian agreement.

° / developers Design Develop Distribute Support [ ELET-TY

Oculus Utilities for Unity

¥ Develop 4 1.25.2 - | Published 24/04/2018

> e 5 B | have read and agred

Downloads

> Tools
>C
> 1.22.0

Oculus Utilities for U, 2ase Notes 1.25.2
ort for the Oc S .

& =

Gambar 10.20 Web Developer Oculus

6. Klik Download
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&

E ° / deve|oper5 Design Develop stribute Support Manage Q ﬁ

C ) | @ secure | httpsy//developer.oculus.com/downloads/package/oculus-utilities-for-unity-5/1.25.2. 7

S Oculus Utilities for Unity

 Develop 1.25.2 = | Published 24/04/2018
>
- | have read and agree to the terms of the and
Downloads 6 Download
> Tools
> Distribute

> s

Oculus Utilities for Unity Release Notes 1.25.2

Gambar 10.21 Web Developer Oculus

Jika tidak ada koneksi internet, di dalam DVD buku ini sudah disediakan driver runtime
dan SDK yang sudah didownload. Masuk pada source DVD buku ini kemudian masuk pada folder
Runtime Driver. Jika Kita sudah masuk maka jalankan program
“oculus_runtime sdk 0.5.0.0 win”. Ikuti petunjuk yang ada sesuai dengan petunjuk yang muncul

pada form instalasi. Berikut tahapan-tahapannya :

1. KIik next
o Setup = B

Setup - Oculus Runtime

Welcome to the Ooulus Runtime Setup Wizard.,

< Back Cancel

Gambar 10.22 Setup Oculus Runtime
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2. KIlik Agreement

3. Kilik Next

4. Klik next

234

o Setup - B

License Agreement o

Flease read the following License Agreement. You must accept the terms of this agreement before
continuing with the installation.

Installing this software confirms your acceptance of the Oculus VR Rift SDK
Software License.

The license may be viewed at https://developer.oculus.com/licensesflicense-3.2/
or in the file LICENSE.txt in the SDK zip file.

o |[§] I accept the agreement |
Do you accept this license?
L) Ido not accept the agreement

InstalBuilder

Gambar 10.23 License Agreement Oculus Runtime

o Setup = B
Installation Directory o

Please spedfy the directory where Oculus Runtime will be installed.

Installation Directory |C:‘!Progran1 Files (x88)\Oculus| | rg'

< Back Mext > Cancel

InstallBuilder

Gambar 10.24 Installation Directory Oculus Runtime
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5. Lakukan proses “restart” pada komputer anda

o Setup = =
L O 2

Installing

Please wait while Setup installs Oculus Runtime on your computer.
Installing
Unpacking C:\Program Files (x86)\0Oculus {Tools\OculusConfigUtil.exe

o Question

4% Tocomplete the installation, Setup must restart your computer, Would you like to
¥’ restart now?

b
InstallBuilder 5
< Back Mext > Cancel HNe

Gambar 10.25 Tampilan Complate The Installation

6. Indikator Oculus sudah terinstall

6

a E == 9:22

Kamis

92 4> 28/05/2015

Gambar 10.26 Indikator Oculus Terinstal

7. Atur Eye Relief

8. Atur Gender

9. Atur Player Hight

10. Klik Show Demo Scene
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hod Oculus Configuration Utility H
File Tools Help

Device

=

Oculus Rift DK2: Ready

Eye Cups A -
ahit.
Eye Relief  in out "'

User
User ||+ -

Gender Male ~
Player Height Metric || 178 cm S

Advanmd ﬂ
| Show Demo Scene | Close

Gambar 10.27 Oculus Configuration Utility

Tampilan Demo Scene
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© Oculus Demo Scene Mirror 4

Headset Display On
Please Put On The Headset

Gambar 10.28 Tampilan Demo Scene

Integrasi di Unity 3D
Sebagai salah satu penggunaan oculus pada Unity, lakukan percobaan berikut:
1. Buat project baru pada Unity

VRLAE ‘

DADATANTUGAS\EEPIS\UNITY

@300 2D

== A

Gambar 10.29 Tampilan New Project Pada Unity

2. Import Unity package
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™

Gambar 10.30 Import Unity Package

3. Klik “Cubes” pada bagian asset

Gambar 10.31 Unity

Setelah semuanya diimport maka akan kelihat pada panel Project asset yang ada

didalamnya sudah terisi dengan beberapa folder yang merupkan bagian dari Oculus SDK.
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o I

Gambar 10.32 Tampilan Scene

C. KESIMPULAN

Menghubungkan oculus dengan unity meliputi instalasi Software Development Kit, head
tracking, sensor, camera rig, contol, hingga integrasi unity 3D dengan oculus. Sebelum integrase

dengan Unity pastikan semua perangkat Oculus terpasang dengan baik.
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D. SOAL
1. Oculus Rift diciptakan oleh adalah ...
a. Francisco Pizarro b. Palmer Luckey c. Joseph Stalin d. Henry Ford

2. Prototype pertama yang dihadirkan oleh Oculus adalah ...
a. Crystal Cove Prototype
b. HD Prototype
c. Rift Development Kid 1
d. Development Kit 2
3. Resolusi layar Development Kit 2 adalah ...
a. 960 x 540 b. 1280 x 720 c. 1920 x 1080 d. 2560 x 1440
4. Script yang berfungsi untuk melakukan pelacakan pada HMD atau perangkat kacamata
virtual adalah ...
a. supportedTrackingCaps
b. requiredTrackingCaps
c. ovrHmd_ConfigureTracking
d. ovjHmd_ConfigureTracking
5. script yang berfungsi untuk menetukan kemampuan yang bisa dilakukan oleh perangkat agar
pada saat dijalankan bisa beropasi dengan benar adalah ...
supportedTrackingCaps
b. requiredTrackingCaps
c. ovrHmd_ConfigureTracking
d. ovjHmd_ConfigureTracking

o
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Halaman Ini Sengaja Dikosongkan

241



MARI BELARMAIN VIRTUAL REALITY DENGAN UNITY 3D

BAB 11

PENGEMBANGAN VIRTUAL REALITY DENGAN
LEAP MOTION

TUJUAN

1. Pembaca dapat mengetahui penggunaan Leap Motion

2. Pembaca dapat melakukan percobaan Leap Motion

A. DASAR TEORI
11.1 Pengertian Leap Motion

Leap Motion merupakan salah satu sensor pendeteksi tangan yang bias digunakan untuk
controller sebuah simulasi. Leap Motion mendeteksi pergerakan tangan secara alami dan
memungkinkan pengguna untuk berinteraksi dengan computer dengan cara yang baru, seperti
point, wave, reach, grab.

Leap Motion dapat melacak 10 jari hingga 1/100 milimeter. Hal ini menunjukkan bahwa
leap motion merupakan sensor control gerak yang sensitive dibandingkan dengan sensor control
yang ada. Leap Motion memiliki bidang pandang yang cukup lebar yaitu 150° dan z-axis untuk
kedalaman. Itu menunjukkan bahwa ketika menggerakan tangan dalam 3D, hampir sama
menggerakan tangan dalam dunia nyata. Leap Motion dapat melacak gerakan tangan pada tingkat
lebih dari 200 frame per detik.

Gambar 11.1 Perangkat Leap Motion
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Leap motion pertama kali dirilis pada tahun 2012 dengan seri A, kemudian pada tahun
2013 merilis lagi dengan seri B. Pada tahun 2014, tepatnya bulan Mei, Leap Motion merilis
software versi 2 kepada developers/pengembang dalam versi beta. Kemudian pada bulan Agustus
2014, perusahaan Leap Motion merilis VR dengan mode tracking yang berguna untuk memberikan

pelacakan pada tangan.

11.2 Cara Kerja Leap Motion
11.2.1" Hardware

Dari perspektif Leap motion Controller, perangkat hardware leap motion terdiri dari dua
kamera dan 3 LED infra merah. Jalur interaksi Leap Motion untuk melacak cahaya dengan panjang
gelombang 850 NM (nanometer) yang berada diluar spectrum cahaya tampak.

Dengan sudut lensa yang lebar, perangkat Leap Motion Controller ini memiliki ruang
interaksi sebesar 8 per kaki kubik dengan jarak pandang terbatas sekitar 2 kaki (60 cm) di atas
perangkat dan rentang dibatasi oleh perambatan cahaya LED melalui ruang, karena jauh lebih
sulit untuk menyimpulkan posisi tangan pengguna dalam 3D di luar jarak tertentu. Intensitas lampu

LED pada akhirnya dibatasi oleh arus maksimum yang dapat ditarik melalui koneksi USB.

2 feet above the controller, by 2 feet wide on each side
(150° angle), by 2 feet deep on each side (120° angle)

Gambar 11.2 Interaksi Area Leap Motion

Pada titik ini, pengontrol USB perangkat membaca data sensor ke dalam memori local dan
melakukan penyesuaian resolusi yang diperlukan. Data ini kemudian dialirkan melalui USB ke
perangkat lunak pelacakan Leap Motion. Karena Leap Motion Controller melacak dalam

inframerah terdekat. Kemudian muncul sebuah gambar dalam skala abu-abu. Sumber intens atau
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reflektor cahaya inframerah dapat membuat tangan dan jari-jari sulit untuk membedakan dan
melacak.
11.2.2 Software

Setelah data gambar dialirkan ke komputer, Leap Motion Controller tidak menghasilkan
peta kedalaman. Melainkan menerapkan algoritma tingkat lanjut ke data sensor mentah. Layanan
Leap Motion adalah sebuah perangkat lunak di komputer pengguna untuk memproses gambar.

Setelah mengkompensasi objek latar belakang (seperti kepala) dan pencahayaan
lingkungan sekitar, gambar dianalisis untuk merekonstruksi representasi 3D dari apa yang dilihat
oleh perangkat. Selanjutnya, lapisan pelacakan cocok dengan data untuk mengekstrak informasi
pelacakan seperti jari dan alat. Pelacakan Algoritma menginterpretasikan data 3D dan
menyimpulkan posisi objek yang tersumbat.

Teknik Penyaringan data yang diterapkan untuk memastikan koherensi temporal.
Kemudian Layanan Leap Motion memasukkan hasilnya yang dinyatakan sebagai serangkaian
frame, atau snapshot, yang berisi semua data pelacakan ke dalam protokol transport. Melalui
protokol tersebut, layanan berkomunikasi dengan Leap Motion Control Panel, serta pustaka klien
asli dan web, melalui koneksi soket lokal (TCP untuk asli, WebSocket untuk web). Pustaka
pengguna dalam mengatur data ke dalam struktur API berorientasi objek untuk mengelola
serangkaian frame. Secara logika, aplikasi yang telah terhubung ke input Leap Motion,

memungkinkan interaktif yang dikendalikan oleh gerakan.

B. PRAKTIK
Setelah pembaca dapat membuat project Virtual Reality dengan Oculus Rift. Sekarang
kami membahas tentang perangkat input Virtual Reality yaitu Leap Motion. Dengan harapan

pembaca bisa membuat Virtual Reality dengan perangkat input berupa Leap Motion.

PERALATAN

1. Komputer

2. Software Unity
3. Koneksi Internet
4. Leap Motion
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LANGKAH LANGKAH PERCOBAAN

Install Software Leap Motion

1. Pastikan sudah terinstall Leap Motion SDK. Jika belum terinstall, bisa diunduh di website :
https://developer.leapmotion.com/get-started/

UNITY ~ DOCS  GALLERY ™ BU DWIKIAKBAR

Get Started with Our SDK

Truly immersive VR starts with your hands. Build your next reality with the Orion beta.

DOWNLOAD ORION BETA

Currently Windows only. Licensed subject to Leap Motion SDK Agreement.

You can also download the installer by itself or check out the known

Gambar 11.3 Tampilan Web Leap Motion

2. Download terlebih dahulu Unity Package yang sudah disiapkan oleh Leap Motion untuk di
develop di Unity3D. Core Assets bisa didownload di https://bit.ly/leapmotionaset

Unity Assets for Leap Motion Orion Beta

Windows 7 64-bit or higher

uire:
HTC Vive (requires Unity 5.6+)

Now supports both Unity 5.6 & 20173

DOWNLOAD UNITY CORE ASSETS 4.3.4

Gambar 11.4 Download Core Assets Leap Motion

3. Saat melalui proses pengunduhan, Package core asset Leap Motion untuk saat ini dengan
versi 4.3.4
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Opening Leap_Motion_Core_Assets_4.3.4.unitypackage

You have chosen to open:
Q Leap_Motion_Core_Assets_4.3.4.unitypackage

which is: Unity package file (4.5 MB)
from: https://leapmotion.cachefly.net

What should Firefox do with this file?

i Open with | Unity Editor (default) ~
(®):Save File
Do this autornatically for files like this from now on.
OK Cancel

Gambar 11.5 Tampilan Opening Leap Motion Core Assets

4. Setelah selesai mengunduh aset leap motion, kemudian buka unity versi 2017.3.1

5. Beri nama file project dan pastikan lokasi untuk file project anda

< Unity 2017.3.1F1

Projects  Learn Bnew  [Hlopen (@) MyAccount
| VRLeapMotior| @300 2D
FAKULIAH\SEMESTER 6\Pemogramar (Con @) Enable Unity Analytics (7)

akbardwikia7 v .

Gambar 11.6 Tampilan New Project Unity
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6. Import package yang telah didownload.

7. Dengan cara klik menubar Assets > import package > custom package.

Zﬂ'
‘= Hierarcl gh PLETeD

Create 7| | Open

RIENEAE I~ | Gizmas - | (@Al

v € untit Delete
Main C
Directi Open Scene Additive

Import Mew Asset...
Import Package » I Custom Package...

Export Package... 7 D 7
Find References In Scene c
ameras

Select Dependencies

Characters
Refresh Ctrl+R CrossPlatforminput
Reimport Effects

Reimport All Environment

ParticleSystems
Prototyping
Run AP| Updater... Utility

Extract From Prefab

Open C# Project Vehicles

I
i3 Project
| create ~|
V{':}Favoritei Assets

@AII Materials :
@AII Models This folder is empty

@AII Prefabs

| = Assets
Gambar 11.7 Import Package

(@

8. Kemudian klik all

9. Selanjutnya klik Import
€ Unity

File Edit Assets GameObject Component Window Help

°] Pivot

3.1f1 Personal (64bit) - Untitled - VRLeapMotion - PC, Mac & Linux Standalone <DX11=

| Gizmes - | (@Al

Leap_Motion_Core_Assets_4.3.4

I} (e |
4 )(P.Suppnr‘tutll‘c: [
v M gur
¥ o 5 Editor
I | EyeTypeEditor.cs wh
I |G| LeapTermnporalWarpingE ditoridsd

EyeType.cs GE
LeapVRCameraControl.cs GE
4 LeapVRTemporalWarping.cs N
4 TempnralWarpinqStatus.:s (=
¥ |G VRHeightOffset.cs —

v EﬁTeItures
4 EILnPuI\rHand_Cnlnr.png

4 ElPIuginLeapNntice.png
8 4 ElPIuginLeapNnticeLarge‘png
¥ [ version.txt

B3 Project | All i None
Create ™ =
'ﬂ?Faunrite; Assets
@AH Materials .
@AH Models This folder is empty
@AH Prefabs

Gambar 11.8 Import Package
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10. Setelah selesai import, muncul folder Leap Motion pada panel project bagian asset.

Assets »

- m

LeapMotion

Gambar 11.9 Assets Leap Motion

11. Setelah muncul dipanel project asset, kemudian klik Assets > LeapMotion > Core >

Examples
12. Kemudian klik Leap Hands Demo

& Project

|Crlitl 'l

Y{?Favnritc!
@AII Materials
(©1 All Models
@AII Prefabs

(a

<<

Leap Hands.. Leap Hands..

i

v 5 Assets |
¥ & Core

» &3 Editor
EditorResources

E& Gizmos
» il Materials
P &5 Models

(S Y B .

'I € Leap Hands Demo (Deskton).unity

Gambar 11.10 Project Unity

13. Klik Play, kemudian akan muncul skeleton dibagian Game View.

14. Gerakkan tangan anda diarea Leap motion.

Gambar 11.11 Tampilan Game View Ketika Tangan Digerakkan
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C. KESIMPULAN

Pada penggunaan Leap Motion pada unity yang perlu kita perhatikan tentang software

Leap Motion dan Package Leap Motion.

D. SOAL

1. Salah satu sensor pendeteksi tangan yang bias digunakan untuk controller sebuah
simulasi.pada Virtual Reality adalah ...
a. Leap Motion b. Oculus Rift c. VR Box d. Gear VR

2. Leap motion pertama kali dirilis pada tahun ...
a. 2011
b. 2012
c. 2013
d. 2014
3. Jalur interaksi Leap Motion untuk melacak cahaya dengan panjang gelombang
(nanometer)Resolusi layar Development Kit 2 adalah ...
a. 750 NM b. 800 NM c. 850 NM d. 900 NM
4. Perangkat Leap Motion Controller memiliki jarak pandang terbatas sekitar ...
a. 30cm
b. 40cm
c. 50cm
d. 60cm
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BAB 12

INTERAKSI PADA VIRTUAL REALITY

TUJUAN

1. Pembaca dapat mengetahui komponen Ul untuk Virtual Reality.
2. Pembaca dapat mengetahui pergerakan user dengan oculus.

3. Pembaca dapat mengetahui jenis interaksi pada VR.

A. DASAR TEORI
12.1  Head Up Display

Head-up Display atau disingkat (HUD) adalah tampilan transparan yang menyajikan data
tanpa memerlukan pengguna untuk melihat dari sudut pandang yang biasa. Asal-usul namanya
berasal dari pengguna bisa melihat informasi dengan posisi kepala yang naik (‘Terangkat’) dan

melihat ke depan.

Gambar 12.1 Visualisasi Head Up Display
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Informasi yang tampil di HUD tergantung pada kebutuhan dari VR itu sendiri. Kebanyakan
HUD tampil statis sehingga HUD akan tetap muncul pada layar selama vr berlangsung. Beberapa
tampilan HUD yang umum adalah :
Health/lives
Time
Weapon/Amunition
Capabilities
Menu
Progression
Mini-map

Speedometer

© 0o N o g Bk~ w b PE

Context Information
10. Reticle/Cursor/Crosshair
11. Compass

Gambar 12.2 Contoh Tampilan HUD

12.2  Head Trecking And Sensor

Perangkat kacamata Virtual Oculus Rift DK2 terdiri dari berbagai sensor hardware
pendukung yang lain, seperti gyroscope, accelerometer, dan magnetometer. Perangkat kacamata
Virtual Oculus Rift DK2 juga terdapat hardware yang berfungsi untuk melacak posisi kacamata
pada waktu dipakai atau digunakan. Informasi dari masing masing sensor tersebut dikombinasikan

melalui beberapa proses yang dijadikan satu untuk menentukan gerakaan posisi gerakan kepala
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dengan kacamata virtual tersebut seperti layaknya di dunia nyata dengan sinkronisasi pengguna

asecara real-time.

Gambar 12.3 Sensor Gyroscope 360°

12.3  Jenis Interaksi Pada Virtual Reality
12.3.1 Menyentuh

Proses interaksi selain menggunakan kepala dan mouse bisa juga menggunakan tangan.
Tangan kita bisa digunakan untuk berinteraksi dengan semua objek. Salah satunya adalah kita bisa
menyentuh objek dengan menggunakan jari telunjuk Kita baik jari Kiri atau kanan. Ketika jari
telunjuk kita mengenai objek yang bisa disentuh maka akan terjadi reaksi berupa perpindahan
objek atau yang lainnya. Berikut potongan script yang bisa digunakan untuk menyentuh objek
yang akan disentuh.

public void OnCollisionEnter(Collision other){
if ( other.gameObject.transform.parent.name == "inde ) {

}

e

Sumber Kode 42 Sript Untuk Menyentuh Objek

Potongan script yang telah kita buat dimasukan kedalam objek yang bisa disentuh. Namun
sebelumnya objek yang bisa disentuh ini harus mempunyai phsyics seperti rigidbody dan collider.
Kedua komponen ini yang digunakan untuk area untuk pendeteksi adanya jari telunjuk yang akan

menyentuh objek ini.
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Gambar 12.4 Komponen Physic Objek Yang Bisa Disentuh

12.3.2 Mengambil

Selain sentuh ada interaksi lain yang bisa dilakukan pada praktikum ini yaitu mengambil
objek. Layaknya pada praktikum untuk mengambil dan memindahkan objek. Hampir sama dengan
sentuh untuk mengambil objek tidak hanya jari telunjuk saja yang digunakan namun Kita
membutuhkan jari-jari yang lain untuk memindahkan sebuah objek. Kita memutuskan untuk

kondisi mengambil objek cukup menggunakan ibu jari dan jari telunjuk.

Gambar 12.5 Mengambil Objek

Potongan script untuk mengambil objek. Selain itu pastikan objek yang bisa disentuh
mempunyai komponen physics berupa collider dan rigidbody.

oid OnCollisionEnter(Collision other){

if (other.gameObject.name == || other.gameObject.transform.parent.name == )

1
J

Sumber Kode 43 Sript Untuk Mengambil Objek
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12.3.3 Gesture

Gesture merupakan gerakan tangan yang sudah diidentifikasi oleh Leap motion. Beberapa
gerakan bawaan yang bisa kita gunakan adalah CircleGesture, KeyTapGesture,
screenTapGesture, dan SwipeGesture. Masing- masing gesture bisa digunakan sesuai dengan
kebutuhan kita.

SwipeGesture CircleGesture ScreenTapGesture KeyTapGesture

Gambar 12.6 Gesture Tangan Pada Leap Motion

Pada VR Lab kita hanya menggunakan SwipeGesture, gesture ini digunakan untuk
perpindahan antar scene. SwipeGesture adalah gerakan tangan yang diayunkan dari kiri kekanan
atau sebaliknya. Untuk menggunakan gesture diatas masing-masing mempunyai potongan script

yang berbeda-beda.

B. PRAKTIK
Setelah pembaca dapat membuat project Virtual Reality Leap Motin. Sekarang kita
mengajak pembaca untuk membuat Virtual Reality dengan membuat user bisa berinteraksi dengan

VR. Interaksinya berupa sentuhan terhadap objek menggunakan Leap Motion.

PERALATAN
1. Komputer
2. Software Unity
3. Koneksi Internet
4. Leap Motion
5

Oculus
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LANGKAH LANGKAH PERCOBAAN

Setup Leap Motion
1. Buka website dengan link https://developer.leapmotion.com/unity/#116

2. Download unity core asset 4.3.4

& Prambors - No.1 Hit... = Linking PyQt output ... g PyQ

¥ I Create SoftEther Acc.

DOCS GALLERY BU RAGELoo

Unity Assets for Leap Motion Orion Beta

Requirements

Windows 7 64-bit or higher
Leap Motion Orion
Oculus SDK 1.3 (requires Unity 5.6+)
HTC Vive (requires Unity 5.6+)

Now supports both Unity 5.6 & 2017.3

DOWNLOAD UNITY CORE ASSETS 4.3.4

Licensed subject to Leap Motion SDK Agreement.

| B B R o

Gambar 12.7 Web Leap Motion

3. Tray icon leap motion
4. Resume tracking
5. Icon berubah menjadi hijau

Visualizer...

Settings...

Resurme Tracking

Gambar 12.8 Memastikan Leap Motion Sudah Siap
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Kubus Yang Bisa Digerakkan
1. Nama “interaksi objek”

2. Create project

& Unity 2017.3.1¢1

Projects  Learn
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interaksi obyeK

E:\tugas kul

iah\semester 6\pemrograman multims

® 3D ) 2D | Add Asset Package

Gambar 12.9 Membuat Projek Baru Pada Unity

3. Kilik Asset

4. Import package

5. Custom package

€ Unity 2017.3.1¢1 P

Chamaiy (64bit) - U
File Edit|| Assets | B
o K3 Create

Show in Explorer

# Scene
Shaded Open
Delete

Import Package

Open Scene Additive

ntitled - interaksi chyek - PC, Mac & Linux Standalone <DX11>

bject Component Window Help

>
| |Gixmu5" ar Al

Custom Package...

Export Package...

Select Dependencies
Refresh

Reimport

Reimport All

Extract From Prefab
Run API Updater...

€ Game

Display 1 Open C# Project

Find References In Scene

4 2D
. Cameras
Characters
Ctrl+R CrossPlatforminput

Effects
Environment
ParticleSystems
Prototyping
Utility

Vehicles

in | Stats | Gizmos

Gambar 12.10 Import Package

6. Pilih leap_motion_core_asset_4.3.4
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7. Open
& Import package ... *
1 * » RAGEL s Downloads v & Search Downloads 2
Organize v New folder = - O @
. - MEmu Download Music Programs rekamin A
@ OneDrive
[ RAGEL
[ Desktop =
B -
|=| Documents
; Downloads Shareit Video Interaction_Engin Leap_Maotion_Cor
Js, Music e 0.3.1 e Assets 4.3.4
&= Pictures
m Videos
“im Local Disk ()
L CD Drive (%)
. . Leap_Motion_Int LeapMotion_Cor
s Local Disk (E) eraction_Engine_ efzzet_ Orion_4.1.
e w 1.1 5_198caad W
File name: | Leap_Motion_Core_Assets 4.3.4 v|  unitypackage v
Gambar 12.11 Pilih File Asset Leap Motion
8. Import

Hasilnya seperti berikut
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; Import Unity Package

Leap_Motion_Core_Assets_4.3.4

¥ b o5 Leapmotion -
¥ M GScore ﬂ
¥ = Dependencies txt [HEW]
v 55 Editor
[ CorePreferences.cs [ME)
I [ customEditarBase.cs ey
[ CustomPropertyDrawerBase.cs [MEH
s EmptyFolderUtility .cs [NEW]
[ LeapHandControllerEditor.cs [NEW]
[ LeapImageRetrieverEditor.cs [HEW]
[ LeapServiceProviderEditor.cs [HEW]
v I &l Tests
¥ [@ FrameValidator.cs [NE
¥ @ FromThenTests.cs ey
¥ [@ HandFactoryTest.cs ey
o TransformCop\rTest.cs [NEW]
¥ M S EditorResources X

[Cancel [[impart]

Gambar 12.12 Import Unity Package
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| Shaded RIEEIEIE I~ | Gizmos 7| (@Al p] |

€ Game

Display 1+ || Free Aspect

Gambar 12.14 Tampilan Asset Leap Motion Pada Scene

9. Pada Hierarcy
10. Pilih 3D object

11. Pilih plane

12. Hierarcy

€ Unity 2017.3,1f1 Personal (64bit) - Leap Hands Demo (Desktop).unity - interaksi obyek - PC, Mac & Linux Standalone <DX11>
File Edit Assets GameObject Component Window Help

ct
| create -| (&
¥ &5 LeapMotion
Directional Light ¥ & core
- » & Editor
¥ 5 EditorResources
& Examples
» &5 Attachment Han
> &5 Rigged Hands

€] Leap Hands Der

c
Py &) Leap Hands Der
Paste » & Gizmos
> Gl Materials
Rename » & Models
Duplicate » G Plugins
Delete ¥ & Prefabs
» G Resources
Select Prefab ¥ & Seripts
> & Textures
Create Empty [ Dependencies
1.1%  Maximize ©n Play Mute Audio Zmoss| 3D Object > Cube
RE_
2D Object > Sphere
Effects > Capsule
Light > Cylinder
Audio > Plane
Video > Quad
ul > Ragdoll.
Camera Terrain
Tree
Wind Zone
3D Tedt

Gambar 12.13 Membuat Plane Objek
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13. 3D object

14. Cube
i Q?Lza.n Hands Demo
Copy » Gl Gizmos
Paste Gl Materials
> & Models

Rename » &3 Plugins
T -
Delete Gl Scripts
Select Prefab Fg-[;:;t:;::ncizs
Create Empty % t:_a_d_l'rj_: _______
3D Object » Cube
2D Object > Sphere
Effects ¥ Capsule
Light > Cylinder
Audio ¥ Plane
Video > Quad
ul > Ragdoll...
Camera Terrain

Tree

Wind Zone

3D Text

Gambar 12.14 Membuat Cube Objek

15. Atur camera dari leap motion dan Kubus sehingga seperti berikut

| Shaded Tl2n]] % || & "] [Gizmos -] (Al

hs

Mute Audio | Stats | Gizmo:

Gambar 12.15 Mengatur Camera dan Kubus
16. Plih Cube
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17. Pada inspector, klik add component
18. Search rigibody
19. Pilih rigibody

25

E

"Q Leap Hands Demo (Desktoy G
[€
[€

., Rigidbody

=00 ) OMmMponeann

Gambar 12.16 Menambahkan Rigibodi Pada Objek Cube

20. Pilih Cube

21. Pada inspector, klik add component
22. Search box

23. Box collider
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Search

TQ Leap Hands Demo (Desktof

Gambar 12.17 Menambahkan Box Collider Pada Objek Cube

Hasil praktikum kubus bisa digerakkan

o

Gambar 12.20 Cube Bisa Digerakkan Dengan Leap Motion
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C. KESIMPULAN

Untuk menambahkan agar objek bisa berbenturan dengan tangan perlu ditambahkan Collider.

D. SOAL

1.

Tampilan transparan yang menyajikan data tanpa memerlukan pengguna untuk melihat dari
sudut pandang yang biasa adalah ...

a. HUD b. HDMI c. HCI d. HUF
Gerakan tangan yang sudah diidentifikasi oleh Leap motion disebut ...

a. Lambai

b. Angkat

c. Gesture

d. Muka

Agar objek bisa disentuk, objek perlu kita tambahkan adalah ...

a. 960 x 540 b. 1280 x 720 c. 1920 x 1080 d. 2560 x 1440

Script yang berfungsi untuk melakukan pelacakan pada HMD atau perangkat kacamata
virtual adalah ...

e. supportedTrackingCaps

f. requiredTrackingCaps

g. ovrHmd_ConfigureTracking

h. ovjHmd_ConfigureTracking

script yang berfungsi untuk menetukan kemampuan yang bisa dilakukan oleh perangkat agar
pada saat dijalankan bisa beropasi dengan benar adalah ...

e. supportedTrackingCaps

f. requiredTrackingCaps

g. ovrHmd_ConfigureTracking

h. ovjHmd_ConfigureTracking
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BAB 13
3D SOUND

TUJUAN

1. Pembaca dapat mengetahui 3D Sound yang digunakan untuk memberikan efek ruang
pada Unity 3D.
2. Pembaca dapat melakukan import 3D Sound pada Unity 3D

A. DASAR TEORI
13.1 Pengertian 3D Sound

3D sound adalah sebuah suara yang memiliki gelombang frekuensi tertentu dan berbeda-
beda di setiap telinga kiri dan kanan yang terhubung dengan otak kanan dan kiri, sehingga
menimbulkan efek pikiran bahwa keadaan asli sedang terjadi, yang sebenarnya hanyalah bayangan
pikiran sesaat. 3D sound digunakan untuk relaksasi, hiburan, maupun terapi pengobatan. Efek
yang ditimbulkan pun membuat sebuah sensasi bahwa kita memang sedang merasakan kejadian

yang terjadi.

LE x‘lj

Gambar 13.1 3D Sound Unity
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13.2  Sejarah 3D Sound
13.2.1 1800-an

Sejarah pembuatan audio 3D dapat ditelusuri kembali ke World Expo 1881 di Paris.
Setelah membangun jaringan telepon pertama di Prancis, Clément Ader menemukan théatrophone.
Penemuan ini menyampaikan audio melalui dua saluran telepon, satu untuk setiap telinga, agar
pertunjukan musik dapat dinikmati dalam jarak stereo jauh. Tak lama, théatrophones dipasang di

seluruh Eropa dan dipuji oleh rakyat biasa dan juga bangsawan.

G AUDITIONS THEATRALES A DOMICILE
2, voe LasisiaGrand, 33

Gambar 13.2 Theatrophone

13.2.2 Awal 1900-an

Gambar 13.3 Pemutaran Audio Stereo
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Selama 45 tahun, orang bereksperimen dengan perekaman dan pemutaran stereo, termasuk
Disney. Film Fantasia 1940 mereka diproyeksikan ke beberapa bioskop menggunakan 6 track
audio melalui beberapa speaker yang ditempatkan di seluruh teater. Ini adalah peningkatan besar
karena sebagian besar film diputar menggunakan satu lagu yang dimainkan hanya dari belakang

layar.

13.2.3 Akhir 1900-an
Kemudian, pada tahun 1978, BBC merekam drama radio 28 menit yang disebut "The

Revenge." Itu revolusioner karena itu adalah cerita pertama yang direkam dalam format binaural
yang benar. Itu diputar di BBC Radio 4, dan tidak mengandung dialog - hanya efek suara! Terbukti
bahwa suara saja dapat menceritakan kisah yang menarik.

Disney merilis atraksi binaural lain pada tahun 1999 yang disebut "Sounds Dangerous!"
Yang dibintangi oleh Drew Carrey. Penonton diminta untuk memakai headphone, lampu mati, dan
drama akan terungkap. Pertunjukan berlangsung selama 13 tahun, yang sangat mengesankan oleh

standar Dunia Disney.

Gambar 13.4 Drew Disney

13.2.4 2000-an
Pada tahun 2000, ada sebuah band bernama Pearl Jam yang berkata kepada diri mereka

sendiri, "Kami ingin mencoba sesuatu yang baru!" Jadi mereka menyewa teknisi suara bernama
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Tchad Blake untuk membuat lagu mereka dalam suara 3D pada album mereka yang disebut,

"Binaural."

Gambar 13.5 Binaural

13.2.5 2010-an
Kemudian, grup Teater Bahan Bakar di Inggris menghasilkan pertunjukan yang disebut

Ring pada tahun 2012. Itu memiliki konsep yang sama dengan atraksi Alien Encounter Disney,
tetapi dengan twist. Penonton duduk di ruang gelap gulita di atas ring. Mereka memakai

headphone, dan setengah dari kinerja adalah melalui headphone, dan setengah lainnya adalah

dengan aktor hidup di sekitar mereka.

SEE WITH YOUR EARS.
MOVE WITH YOUR FEET

Gambar 13.6 Pertunjukan Ring
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Tabel 7 Audio Source

No. Audio Source Pengertian

1. | Audio Clip Referensi file klip yang akan dimainkan

2. | Output Suara dapat dihasilkan melalui pendengar audio atau mixer
audio

3. | Mute Menghidupkan atau mematikan Suara

4. | Bypass Effect Cara cepat untuk mengaktifksan dan menonaktifkan efek
suara.

5. | Bypass Listener Effects | Cara cepat untuk mengaktifkan dan menonaktifkan efek
pendengaran

6. | Bypass Reverb Zones | Cara cepat untuk mengaktifkan dan menonaktifkan efek
menggema

7. | Play On Awake Jika di aktifkan suara akan langsung diputar

8. | Loop Jika di aktifkan suara akan diputar berulang ulang

9. | Priority Mengatur prioritas sumber audio

10. | Volume Mengatur nilai kekuatan suara untuk pendengar

11. | Pitch Mengatur jumlah perubahan nada karena perlambatan /
percepatan dari Klip Audio

12. | Stereo Pan Mengatur posisi dalam bidang stereo dari suara 2D

13. | 3D Sound Settings Menentukan berapa banyak efek doopler yang akan

Doppler Level diterapkan ke sumber audio ini
14. | Volume Rollof Memilih mode suara dari sumber audio
15. | Max Distance Tingkatan suara untuk membuatnya lebih nyaring

B. KESIMPULAN
3D Sound digunakan pada perfilman. Software Unity support untuk 3D sound.
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